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RESUMEN

El tema de tesis “ANALISIS Y DISENO DE EDIFICIOS ASISTIDO POR
COMPUTADORAS”, se ha desarrollado con la finalidad de servir de material
didactico a todas aquellas personas que pretendan iniciarse en el uso de un
programa de andlisis de edificios, en este caso el programa ETABS.

La investigacion se ha dividido en 6 capitulos, que se describen a continuacion:

- En el capitulo 1, se desarrolla la introduccion, que explica la necesidad del uso
de programas de cémputo para realizar el analisis de una estructura.

- El capitulo 2, presenta una breve referencia histérica, en donde se narra la
evolucion de los programas de analisis y disefio de estructuras, asi como las
facilidades actuales de éstos para el pre-procesamiento de los datos, su analisis
y el post-procesamiento de los mismos.

- En el capitulo 3, se describen las herramientas que ofrece el programa ETABS
para realizar la creacion del modelo estructural del edificio (modelaje), el
analisis y el disefio de sus elementos en concreto armado.

- En el capitulo 4, se describen las caracteristicas estructurales de un edificio real
de oficinas, las consideraciones tomadas en cuenta para la elaborar el modelo
en ETABS y los parametros sismicos que se utilizaron en el capitulo 5 para
realizar el analisis espectral de respuesta. Se menciona ademas, la diferente
informacién que puede ser mostrada tanto de manera tabular como gréafica por
el programa, después de realizar el analisis.

- En el capitulo 5, se muestra paso a paso la creacion en el programa ETABS del
modelo estructural del edificio descrito en el capitulo 4, el desarrollo del analisis
espectral de respuesta y el disefio en concreto armado de los elementos tipicos
del edificio, con el propésito de familiarizarse con las herramientas que ofrece.

- En el capitulo 6, se presentan las conclusiones de la investigacion.

A continuacién del cuerpo de la tesis se encuentra la referencia bibliogréfica y los

anexos (Anexos A y B). El Anexo A, que presenta un esquema explicativo del

contenido del CD y el Anexo B el integro del trabajo, en formato doc y pdf, junto con
la carpeta “Archivos del Modelo”, que contiene los archivos requeridos para crear

paso a paso el modelo del edificio, desarrollado en el capitulo 5.
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1 INTRODUCCION

Cualquier proyecto de estructuras, antes de ser analizado y disefiado debe ser
previamente modelado.

En la etapa de creacion del modelo (modelaje), se representa la estructura real por
medio de una construccion simplificada de los elementos que la conforman. Es muy
importante que se entienda el comportamiento de éstos a fin de evitar que se
utiicen mas elementos de los que se necesitan mediante refinamientos
innecesarios que retrasan el andlisis.

En general, los programas de analisis de estructuras permiten realizar el modelaje
de una estructura, el procesamiento numérico de los datos y el andlisis de los
resultados por medio de las etapas de pre procesamiento, procesamiento y post
procesamiento, respectivamente.

Actualmente, el modelaje de una estructura por medio de estos programas no es
complicado, pues en su etapa de pre procesamiento se cuenta con diversas
herramientas que facilitan el dibujo y la visualizacién del modelo.

Posteriormente a la fase de modelaje, se deben determinar y analizar los esfuerzos
y deformaciones en la estructura. Para ello se utilizan técnicas de analisis matricial
de estructuras (AME) y analisis por el método de elementos finitos (MEF), que
involucran una gran cantidad de célculos numéricos, de modo que es
imprescindible utilizar algin programa de computo.

En vista de la importancia que tienen actualmente estos programas en el andlisis de
estructuras es que se ha realizado el presente trabajo de investigacion, dentro del
cual se han desarrollado especificamente las capacidades del programa ETABS,
por medio de la explicacion de las facilidades que ofrece en sus etapas de pre
procesamiento, procesamiento y post procesamiento.

Este programa, esta orientado al andlisis y disefio de edificios y para ello presenta
un entorno especializado.

Con el fin de ilustrar las capacidades del programa ETABS, se presenta
adicionalmente, a manera de ejemplo, el modelaje, analisis y disefio en concreto

armado de los elementos tipicos de un edificio real de oficinas.
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POSIBILIDADES ACTUALES PARA EL MODELAJE Y
ANALISIS DE EDIFICIOS

2.1 Referencia Histdrica

Antes del desarrollo de los programas de analisis estructural, los ingenieros
analizaban los edificios como un conjunto de poérticos planos empleando métodos
aproximados como el del portal, voladizo o muto, utilizando para las operaciones
numeéricas reglas de calculo o calculadoras de mano.

En 1970, el Dr. Edward L. Wilson, lanzé en EE.UU el primer programa completo de
andlisis estructural’, llamado SAP, el cual representaba para su época el estado
del arte de los procedimientos numéricos para la ingenieria estructural. En esa
época, el programa era utilizado en computadoras de gran tamafo, por lo que
estuvo restringido a las organizaciones gubernamentales y a las grandes
compainiias.

Los programas elaborados a inicios de los 70s tenian una serie de limitaciones,
como: una capacidad muy reducida de analisis, un complicado proceso de ingreso
de datos (que se realizaba a través de tarjetas perforadas) y una trabajosa lectura
de los resultados, los cuales se obtenian en papel impreso.

Estas desventajas iniciales, que demandaban un gran cuidado en el ingreso de los
datos y en la lectura de los resultados, se fueron reduciendo con los afios debido al
aumento en la memoria y velocidad de las nuevas computadoras, la
implementacioén de nuevos métodos numericos, la invencion de nuevos algoritmos,
lenguajes de programacion y sistemas operativos con entornos graficos mas
avanzados.

A finales de los afios 70, aparecieron las computadoras personales, lo cual hizo que
los programas de analisis también se volvieran populares en las pequefas
compafiias y entre algunos usuarios individuales.

En el afio 1980, se desarrollé la primera aplicacion para andlisis estructural en 3D
para computadoras personales.

Actualmente, los programas de analisis y disefio de estructuras permiten realizar
rapidamente la creacion del modelo a través del dibujo de un conjunto de objetos

gue poseen propiedades (dimension, material, seccidén transversal, etc.) y que

! Revisar la informacién de la pagina web perteneciente a la empresa CSI Computers & Structures inc.
(http://mww.csiberkeley.com/USGS/backgrounder.pdf).
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representan a los elementos de la estructura. Estos cuentan también con
herramientas de edicién, como cortar, copiar y pegar; opciones para obtener la
geometria global de la estructura a través de plantillas o mediante la importacion de
archivos de dibujo de CAD. Asimismo, cuenta con opciones de visualizacion del
modelo (3d, planta, elevacion), opciones de visualizacion de resultados (en pantalla
0 archivos de texto), los cuales pueden ser exportados a diversas aplicaciones de
Windows (Excel, Word, Access).

En estos programas, el modelaje, el procesamiento numérico de los datos y la
visualizacion de los resultados, se realiza en entornos de trabajo perfectamente
definidos, que corresponden a las etapas de pre procesamiento, procesamiento y

post procesamiento, respectivamente.

2.2 Posibilidades de Pre Procesamiento

Los programas actuales permiten desarrollar la geometria del modelo mediante un
conjunto de objetos, como lineas o mallas de elementos finitos bi o ftri
dimensionales, a los cuales se les asigna sus propiedades mecanicas (mdédulo de
elasticidad, coeficiente de Poisson, etc.), propiedades geométricas (seccidn
transversal, momentos de inercia, espesores en el caso de losas, etc.), el material y
las solicitaciones de carga (fuerzas, desplazamientos, cambios de temperatura,
etc.).

Mediante las opciones de seleccion, los elementos pueden ser elegidos de acuerdo
a la planta a la que pertenecen, a su seccién transversal, al tipo de objeto (punto,
linea, area), etc.

De otro lado, la geometria del modelo, que puede ser modificada a través de las
opciones edicion, como las de copiado, pegado y eliminacién, se puede visualizar a
través de vistas tridimensionales, vistas en planta o vistas en elevacion.

Es posible también, poder visualizar las asignaciones realizadas a los elementos,
tales como, cargas, nombre, material, ejes locales, etc. y personalizar las opciones
de visualizacién relacionadas al color del fondo de pantalla y de los elementos, al

numero de ventanas de visualizacion, al sonido de las animaciones, etc.
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2.3 Posibilidades de Procesamiento

Las posibilidades de procesamiento, estan relacionadas con el tipo de andlisis que
se puede ejecutar. Algunos de estos tipos corresponden al analisis estético elastico,
andlisis dinamico lineal (modal, tiempo-historia y espectral), analisis de acciones
incrementales (Pushover), andlisis de respuesta térmica, analisis transitorio lineal y
no lineal y al andlisis de lineas de influencia.

Es posible también, considerar durante el analisis, el efecto de la secuencia

constructiva en la determinacion de los resultados.

2.4 Posibilidades de Post Procesamiento

Los resultados del andlisis pueden ser mostrados en pantalla a través de gréficos,
tablas y funciones, o de manera impresa, a través de archivos de texto.

De manera gréafica, es posible mostrar las reacciones en la base, las fuerzas
internas en los objetos de linea y la representacion de la distribucién de fuerzas y
esfuerzos en los objetos de area y volumen.

De manera tabular, es posible mostrar los desplazamientos, rotaciones y
reacciones en los nudos, las fuerzas internas en los elementos, los modos del
edificio, etc.

También se pueden generar funciones que corresponden a curvas espectrales de
respuesta, trazas tiempo-historia y curvas estaticas Pushover.

Con la informacién relacionada a las restricciones, grados de libertad, masa de los
elementos, periodos y frecuencias modales, factores de participacion modal,
porcentaje de masa de participacion modal, etc., se puede generar un archivo de
texto que podra ser visualizado de manera impresa.

Es posible ademas, obtener animaciones de la forma deformada del modelo (para
un caso de carga) y los modos de vibracién y exportar los resultados del andlisis a

hojas de calculo, procesadores de texto o bases de datos.
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ANALISIS Y DISENO DE EDIFICIOS MEDIANTE EL
PROGRAMA ETABS

3.1 Modelaje de la Geometriay Propiedades Mecéanicas del Edificio

3.1.1 Malla

Una malla es una cuadricula espacial, que esta conformada por un conjunto de
lineas. Su finalidad es facilitar la ubicacién de los diferentes elementos que
componen el edificio.
Las lineas de malla pueden pertenecer a un Sistema Cartesiano (Rectangular) o a
un Sistema Cilindrico.
En la pantalla del programa, es posible visualizar ambos tipos de sistemas al mismo

tiempo o uno en especial, utilizando las opciones de visualizacion.

Sistema Cartesiano
En este sistema, las lineas de malla son paralelas a los ejes globales X y Y.
En la figura 3-1.-a se muestra la malla rectangular utilizada para realizar el modelo

del edificio de un piso que se observa en la figura 3-1.-b.

30 view el el

a.- Malla rectangular utilizada para la creacion del b.- Modelo en ETABS de un edificio de 1 piso.
modelo del edificio.

Figura 3-1.- Malla rectangular y modelo de edificio de 1 solo piso.

Para la creacién de la malla, dentro de la ventana mostrada en la figura 3-2, se
debe definir para cada linea de malla, su ubicacion (de manera relativa a la

siguiente linea de malla o de manera absoluta, con respecto al origen), tipo
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(primaria o secundaria), visibilidad, color y la ubicacion de la burbuja que encierra

su nombre.

M Define Grid Data x|
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i 2 g PFrirnary Show Right [ Hide Al Grid Lines

5 I~ Glue ta Grid Lines

g Bubble Size I‘I.

8

9

10 LI Reaorder Ordinates |

u]: | Cancel I

Figura 3-2.- Ventana de definicion de la malla del modelo, para un sistema cartesiano.

Las lineas de malla primarias usualmente son utilizadas para ubicar elementos
estructurales, mientras que las lineas de malla secundarias son opcionales y
pueden servir para ubicar elementos estructurales secundarios, elementos no
estructurales como tabiques, para delimitar aberturas en la losa de piso, ubicar
cargas en el edificio, etc. Se puede apreciar en la figura 3-2 que el programa no

muestra las burbujas con el nombre de las lineas de malla secundarias.

Sistema Cilindrico

En este sistema, las lineas de malla se encuentran espaciadas por un angulo de
giro y un espaciamiento radial especificado.

En la figura 3-3a se muestra la malla cilindrica utilizada para realizar el modelo del

edificio de un piso que se observa en la figura 3-3b.
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a.- Malla cilindrica utilizada para la creacion del
modelo del edificio.

b.- Modelo en ETABS de un edificio de 1 piso.

Figura 3-3.- Malla cilindrica y modelo de edificio de 1 solo piso.

Para la creacién de la malla, dentro de la ventana mostrada en la figura 3-4, se

debe definir para las lineas curvas, que siguen la direccién radial (R), su ubicacion

(de manera relativa a la siguiente linea de malla o de manera absoluta, con

respecto al origen) y para las lineas rectas que nacen en el origen, un angulo de

giro (T) (de manera relativa a la siguiente linea de malla o de manera absoluta, con

respecto al origen). Para ambos tipos de lineas (curvas y rectas), se debe definir

adicionalmente su tipo (primaria o secundaria), visibilidad, color y la ubicacion de la

burbuja que encierra su nombre.
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Figura 3-4.- Ventana de definicion de la malla del modelo, para un sistema cilindrico.
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3.1.2 Pisos

En ETABS, cada piso estd conformado por una planta del edificio (techo) y por el
entrepiso comprendido entre esta planta y la planta inferior. Los objetos que
pertenecen a cada piso son los objetos de la planta y los objetos del entrepiso.

Los pisos superiores al plano de la “Base”, el cual es un plano predefinido en del
programa y que no es posible modificar, pueden ser definidos al especificar su
nombre y la altura de su entrepiso.

En la figura 3-5 se ilustra con un edificio de 3 pisos, cuales son los elementos

asociados a cada piso (planta + entrepiso).

PISO i = PLANTAi + ENTREPISO i

Figura 3-5.- Plantas y entrepisos correspondientes a cada nivel de piso.

El programa permite definir pisos maestros y pisos similares a estos, para que las
modificaciones que se realicen en cualquier piso relacionado se reproduzcan
automaticamente en todo el grupo de pisos similares. De esta manera, se pueden
agregar o eliminar elementos y cargas en un conjunto de pisos al mismo tiempo.

La figura 3-7 muestra un edificio de cinco pisos. Los dos primeros son iguales entre
si, pero diferentes a los tres ultimos, que también son iguales entre si.

La creacion del modelo, mostrado en la figura 3-6, se simplifica al definir al piso 1

como maestro del piso 2 y al piso 3 como maestro de los pisos 4y 5.
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Figura 3-6.- Ventana de definicion de los pisos del modelo.

Figura 3-7.- Modelo de un edificio de 5 pisos en ETABS, con 2 pisos maestros.

3.1.3 Elementos Auxiliares de Referencia

Los elementos auxiliares de referencia, que estan conformados por las lineas de
referencia y los planos de referencia, facilitan el dibujo de los objetos en el modelo

del edificio, en posiciones que no se encuentren definidas por las lineas de malla.

@ Tesis publicada con autorizacion del autor

SOME RIGHTS RESERVED Algunos Derechos Reservados. No olvide citar esta tesis




Lo PONTIFICIA
TESIS PUCP E T8 gﬂ_\g‘_f}gﬁm

S ! e PERU

Lineas de Referencia

Las lineas de referencia son guias verticales que se pueden crear al indicar su
punto de interseccién en cualquier vista en planta o al especificar sus coordenadas
relativas a los ejes globales Xy Y.

Estas lineas son utiles cuando los extremos de los elementos que se necesitan

dibujar en una vista en elevacion o planta no coinciden con los puntos de la malla.

Planos de Referencia

Los planos de referencia son planos guia horizontales insertados a una altura
determinada del plano de la base.

Estos planos son utiles porque proporcionan un nuevo nivel de piso, que permite
por ejemplo, en una vista en elevacion o planta, ubicar a los elementos de un
mezanine no considerado.

Las lineas y los planos de referencia pueden utilizarse en conjunto para delimitar
aberturas o perforaciones en objetos verticales de area (p.e. en un muro de
concreto).

La figura 3-8 muestra un edificio de tres pisos similares, con un mezanine en el
primer entrepiso. EI mezanine quedé definido por un plano de referencia intermedio

en el primer entrepiso y dos lineas de referencias adicionales.

PISO2 PISO3

Lineas de referencia

PISO 1

Figura 3-8.- Edificio de tres pisos con mezanine.
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3.1.4 Sistema de Coordenadas

Sistema de Coordenadas Global

Para modelar un edificio se dispone por defecto de un sistema cartesiano y
dextrégiro (que sigue la regla de la mano derecha) de coordenadas globales X-Y-Z,
donde el eje Z es vertical y apunta hacia arriba, como se muestra en la figura 3-9.

Figura 3-9.- Sistema de Coordenadas Global X-Y-Z.

Ejes Locales

En el programa ETABS los objetos de linea y de area se orientan dentro del modelo
mediante un sistema dextrégiro de ejes locales 1-2-3. No existe esta opcion para
los objetos de punto.

El programa ETABS muestra a los ejes locales 1, 2 y 3 con los colores rojo, blanco

y celeste, respectivamente.

e Ejes locales en objetos de linea

En los objetos de linea, el eje local 1 se extiende a lo largo del elemento y su

1331

hacia el extremo final “j”. Los

sentido positivo se dirige desde el extremo inicial
ejes locales 2 y 3 se encuentran instalados en el centroide de la seccién
transversal. Los ejes 2 y 3 pueden ser rotados alrededor del eje 1, tal como se

muestra en la figura 3-10.
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Figura 3-10.- Orientacién, ubicacién y rotacion positiva de los ejes locales en objetos de linea.

Por defecto, el programa orienta los ejes locales de los objetos de linea como se
indica a continuacion:

En columnas, los ejes 1 y 2 siguen las direcciones +Z y +X respectivamente.

En vigas, el eje 2 siempre sigue la direccion +Z. El eje 1 tiene una proyeccion
positiva en la direcciéon +X, independientemente del sentido en que se dibuje la
viga. S6lo cuando la viga es paralela al eje Y, el eje 1 sigue el sentido de dibujo de
la viga.

En elementos inclinados, los ejes 1 y 2 son ascendentes y forman un plano vertical.
En la figura 3-11 se muestran los ejes locales para las columnas, vigas y elementos

inclinados, y el eje local 2 en color negro para que sea visualizado en el papel.
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a.- En columnas b.- En vigas c.- En elementos inclinados

Figura 3-11.- Orientaciones de los ejes locales en objetos de linea.
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e Ejeslocales en objetos de area

El eje local 3 es perpendicular al objeto de &area. Los ejes 1 y 2, contenidos en el
plano del objeto de area, pueden ser rotados un determinado angulo alrededor del

eje 3, como se muestra en la figura 3-12.

@ Rotacion positiva

Figura 3-12.- Rotacién positiva de los ejes locales en objetos de area.

En muros, losas y rampas, el eje local 3 se orienta dependiendo del sentido en que
se dibuj6 el elemento. Por ejemplo, para un muro en el plano XZ, el eje 3 sigue la
direccion +Y si el muro se dibuj6 en sentido horario (figura 3-13) y sigue la

direccion -Y si el dibujo se hizo en sentido antihorario.

Figura 3-13.- Orientacién del eje 3 en un muro en el plano XZ dibujado en sentido horario.

Por defecto, el programa orienta los ejes locales de los objetos de area como se
indica a continuacion:

En muros, el eje 2 siempre sigue la direccion +Z. Cuando un muro se crea mediante
una vista en planta, el eje 1 sigue el sentido en que se dibujé el muro, como se

muestra en la figura 3-14.
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Figura 3-14.- Ejes locales de muros creados en una vista en planta.

En losas, el eje 2 siempre sigue la direccién +Y.
En rampas, el eje 2 siempre es ascendente y forma con el eje 3 un plano vertical.
La figura 3-15 muestra ejemplos de ejes locales en un muro, una losa y una rampa,

para el sentido de creacion indicado con la flecha circular.

“‘"‘"' / ,A]‘l \"f’v’ / !‘ S’” / -“

|
a.- En muros b.- En losas c.- En rampas

Figura 3-15.- Orientaciones de los ejes locales en objetos de area.

Cabe mencionar que los objetos de area con seccion cobertura y las losas
orientadas en una direccibn no presentan ejes locales. Solamente muestran la
direccion de distribuciéon de carga del elemento y su angulo de giro, en el caso de

haber sido rotados.
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3.1.5 Materiales

El programa permite crear cualquier tipo de materiales al definir sus propiedades
mecanicas para el analisis y para el disefio.

Por defecto ETABS cuenta con dos materiales: concreto armado y acero, con
propiedades predefinidas, que pueden ser modificadas.

Propiedades para el Analisis

Las propiedades que se pueden definir para el andlisis son: la masa y el peso por
unidad de volumen, el médulo de elasticidad (E), el coeficiente de Poisson () y el
coeficiente de expansion térmica (a), que se encuentra en unidades de °C™. El
mddulo de corte (G) se calcula automaticamente, como E /[2 * (1 + w)].

Si el material es modelado como anisotrépico, se deberan especificar las

propiedades para el andlisis en cada direccion, incluyendo el modulo de corte.

Propiedades para el Disefio

Las propiedades para el disefio varian segun el tipo de disefio elegido. Se puede

elegir entre disefio en concreto o disefio en acero.

e Disefio en Concreto

Para realizar el disefio en concreto se deben definir las siguientes propiedades: la
resistencia a la compresion del concreto (f'.), el esfuerzo de fluencia del acero de
refuerzo longitudinal (fy) y el esfuerzo de fluencia del acero de refuerzo transversal
(fys)-

El esfuerzo f, es utilizado en los calculos del refuerzo por flexion y carga axial,
mientras que el esfuerzo fys en el calculos del refuerzo por corte. Por lo general, se
utiliza el mismo tipo de acero para ambas solicitaciones (f, = fys).

Adicionalmente, si el concreto que se va a utilizar es fabricado con agregados
ligeros, se especifica el factor de reduccién de la resistencia al corte, el cual

comunmente varia entre 0.75 y 0.85. Para todos los calculos de corte el término

hﬁ es multiplicado por este factor.

e Disefio en Acero

Para el disefio en acero se deben definir las siguientes propiedades: el esfuerzo de
fluencia (Fy), la resistencia ultima (F,) y el costo por unidad de peso.
El costo por unidad de peso es una variable usada para el disefio por el post

procesador de Disefio de Vigas Compuestas, el cual determina el tamafio 6ptimo de
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las vigas basandose en el costo, conectores y curvatura, en vez de solamente en el

area de su seccion transversal (peso).

3.1.6 Objetos de Punto

Los puntos son objetos mediante los cuales se conectan elementos, se apoya la
estructura o se aplican cargas concentradas que pueden ser transferidas a las
barras del modelo.

ETABS crea automaticamente estos objetos en los extremos de un elemento tipo
barra o en las esquinas de un elemento tipo area.

Para modelar los apoyos de un edificio, es posible restringir uno o méas de los 6
grados de libertad que posee cada uno (3 traslacionales y 3 rotacionales).

El programa permite seleccionar para cada nudo, uno de los cuatro casos
predeterminados de restricciones (empotramiento, apoyo simple, apoyo de rodillo y
sin restricciones) que son los mas comunes en el modelaje de edificios.

Después de realizado el analisis, es posible obtener los desplazamientos en los

nudos de la estructura y las reacciones en los nudos de apoyo (nudos restringidos).

3.1.7 Objetos de Linea

Son lineas rectas, que se conectan en sus extremos a los nudos de la estructura y
a las que se les puede o no asignar una seccion transversal de cierto tipo.

Los objetos de linea que poseen propiedades de seccion consideran efectos de
deformacién por fuerza axial, deformacion por fuerza cortante, torsion y flexion y se
clasifican segun su orientacién en el modelo en objetos de linea tipo: columna
(orientacién vertical), viga (orientacion horizontal) y diagonal.

Los objetos de linea que no poseen propiedades de seccién son los de tipo nulo,
como la seccién “ninguno” y los de tipo “linea de dimension”. Los objetos de tipo
nulo, con seccidn “ninguno” sirven para asignar cargas en su longitud y los objetos
de tipo “linea de dimension” para acotar el modelo en una vista en planta.

Con un objeto de linea se puede representar también el comportamiento de rétulas

plasticas.

Propiedades de Seccién en Elementos Tipo Barra

Estan conformadas por las propiedades del material y las propiedades geométricas
de la seccidn, que se asignan a los objetos de linea.

Las propiedades del material se desarrollaron en la seccién 3.1.5.

Las propiedades geométricas corresponden a los momentos de inercia, la

constante torsional, las areas de corte y al area transversal de la seccion.
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El programa cuenta de manera predefinida con las secciones del AISC y permite

cargar diferentes bases de datos de otras secciones, mediante archivos con

extension *.PRO. Las secciones que se pueden cargar estan organizadas en los

siguientes archivos:

- AISC3.PRO: Secciones del Instituto Americano del Acero y Construccion (V3).

-  BSSHAPES.PRO: Secciones de acero de las Normas Britanicas.

- CISC.PRO: Secciones del Instituto Canadiense del Acero y Construccion.

- EURO.PRO: Secciones europeas de acero.

- JOISTS.PRO: Secciones del Instituto de Viguetas de Acero.

- SECTIONS.PRO: Secciones del Instituto Americano del Acero y Construccion
(V2).

- SECTIONSS8.PRO: Secciones del Instituto Americano del Acero y Construccion
(V3).

Es posible crear secciones transversales comunes, seleccionando una plantilla y

proporcionando los parametros geomeétricos necesarios. Para estas secciones

ETABS calcula automaticamente las propiedades geométricas. La figura 3-16

muestra las plantillas disponibles y los parametros geométricos que deben ser

definidos en cada una de ellas a fin de crear las secciones del edjificio.

SECCIONES
t2 t2 12
—t —, P
t 2 T 31T+
3 3 J 3 t3
Ty S+t Ty v
] Tt
| —
t2h
Ifala ancha Canal Tee
by t2 12
— ——
2 it L
3 3 3 t3
Ty T
T i
— Y
t2 dis
Angulo Angulo doble Cajon
t2
e :
tiy 2
t3 3<—T ta 3
Tubo Rectangular Circulo

Figura 3-16.- Plantillas de secciones comunes para elementos tipo barra y los parametros
geomeétricos que definen su forma y permiten el calculo de sus propiedades de seccion.
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A manera de ejemplo, en la figura 3-17 se muestra una seccion W, creada a partir
de una plantilla y sus propiedades geométricas, calculadas por el programa.

A =5.250e-3 m2 |S33=3.318e-4 m3

2
& A J=2.079e-7 m4 |1S22=7.539e-5 m3

I3-3=3.318 e-5 m4 | Z33=3.863 e-4 m3

3= 2 |22=5654e-6 m4 |Z22= 1.195e-4 m3
0.0125
AS22=2500e-3 m2 r3-3=0.0795 m
L AS33=2500e-3 m2 |rz2=0.0328 m

Figura 3-17.- Propiedades geométricas de una seccioén barra.

Si las plantillas disponibles no son adecuadas para definir una seccién, se podra
utilizar la seccién denominada “General’. Esta, permite crear una seccion
especificando directamente sus propiedades geométricas.

También se pueden dibujar secciones de cualquier tipo y adicionarlas a las
secciones predefinidas mediante el sub programa “Disenador de Secciones”. En
este caso, el sub programa calcula autométicamente las propiedades geométricas.
Un tipo particular de seccion que se puede crear es el tipo “Vigueta de Acero”, que
consiste en una vigueta compuesta por una brida superior, una brida inferior y
diagonales.

El programa permite crear barras de seccion variable dividiendo al elemento en
varios tramos y asignando a cada uno de ellos una seccion inicial y final. Para el
célculo de las propiedades de seccion a lo largo de un tramo, ETABS interpola las
propiedades de las secciones iniciales y finales del tramo de manera lineal,
parabdlica o clubica, segln se necesite.

Existe también la posibilidad de que el programa seleccione la seccion mas
conveniente para un elemento después de realizar el analisis. Para ello, hay que
indicar que la seccion pertenece al conjunto llamado “Lista de Autoseleccion”, el
cual esta conformado por una lista de secciones disponibles especificadas por el

usuario.

e Modificadores de Propiedades de Seccion

Se utilizan para escalar mediante un factor algunas de las propiedades
geométricas, como el area de la seccion transversal, las areas de corte, la
constante torsional, los momentos de inercia, la masa y el peso del material del

elemento.
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Conexiones en los Extremos

Los objetos de linea se conectan por defecto rigidamente en sus extremos, pero es
posible desconectarlos total o parcialmente de la carga axial, el corte, la torsion y
los momentos flectores.

La figura 3-18 muestra una viga con los tipos de conexiones que se pueden

modelar.

: - ] .

] ] ’ °

a.- Viga conectada en ambos b.- Viga con extremo sin c.- Viga con extremo
extremos (por defecto). restricciones de giro. parcialmente rigido.

Figura 3-18.- Tipos de conexiones que se pueden modelar.

Las liberaciones se especifican siempre en los ejes locales del objeto de linea y

ocurren en las caras de los apoyos, es decir, en las caras interiores de los extremos

rigidos.

Cualquier restriccion en la conexion de los elementos tipo barra se puede liberar

siempre que el elemento permanezca estable, de modo que toda la carga aplicada

al elemento sea transferida al resto de la estructura. Por ello, no estan permitidos

los siguientes conjuntos de liberaciones:

- Liberar la carga axial en ambos extremos.

- Liberar la fuerza de corte 2 (principal) en ambos extremos.

- Liberar la fuerza de corte 3 (secundaria) en ambos extremos.

- Liberar la torsion en ambos extremos.

- Liberar el momento 2-2 (secundario) en ambos extremos y la fuerza de corte 3
(secundaria) en cualquier extremo.

- Liberar el momento 3-3 (principal) en ambos extremos y la fuerza de corte 2

(principal) en cualquier extremo.

Extremos Rigidos en Barras

Los extremos rigidos toman en cuenta el traslape de los elementos tipo barra no
colineales en la zona de su unién, como ocurre por ejemplo en la unién de una viga
y una columna.

En estructuras con elementos de grandes dimensiones la longitud del traslape
puede ser una fraccion significativa de la longitud total del elemento conectado, por
ejemplo en la union de una viga y una placa.

Para cada elemento tipo barra se pueden definir dos longitudes de extremo rigido

(End-1'y End-J) y un factor de zona rigida. Las longitudes End-1 y End-J permiten
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desplazar la cara del elemento, inicialmente ubicada en el nudo de intercepcion (i 6
j), a la frontera de la zona de traslape de los elementos.

El factor de zona rigida indica la fraccion de la longitud de los extremos rigidos que
se comportara rigidamente a deformaciones por flexion y corte. Este factor puede
variarentre Oy 1.

Por defecto ETABS asume un valor de 0, lo cual significa que los extremos rigidos
tienen la misma rigidez y propiedades de seccion barra que el resto del elemento.
Las deformaciones axiales y torsionales no son afectadas en la zona rigida debido
a que el programa asume que la longitud total de elemento es flexible para esas
deformaciones.

El programa, también puede calcular automaticamente las longitudes de los
extremos rigidos de un nudo, como las longitudes de traslape de los elementos
conectados. Aun en este caso, se debe especificar un valor apropiado del factor de
zona, pues ETABS considera por defecto 0.

En la figura 3-19b se muestran los extremos rigidos que el programa calcula en la

unién de una columna con dos vigas de diferente peralte.

a.- Perspectiva de la unién de 3 b.- Extremos rigidos de los c.- Perspectiva de la union de 3
elementos sin extremos rigidos. elementos. elementos con extremos rigidos.

Figura 3-19.- Extremos rigidos en la union de una columna y dos vigas de diferente peralte.

Extremos Excéntricos en Barras

El programa asume por defecto, que la unién entre una columna y las vigas que
llegan a ella ocurre en el nudo en el cual coinciden el centroide de la seccion
transversal del extremo superior de la columna y los puntos centrales superiores de
las secciones transversales de los extremos de las vigas que llegan a la columna.
Sin embargo, en estructuras reales este no siempre es el caso.

Un ejemplo de ello se muestra en la figura 3-20, que representa la vista en planta
de un edificio conformado por un sistema de columnas, vigas y losas, en donde las
vigas de borde se encuentran desplazadas excéntricamente con respecto al eje de

las columnas.
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Figura 3-20.- Vista en planta de un edificio con vigas de borde conectadas excéntricamente a sus
columnas.

Para poder modelar estos casos, ETABS provee a cada seccion transversal de 11

puntos cardinales, tal como se muestra en la figura 3-21 para una seccion Canal.

A2

—e ©

Inferior izquierda
Inferior centro
Inferior derecho
Medio izquierdo
Medio centro
Medio derecho
Superior izquierdo
Superior centro

. Superior derecho
10. Centroide

11. Centro de corte

OCoOoNDA RGN

S

1 2 3
Figura 3-21.- Puntos cardinales de una seccion transversal.

Para secciones simétricas respecto a los dos ejes, los puntos cardinales 5, 10y 11
coinciden.

Los puntos cardinales sirven para especificar el punto de pase del eje 1 del
elemento, que por defecto en las columnas es el centroide y en las vigas el punto
centro superior.

Es posible ademas conectar excéntricamente una viga a una columna al definir un
desplazamiento en los extremos de la viga en las direcciones de los ejes locales o
globales a partir de un punto cardinal elegido. Las conexiones excéntricas son
completamente rigidas.

Una vez especificada una conexién excéntrica para un elemento, los ejes locales de
éste se basaran en su posicién final. Similarmente, la ubicacién de las cargas
asignadas al elemento se basaran en su longitud y ubicacion final, después de
aplicadas las conexiones excéntricas.

La figura 3-22 muestra cdémo varia la direccion final de los ejes locales después de
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asignar una excentricidad a uno de los extremos de una viga en planta. Inicialmente
la viga se extiende del extremo i al extremo |, el eje local 2 apunta hacia arriba.
Después de definir la excentricidad en el extremo j, la viga se extiende del extremo i

alextremo 'y el eje local 1' apunta deiaj'.

Posicion inicial Posicion final
Figura 3-22.- Ejes locales en viga, antes y después de definir una excentricidad de punto en su
extremo j.

3.1.8 Objetos de Area

Las estructuras bidimensionales pueden verse afectadas por cargas en su propio
plano, cargas perpendiculares a él o una combinaciéon de ambos casos.

Segun la direccion de las cargas y las condiciones de apoyo de los elementos, los
objetos de area pueden comportarse como membranas, placas o cascaras.

En las membranas, las cargas estan aplicadas en el plano del elemento y producen
esfuerzos internos normales y cortantes en el plano. Por lo tanto, para que una
membrana resista las cargas aplicadas debe tener rigidez en su plano.

En las placas, las cargas estan aplicadas fuera del plano del elemento y producen
esfuerzos cortantes fuera de su plano, torsiones y flexiones. Por lo tanto, para que
una placa resista las cargas aplicadas debe tener rigidez a la flexion y a torsion.

En las cascaras, las cargas aplicadas producen que el elemento se comporte como
la suma de una membrana y una placa. Por lo tanto, para que una cascara resista
las cargas aplicadas debe tener rigidez en su plano y fuera de él.

La figura 3-23 muestra los diferentes comportamientos que presenta un objeto de
area en funcién de las cargas que soporta, asi como las fuerzas internas de un

elemento diferencial para cada caso.

@ Tesis publicada con autorizacion del autor

SOME RIGHTS RESERVED Algunos Derechos Reservados. No olvide citar esta tesis




t #_% | UNIVERSIDAD

NEL PERU

Figura 3-23.- Fuerzas internas elementos diferenciales de una membrana, una placa y una cascara.

En nuestro medio, a los elementos que se comportan como membranas se les
llama placas y a los que se comportan como placas se les llama losas. Los
elementos con un comportamiento de cascara si son conocidos con el mismo
nombre.

Un método aproximado para analizar el comportamiento de estas estructuras (a fin
de obtener los esfuerzos y deformaciones en ellas) consiste en dividir la estructura
total, por medio de una malla, en una serie de regiones denominadas elementos
finitos, que se encuentran unidos entre si en puntos llamados nodos. De esta
manera se aproxima la solucién de un problema complejo mediante un modelo que
consiste en la solucién de una serie de problemas mas sencillos que se encuentran
relacionados entre si.

La figura 3-24 muestra una posible division de las estructuras bidimensionales en

elementos finitos rectangulares por medio de una malla.

MEMBRANA PLACA CASCARA

Figura 3-24.- Malla de elementos finitos en estructuras bidimensionales.
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La experiencia en el uso del método de elementos finitos (MEF) recomienda realizar
un refinamiento de la malla de elementos finitos en zonas de alta concentracion de
esfuerzos, cambios bruscos en la geometria o0 en zonas cercanas a la aplicacion de
condiciones de frontera o carga. Por otra parte, sefiala que no es necesario hacerlo
cuando se quiere obtener desplazamientos.

En el programa ETABS, un objeto de area se puede utilizar, para modelar los muros
y losas del edificio por medio de una malla de elementos finitos o como un
instrumento de reparticion de cargas. A los objetos de area se les puede o no
asignar una seccion transversal de cierto tipo.

Los objetos de area que poseen propiedades de seccion se utilizan para realizar un
andlisis por elementos finitos y se clasifican segun su orientacién en el modelo en
objetos de area tipo muro (orientacion vertical), tipo piso (orientacion horizontal) y
tipo rampa (orientacion diagonal).

Los objetos de area que no poseen propiedades de seccion son los de tipo nulo
como la seccion “ninguno” y las “aberturas”. Un objeto con seccion “ninguno” puede
ser dibujado en cualquier vista y sirve para transmitir las cargas asignadas a él a los
elementos de la estructura por medio de una técnica de metrado de cargas como la
del sobre o la del area tributaria, mientras que una “abertura” sélo se puede dibujar
en una vista en planta y sirve para crear aberturas dentro de un objeto de area con
propiedades de secciéon. Las “aberturas” se utilizan por ejemplo para modelar la

caja del ascensor o los ductos de las montantes de agua y de desague.

Propiedades de seccion en Objetos de Area

Estan conformadas por las propiedades del material y las propiedades geométricas
de la seccion, que se asignan a los objetos de area.

Las propiedades del material se desarrollaron en la seccion 3.1.5.

El programa permite asignar a un objeto de area secciones de muro, losa y
cobertura. Los objetos de area con seccién muro y losa pueden ser unidireccionales
o bidireccionales. Sin embargo, los objetos de area con seccidén cobertura son
siempre unidireccionales y sus apoyos se orientan por defecto en la direcciéon del
eje local 1.

En nuestro medio es comudn utilizar coberturas para la construccion de entrepisos
ligeros, conformados por una placa colaborante (que sirve también como encofrado
y de acero negativo) y el espesor de concreto de la losa, en edificios, mezanines,
puentes peatonales y vehiculares.

Las propiedades geométricas que se definen en el caso de las secciones de muro y

losa son las mismas pero difieren para el caso de la seccidn cobertura.
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e Secciones Muro y Losa

Los pardmetros que se especifican para definir una seccion muro y una seccién
losa son los mismos y corresponden al material, a los espesores de membrana y
flexion y al tipo de comportamiento del elemento (membrana, placa o cascara).

El espesor de membrana se utiliza para calcular la rigidez de la membrana en
secciones de cascara completa y en secciones de membrana pura, asi como el
volumen del elemento para el calculo de la masay el peso propio.

El espesor de flexion es utilizado para calcular la rigidez de curvatura y corte
transversal en secciones de cascara completa y secciones de placa pura.

ETABS permite que un objeto de area con un comportamiento de membrana sea
utilizado como un instrumento para repartir cargas. Esto es util para distribuir
automaticamente las cargas de una losa, en una direccién o en dos direcciones, a
sus vigas y muros utilizando el criterio del area tributaria. Si la carga se distribuye
en una direccion, el programa considera por defecto que la direccién de apoyo de la
losa es la del eje local 1, sin embargo éste puede ser posteriormente rotado.
También permite modelar zapatas gruesas y losas de cimentacion, para el caso de
un elemento con un comportamiento de placa o de cascara, porque puede
considerar adicionalmente el comportamiento de placa gruesa y tomar en cuenta en

el andlisis las deformaciones por corte transversal fuera del plano.

e Seccion Cobertura

Existen tres tipos de seccidén cobertura, que son la seccién cobertura rellena, la
seccion cobertura sin rellenar y la seccién losa maciza. Estas secciones se

muestran en la figura 3-25.

-hs Wr tc Wr hs
— F— IIT jtc
i /J;h W
s | | s ]
a.- Cobertura rellena b.- Cobertura sin rellenar c.- Losa maciza

Figura 3-25.- Tipos de secciones de los elementos tipo cobertura.

Para crear las secciones de cobertura rellena y losa maciza es necesario
especificar sus parametros geométricos, las caracteristicas de los conectores de
corte y el peso por unidad de &rea. Para el caso de la cobertura sin rellenar se debe
especificar sus pardmetros geométricos, el espesor de corte de la cobertura y el

peso por unidad de area.
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Tabla 3-1.- Propiedades de los tipos de seccién cobertura.

Tipo de seccidn

Cobertura

rellena
Cobertura sin

rellenar
Losa maciza

Propiedades
geomeétricas

Frofundidad de |a losa (i)

<.

Frofundidad de la cobertura (hr)

Ancho de log canales fwr)

Espaciamiento promedio entre canales (5r)

Propiedades de
los conectores
de corte

Diametro

Altura (hs)

Resistencia Ultima a tensidn (Fu)

Propiedades de
los materiales

Material de la losa

Material de la cobertura

W

Espesor de corte de la cobertura

W

Peso unitario de la cobertura metalica

Los elementos con seccidn cobertura no muestran Ssus

ejes locales, sino la

direccién en la cual se apoyan, que por defecto es la direccion del eje local 1, sin

embargo esta direccion puede ser posteriormente rotada un angulo cualquiera, tal

como se muestran en la figura 3-26.

¥

‘. 7

¥

@

@

90

Y
A

@

@

Y
A

Figura 3-26.- Orientaciéon de un elemento tipo cobertura, antes y después de ser rotado 90°

Modificadores de Propiedades de Seccidn

Se utilizan para modificar tanto a la rigidez del elemento, al especificar los factores

(f11, 22, f12, m11, m22, m12, v13, v23), asi como a su masa y peso. Los factores

f11, f22, f12 afectan a la rigidez de membrana, los factores m11, m22, m12 afectan

a la rigidez a la flexion y los factores v13, v23 a la rigidez al corte.

Por ultimo, estos factores de modificacion sélo afectan las propiedades de andlisis,

pero no a las propiedades de disefio.

©
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3.1.9 Piersy Spandrels

Por efecto de las cargas de gravedad y sismo en el interior de los muros aparecen
esfuerzos normales y de corte. Sin embargo, para efectos de disefio es necesario
integrar estos esfuerzos para determinar las fuerzas internas en las secciones del
elemento (fuerza axial, fuerzas cortantes, momento torsor y momentos flectores).

El programa ETABS permite tratar a las porciones de muros (bidimensionales)
como si se tratase de elementos tipo barra (unidimensionales), integrando los
esfuerzos para reportar las fuerzas internas en cada seccién transversal. Esto se
realiza identificando a dichas porciones de muro como elementos de muro pier o

spandrel, como se detalla a continuacion.

Muros Pier

Un muro pier permite obtener las fuerzas internas en secciones horizontales de
muros formados por objetos de area verticales (tipo muro), o por una combinacion
de objetos de areay de linea verticales.

Por ejemplo, en la figura 3-27a se muestran los esfuerzos normales y de corte
presentes en la seccion horizontal superior de un muro en forma de L. Las Fuerzas
internas en la seccion horizontal superior, que se muestran en la figura 3-27b, son

obtenidas al integrar los esfuerzos en dicha seccion.

M2

\ V3

Eje Neutro

a.- Distribucion de esfuerzos en la seccion horizontal b.- Fuerzas Internas en la seccién horizontal
superior de un muro en forma de L. superior de un muro pier tridimensional.

Figura 3-27.- Esfuerzos en un muro tridimensional y sus fuerzas internas obtenidas para el muro pier.

También se pueden usar elementos de linea junto con los de area dentro de un
muro pier para modelar, por ejemplo, muros de albafileria confinada, como el

mostrado en la figura 3-28.
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Figura 3-28.- Muro de albafiileria confinada modelada con un muro pier formado por elementos de
lineay de area.

Los muros pier pueden ser bidimensionales, si estan formados por objetos
contenidos en un solo plano vertical, o tridimensionales, si los objetos que los
forman estan contenidos en dos 0 mas planos verticales.

Cuando se trata de muros pier tridimensionales, el plano del muro pier es paralelo a
la porcion de muro de mayor longitud, pero si las porciones de muro son de la

misma longitud, sera paralelo a la que se dibujoé primero.

e Ejes locales de muros pier

Todos los muros pier poseen un sistema dextrégiro de ejes locales 1-2-3, en donde
el eje local 1 sigue la direccién +Z. El eje local 2 se encuentra en el plano del muro
pier y tiene una proyeccién positiva en la direccion +X. Cuando el muro es paralelo
al eje Y, el eje 2 sigue la direccion +Y. Los ejes locales para muros pier

bidimensionales y tridimensionales se muestran en la figura 3-29.

-
t "~ _  Plano del muro Pier

Figura 3-29.- Ejes locales en muros pier bidimensionales y tridimensionales.
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e Etiquetado de muros pier

En la figura 3-30 se muestran los diagramas de Fuerza Axial en cada una de las

porciones de un muro plano perforado de tres niveles.

A
(¢ )
PLANTA 3
= PLANTA 2
l PLANTA 1
v BASE
[55] A [55] [=

Figura 3-30.- Diagramas de fuerza axial en muros pier.

Para obtener los diagramas de fuerzas internas en secciones horizontales de las

porciones verticales del muro, éstas se deben idealizar como elementos tipo barra,

como se observa en la figura 3-31.

(1 i 1 1 1
Sl % ! -t
LA B (o] D
- ¥ 3 -
PLANTA 3
| | | PLANTA 2
= % | PLANTA 1
N BASE
[55] A 5] 5]

Figura 3-31.- Idealizacién de porciones de muro como elementos unidimensionales.
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Para lograr esta idealizacion, se asignan etiquetas de muro pier a las porciones en
gue se necesiten los diagramas de fuerzas internas, como se muestra en la figura
3-32.

— :_:4 =)
—4_54‘ >
— §—| =)

- é—l =)

PLANTA 3

PLANTA 2

PLANTA 1

5=

Z

.
N

BASE

=)
B

[5E

Figura 3-32.- Ejemplo de etiquetado de muros pier.

Con esta asignacién se logra identificar a las porciones verticales izquierda y
derecha del muro como P1 y P2 respectivamente. El programa maneja cada nivel

de P1y P2 como un solo elemento individual dividido por niveles.

Muros Spandrel

Un muro spandrel puede estar formado por objetos de area verticales (elementos
de céascara tipo muro) o por una combinacién de objetos de area y de linea
horizontales.

Por ejemplo, en la figura 3-33a se muestran los esfuerzos normales (o) y de corte
(t) presentes en la seccion vertical extrema de una viga de acoplamiento modelada
con elementos de area. Las Fuerzas internas en la seccion vertical extrema (V2,
M3), que se muestran en la figura 3-33b, se obtienen al integrar los esfuerzos en la

seccion.
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a.- Distribucién de esfuerzos en la seccién b.- Fuerzas Internas en la seccién vertical de una
vertical de una viga de acoplamiento. viga de acoplamiento.

Figura 3-33.- Esfuerzos en una viga de acoplamiento y sus fuerzas internas.

e Ejes locales de muros spandrel

Los muros spandrel poseen un sistema dextrégiro de ejes locales 1-2-3, en donde
el eje local 1 es horizontal, dentro del plano del muro spandrel, y tiene una
proyeccion positiva en la direccion +X, pero si el muro spandrel es perpendicular al
eje X, seguira la direccién +Y. El eje 2 siempre sigue la direcciéon +Z. La figura 3-34

muestra los ejes locales en muros spandrel.

Figura 3-34.- Ejes locales en muros spandrel.
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e Etiquetado de muros spandrel

Cada elemento dentro de un muro spandrel est4 asociado al nivel de piso mas alto
gue este elemento interseca o toca. Si no intersecara ningun nivel, éste pertenecera
al nivel de piso inmediato superior. La figura 3-35 muestra la asociacion a niveles
de piso de los muros spandrel.

Planta A Planta A
<
@]
R
[oN
. o
=
w
J7
Planta B Planta B

Figura 3-35.- Asociacion de muros spandrel a niveles de piso.

A diferencia de los muros pier, un muro spandrel puede contener objetos de area de
dos niveles de piso adyacentes.
En la figura 3-36 se muestra el diagrama de Momento Flector en cada una de las

porciones de muro perforado plano de tres niveles.

(o~

—(o1~)

PLANTA 3

d
R

PLANTA 2

PLANTA 1

ki

[=

.
N

BASE
==

Figura 3-36.- Diagrama de momento flector en muros spandrel.

Para obtener los diagramas de fuerzas internas en muros, las vigas de
acoplamiento se idealizan como elementos tipo barra, como se observa en la figura
3-37.
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PLANTA 3

PLANTA 2

PLANTA 1

BASE

Figura 3-37.- Idealizacién de vigas de acoplamiento como elementos unidimensionales.

Para idealizar las vigas de acoplamiento como elementos unidimensionales, se les

asigna etiquetas de muro spandrel, como se presenta en la figura 3-38.

PLANTA 3

PLANTA 2

PLANTA 1

BASE
C I

B

Figura 3-38.- Ejemplo de etiquetado de muros spandrel.

Se observa que las tres vigas de acoplamiento tienen las mismas etiquetas de muro
spandrel S1 y S2, pero el programa las manejara como elementos independientes
en cada nivel.

Para los elementos de barra, muros pier y muros spandrel, los diagramas de
fuerzas internas se obtienen uniendo con segmentos rectos los valores calculados

en los puntos prefijados como ubicaciones de salida. Sin embargo, para elementos
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de muro pier y spandrel, los valores de fuerzas exactas son calculados soélo en los
extremos del elemento y por tanto cuando los diagramas de fuerzas internas no son
lineales, los valores intermedios no son representativos y los resultados s6lo son
validos en los puntos extremos calculados.

Debido a este detalle, cuando el disefio es gobernado por cargas de gravedad, se

recomienda modelar las vigas de acoplamiento con elementos de barra.

3.1.10 Diafragma Rigido

Las losas de entrepiso que conforman la estructura de una edificacion presentan
mayor rigidez en su propio plano que fuera de él. Por esta razén se pueden
idealizar como cuerpos infinitamente rigidos para deformaciones en su propio
plano. La figura 3-39 ilustra lo que ocurre con un diafragma rigido para una carga

cualquiera “P”.

Losa cargada transversalmente Losa cargada en su propio plano

Figura 3-39.- Deformaciones internas de una losa ante diferentes tipos de carga

En la direccion perpendicular al plano del diafragma éste es flexible, por lo tanto,
para cualquier nudo del diafragma, la existencia de desplazamientos verticales y
rotaciones alrededor de los ejes horizontales (que son independientes del
movimiento del diafragma) no afectan la idealizacién.

Para describir el movimiento de un diafragma rigido en el plano horizontal sélo es
necesario conocer dos desplazamientos horizontales ortogonales (en las
direcciones X y Y) y un giro, alrededor de un eje perpendicular al plano del
diafragma (eje 2).

En la figura 3-40, se representa una estructura de un piso compuesta por cuatro
porticos y un diafragma rigido desplazado una distancia “8”, en la direccion global
X. En ella se puede apreciar, que los nudos de las columnas unidos a la losa,
presentan el mismo desplazamiento horizontal “6”, pero diferentes desplazamientos
verticales producto de la deformacion axial de las columnas (los nudos del lado

izquierdo se han desplazado hacia arriba y los del lado derecho hacia abajo).
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Figura 3-40.- Deformaciones en los elementos de una estructura de un piso, con diafragma rigido en
su propio plano, ante un desplazamiento en la direccién X

También se observa que estos nudos presentan giros alrededor de los ejes Xy Y,
debido a las deformaciones por flexion de los elementos. Estos giros son
independientes del giro del diafragma.

En resumen, dos puntos cualesquiera que formen parte de la losa de entrepiso (que

se comporte como un diafragma rigido) no pueden tener desplazamientos relativos

dentro del plano horizontal, no obstante, pueden tener desplazamientos relativos en
la direccién vertical y giros con respecto a cualquier eje horizontal.

Las ventajas de idealizar una losa de entrepiso como diafragma rigido son las

siguientes:

- Permite compatibilizar los desplazamientos de todos los elementos contenidos
en el diafragma, y analizar la estructura como un conjunto, lo que brinda
resultados mas confiables que los obtenidos al analizarla con porticos
independientes.

- Demanda menos memoria y tiempo en el proceso de analisis de los programas
de computo, como el ETABS, debido a que se reduce el tamafio de la matriz de
rigidez tridimensional del edificio.

- Distribuye autométicamente las fuerzas horizontales a los diferentes elementos
verticales resistentes, en proporcion a sus rigideces.

- Toma en cuenta el efecto de torsibn de toda la estructura, lo cual es
especialmente importante en estructuras con resistencia vertical irregular o con
plantas irregulares. Por lo tanto en estructuras donde los centros de masa y de
rigidez no coinciden, la idealizacion de diafragmas rigidos toma en cuenta
automaticamente la torsion que genera la aplicacion de fuerzas horizontales en

lugares diferentes del centro de rigidez.
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Diafragma rigido en objetos de area

Dentro del programa ETABS, si se asigna un diafragma rigido a un objeto de area,
se logra que todos los puntos del perimetro y los puntos que se encuentran dentro
de los limites del objeto de area, incluyendo los puntos (nudos) creados como
resultado de una particion automatica, se comporten como parte del diafragma
rigido.

Al asignar un diafragma rigido a un objeto de area, su comportamiento fuera del
plano no se vera afectado.

Los diafragmas rigidos solamente pueden ser horizontales, por lo tanto no se
pueden asignar a objetos de area tipo muro ni a objetos de area tipo rampa, sino
s6lo a los objetos de area tipo piso y a los objetos de area tipo nulo que estén en un

plano horizontal.

Diafragma rigido en objetos de punto

A un objeto de punto se le puede asignar directamente una restriccion de diafragma
rigido, de modo que se comporte como lo haria si fuera parte de un diafragma
rigido.

Al asignar un diafragma rigido a un objeto de punto, su comportamiento fuera del

plano horizontal (formado por los objetos de punto) no se vera afectado.

Célculo del centro de rigidez lateral de un diafragma

El centro de rigidez (CR) es un concepto que fue definido inicialmente para
estructuras de un solo piso, como el punto correspondiente al centroide de las
rigideces laterales de todos los elementos resistentes de la estructura. Este punto
es una funcién de las propiedades estructurales, es independiente de la carga y es
el Unico que no se traslada cuando el edificio estd sometido a un momento torsor.
Para los edificios de varios niveles no tiene sentido hablar de un solo centro de
rigidez debido a que cada piso rotara relativamente con respecto a los demas por la
interaccion de fuerzas entre los diferentes pisos del edificio.

Por lo tanto, para el andlisis lateral de este tipo de edificios, la suposicion que mejor
se aproxima a la realidad es analizar al edificio como una serie de edificios de un
solo piso, apilados uno sobre otro, sin compatibilidad de desplazamientos de
entrepiso.

Existen diversos métodos para estimar el centro de rigidez, como por ejemplo el
utilizado por algunos programas europeos, que consiste en dar un momento torsor
unitario en algun punto arbitrario de la losa de piso con el fin de determinar el centro
de rigidez como el punto sin desplazamiento lateral.

El programa ETABS, puede calcular los centros de rigidez para cada diafragma
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rigido como parte de la solucion del problema. Para ello utiliza 3 casos de carga
unitaria, que se aplican en el centro de masa (CM) del piso en estudio, tal como se
muestra en la figura 3-41.

Caso 1 Caso 2 Caso 3

CR R CR
*T’ [ ]
. s .
o ezy JGZZ’
p d o i
v om 00 | cM oM
Fx=1 @ ® @
Mz=1
A
X

=

z Fy=1

Figura 3-41.- Casos de carga utilizados para determinar el centro de rigidez.

Como resultado de cada uno de los estados de carga se obtienen los giros 6zx, 6zy
y 0zz respectivamente, con los cuales se calcula la distancia horizontal (dx) y
vertical (dy) del centro de masa al centro de rigidez, como:

dx =-0zy/ 06zz

dy = - 0zx/ 0zz

Finalmente, con dx y dy se ubica el centro de rigidez de cada piso, como:

Xcr = Xew + dX

Ycr = Yeu + dy

3.1.11 Masas

La masa de la estructura se utiliza en un analisis modal para calcular los periodos y
formas modales de vibracion y en un andlisis de respuesta en el tiempo o espectral
para calcular las fuerzas de inercia y posteriormente las solicitaciones internas que
estas producen.

En los elementos lineales, la masa se calcula integrando el producto de la masa
volumétrica del material por su area transversal, a lo largo de la longitud del
elemento. En los elementos de area, la integral corresponde al producto de la masa
volumétrica del material por el espesor del elemento y se extiende en toda su area.
Posteriormente, para ambos casos, la masa se distribuye a los nudos de los

elementos.

Fuente de Masa

En el programa ETABS, la masa del edificio puede obtenerse de la masa propia de
los elementos y la masa adicional asignada en los objetos de punto, de linea y de

area. También puede obtenerse la masa de las cargas que actuan sobre el edificio
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y en un caso mas general, ésta puede obtenerse en base a los 2 casos anteriores.

Estos 3 casos se detallan a continuacion.

* De masa propiay masa especificada

En este caso, la masa del edificio se encuentra asociada a la masa propia de los
elementos estructurales y a la masa adicional asignada en los objetos de punto, de
linea y de area. La masa propia se calcula multiplicando el volumen de cada
elemento por su masa por unidad de volumen.
La masa especificada, es la masa adicional asignada a los elementos (tabiques,
revestimientos, etc.), y se aplica de manera concentrada a los objetos de punto y de
manera uniformemente distribuida a los objetos de linea y a los objetos de area.
- Masa adicional en objetos de punto
Se deben especificar las masas traslacionales en las direcciones de los tres
ejes globales y los momentos de inercia rotacionales alrededor de las
direcciones de los ejes globales.
En las direcciones globales X y Y el valor de la masa traslacional es el
mismo porque la masa en cualquier direccion del sismo es la misma.
Las masas traslacionales presentan unidades de Fuerza*Segundo?® /
Longitud y los momentos de inercia rotacionales unidades de
Fuerza*Longitud*Segundo?.
- Masa adicional en objetos de linea
Se debe especificar la masa adicional por unidad de longitud, que el
programa aplicara solamente a los tres grados de libertad traslacional, a
menos que se considere sélo la masa lateral, para lo cual, la masa adicional
se aplicara Unicamente en las direcciones globales X y Y.
Esta masa tiene unidades de Fuerza x Segundo? / Longitud?.
- Masa adicional en objetos de area
Se debe especificar la masa adicional por unidad de area, que el programa
aplicara solamente a los tres grados de libertad traslacional, a menos que se
considere solo la masa lateral, para lo cual, la masa adicional se aplicara
Unicamente en las direcciones globales Xy Y.

Esta masa tiene unidades de Fuerza x Segundo? / Longitud?.

e De cargas

En este caso, la masa de la estructura se define por medio de una combinacion de

los casos de carga previamente definidos. La masa total es igual a la suma de las
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cargas, escaladas el factor de cada uno de los casos de carga, divididas entre la
gravedad. Para este célculo sélo se consideran las cargas en la direccion global Z.
Cuando la fuente de masa es de cargas, el programa ignora toda masa adicional
asignada.

» De masa propia, masa especificada y cargas

Es la suma de las opciones anteriores, la cual considera para el calculo de la masa
del edificio a las masas propias de los elementos estructurales, a las masas

adicionales y a la masa que se obtiene de la combinacién de los casos de carga.

En cualquiera de los tres casos posibles de fuentes de masa, se puede elegir
“incluir solamente la masa lateral” y/o “concentrar la masa lateral en las plantas”

Si se elige “incluir solamente masa lateral”, se considerara en el analisis solo las
masas traslacionales asignadas en las direcciones globales X y Y, y los momentos
de inercia rotacionales de masa alrededor del eje global Z, y no se tomara en
cuenta la dinamica vertical del edificio.

Si se elige “concentrar la masa lateral en las plantas”, entonces, durante el analisis,
la masa lateral ubicada entre dos plantas se concentrara en la planta mas cercana

a dicha masa.

3.2 Analisis Estatico Elastico

El Andlisis Estatico Elastico es un analisis de cargas que no varian en el tiempo y
en el cual la estructura no excede el rango elastico.

Las cargas estaticas pueden tener un origen gravitatorio, de viento, de nieve, etc.
Existen procedimientos para el analisis sismico de edificios en los que las
solicitaciones sismicas se pueden representar por medio de un conjunto de cargas
estaticas.

El programa ETABS, organiza el Andlisis Estatico en casos de carga estatica, cada
uno de los cuales contiene un conjunto de cargas de origen semejante y que actlian

simultaneamente en los objetos del modelo.

3.2.1 Casos de Carga Estatica

Un caso de carga estatica se define indicando un nombre, un tipo de carga y un
factor para incluir el peso propio de la estructura en las cargas que actian en los

objetos del modelo.
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Nombre del Caso de Carga.- Es una cadena de caracteres definida por el
usuario para identificar el caso de carga.

- Tipo de Carga.- Con el fin de usar combinaciones predefinidas de casos de
carga, el programa permite asignar a cada caso de carga uno de los siguientes
tipos: Muerta, Super Muerta, Viva, Reduccion de Carga Viva, Sismo, Viento,
Nieve y Otras.

- Factor de Peso Propio.- El programa multiplica el peso propio de los objetos
de la estructura por este factor y los afiade al caso de carga. El peso propio de
la estructura se suele asignar totalmente al caso de carga muerta, por medio de
un factor igual a uno. En contraste, este factor es igual a cero para los casos de
carga viva.

En el programa, los casos de carga estatica Muerta y Viva se crean por defecto con

los nombres “DEAD” y “LIVE” respectivamente y con los valores del factor de peso

propio indicados.

Las cargas de los casos de carga estatica de viento o de sismo pueden ser

asignadas mediante cargas concentradas o distribuidas, pero también de manera

automatica al elegir un cédigo de carga apropiado.

3.2.2 Cargas en Objetos

En cada operacion de asignacion de cargas a un objeto se debe elegir un caso de
carga estética previamente definido.

Se pueden asignar cargas a objetos de punto, de linea o de area.

Cargas en objetos de punto

A un objeto de punto se le puede asignar: fuerzas, desplazamientos y cambios de

temperatura.

4
e [uerzas ==

Se asigna una carga de fuerza a un objeto de punto, indicando la magnitud de las
fuerzas o momentos en la direccién de los ejes globales, teniendo en cuenta que la
direccién positiva de las fuerzas y momentos corresponde a la direccién positiva de

los ejes globales, los que se muestran en la figura 3-42.
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Figura 3-42.- Sentido positivo de las fuerzas y momentos en un objeto de punto.

Las cargas asignadas en los puntos que se encuentran a lo largo de un objeto de
linea o dentro del plano de un objeto de area, pasan a formar parte del caso de
carga especificado siempre y cuando el objeto de linea o de area tenga activa la

opcién de subdividido automatico.

. i
o Desplazamientos de nudos “conectados al suelo” =

Se asigha una carga de desplazamiento (6) a un objeto de punto indicando el
desplazamiento en los ejes de coordenadas globales, como se muestra en la figura
3-43.

El desplazamiento asignado a un nudo es considerado como carga estatica solo si
previamente se le ha asignado a éste una “conexién al suelo” en la misma direccién
de su desplazamiento (traslacién o rotacion).

Se entiende por “conexién al suelo” a una restriccion, un resorte o un elemento de
enlace.

Este desplazamiento tiene efecto sobre la estructura si el objeto de punto esta
conectado directamente a un objeto estructural o descansa sobre un objeto de area

de tipo piso, que el ETABS pueda dividir automaticamente.

777 517 77

77

Figura 3-43.- Asentamiento de apoyo.
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e Temperatura b5

Se asigna un cambio de temperatura (en °C) a un objeto de punto para definir una
variacion de temperatura uniforme a lo largo de los elementos de barra o de
cascara que se conectan al nudo.

Cuando se asigna un cambio de temperatura en los nudos extremos de los objetos
de linea o en los nudos de las esquinas de los objetos de area, el programa
interpola linealmente los valores del cambio de temperatura a lo largo de ellos.

Cargas en objetos de linea

A un objeto de linea se le puede asignar: cargas concentradas, cargas distribuidas
y cambios de temperatura.

e Cargas concentradas en objetos de linea Ca

Para asignar una carga concentrada (fuerza o momento) en un objeto de linea se
indica su direccién, su magnitud y distancia con respecto al extremo i del objeto de
linea. Esta distancia puede ser relativa o absoluta.

La carga puede actuar en la direccion de los ejes locales o globales.

e Cargas distribuidas en objetos de linea =4

Las cargas distribuidas (fuerzas o momentos) pueden ser uniformes o
trapezoidales.

Para asignar una carga uniforme sélo se necesita especificar su magnitud y
direccién en la que actla.

En cambio, para las cargas trapezoidales, ademas de especificar la direccion en la
gue actla, se debe indicar la magnitud de la carga y su distancia con respecto al
extremo i del elemento, para los diferentes trapecios consecutivos. Estas distancias

pueden ser relativas o absolutas, como se muestra en la figura 3-44.
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Figura 3-44.- Ejemplos de cargas distribuidas en objetos de linea.

La carga puede orientarse en la direccién de los ejes locales y globales.

En el caso de objetos de linea inclinados, una fuerza distribuida, orientada en
alguno de los ejes globales, puede actuar por unidad de longitud del objeto o por
unidad de longitud proyectada del objeto en el eje global perpendicular a la carga.
La figura 3-45a muestra una carga de magnitud w en la direccién de la gravedad,
gue actla por unidad de longitud proyectada en el eje X. El programa ETABS
interpreta esta carga, como una carga distribuida por unidad de longitud del objeto

de linea pero con una magnitud w cos(6) como se muestra en la figura 3-45b.

2 0 2 0
Zz z
| L coso \
X X
a.- Carga distribuida o en la direccion de la b.- Representacion de la carga distribuida ©
gravedad, aplicada sobre la longitud proyectada actuando sobre toda la longitud del objeto de
del objeto de linea en el gje X. linea.

Figura 3-45.- Objeto de linea inclinado, con carga aplicada sobre una proyeccién de su longitud.
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e Temperatura I=

Se asigna un cambio de temperatura (en °C) a un objeto de linea al indicar el valor
del cambio uniforme de temperatura en el objeto de linea. También se puede
asignar una variacion uniforme de cambio de temperatura al especificar los cambios
de temperatura en los nudos extremos del objeto de linea, como se menciond en la
seccion de cargas en objetos de punto.

Se pueden combinar cambios de temperatura asignados a objetos de linea con
cambios de temperatura en los nudos de sus extremos. En esos casos el programa

suma ambas cargas de temperatura.

Cargas en areas

A un objeto de area se le puede asignar: cargas uniformes, cargas de temperatura y

cargas de viento.

. . ’ i
e Cargas uniformes en objetos de area *7

Para asignar una carga uniforme a un objeto de area se indica su magnitud y la
direccion en la que actia.

La carga puede orientarse en la direccién de los ejes locales y globales.

En el caso de objetos de area inclinados, una fuerza distribuida, orientada en
alguno de los ejes globales, puede actuar por unidad de superficie del objeto o por
unidad de superficie proyectada del objeto en el eje global perpendicular a la carga.
La figura 3-46a muestra una carga de magnitud w en la direccién de la gravedad,
que actua por unidad de area proyectada del objeto en el eje X. El programa
ETABS interpreta esta carga, como una carga distribuida por unidad de area del

objeto pero con una magnitud w cos(0), como se muestra en la figura 3-46b.
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X X
a.- Carga distribuida o en la direccién de la b.- Representacion de la carga distribuida o
gravedad, aplicada sobre la superficie actuando sobre toda la superficie del objeto de
proyectada del objeto de area en el eje X. area.

Figura 3-46.- Objeto de area inclinado, con carga distribuida aplicada sobre una proyeccion de su
superficie.

e Temperatura I

Se asigha un cambio de temperatura (en °C) a un objeto de area al indicar el valor
del cambio uniforme de temperatura sobre la superficie de un objeto de area.
También se puede asignar una variacién uniforme de cambio de temperatura al
especificar los cambios de temperatura en los nudos extremos del objeto de éarea,
como se menciond en la seccidén de cargas en objetos de punto.

Se pueden combinar cambios de temperatura asignados a objetos de area con
cambios de temperatura en los nudos de sus esquinas. En esos casos el programa
suma ambas cargas de temperatura.

Por ejemplo en la figura 3-47, se ha asignado un cambio de temperatura de 50°C
en los nudos superiores de un objeto de area, el mismo que se ha sumado al
cambio uniforme de temperatura de 25°C (figura 3-48), para obtener un cambio de
temperatura resultante en el objeto de area de 75°C en los nudos superiores y de

25°C en los nudos inferiores, como se muestra en la figura 3-49.
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1) 1 Area Object Temperatures
: TS & R
(A ) (B )
T T Load Case Name IDEAD VI
PLANTA 1
50. — Object Temperature Object Temperature Options
Uniform Temperature Change ID. ¢ Add to Esisting Temperature
— Corner Point Temperature Option & Replace Existing Temperature
Z W Include Effects of Pairt Temperatures " Delete Existing Temperature
0. 0. Ok I Cancel |
N BASE
- ] A ]

Figura 3-47.- Objeto de area con cambio de temperatura de 50°C en nudos superiores.

!\‘ 1 Y (1) Area Object Temperatures
< and
LA ) (B)
T T Load Case Hame IDEAD VI
PLANTA 1
25. 25. — Object Tenperature Object Temperature Options
Uniform Temperature Change |25. o i [ TR
— Corner Point Temperature Option ' Replace Existing Temperature
7 [ Include Effects of Point Temperatures ¢ Delete Existing Temperature
25. 25. Ok I Cancel |
N BASE
+ X

Figura 3-48.- Objeto de area con cambio de temperatura uniforme de 25°C.

( 1) 19 \J Area Object Temperatures
LA) (B)
\ s
T [ Load Case Hame IDEAD VI
PLANTA 1
75. 75. — Object Temperature Object Temperature Options
Uniform Temperature Change |25. e e
— Corner Point Temperature Option & Replace Existing Temperature
Z W Include Effects of Pairt Temperatures " Delete Existing Temperature
Ok I Cancel |
2a: N 23 BASE
[=5] A [5x]

Figura 3-49.- Objeto de area con cambio de temperatura resultante.

e Presion de Viento

Una edificacién soporta una carga de viento cuando se interpone en la direccién del
movimiento de una masa de aire.

La carga de viento origina presiéon en las caras de la edificacion que estan
expuestas a la direccion del viento (barlovento), y succién en las caras opuestas a

la direccién del viento (sotavento), tal como se ilustra en la figura 3-50.
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Sotavento
(Succidn)

Barlovento
(Presion)

Figura 3-50.- Direccion del viento y fuerzas de presién y succion.

En el programa ETABS, antes asignar una carga de presion de viento, predefinida
por algun cddigo, se debe definir un caso de carga estética de viento y seleccionar
una norma de viento para la carga lateral automatica.

Se calcula automaticamente la magnitud de una carga de viento asignada a un
objeto de area al indicar un coeficiente de presion de viento para la norma
seleccionada. La direccion puede ser de barlovento o sotavento.

Las cargas de presion de viento en objetos de area, ya sean de barlovento o
sotavento, siempre siguen la direccién positiva del eje local 3 del objeto de area.

Si no se asigna una norma lateral de viento, las cargas que pertenecen al caso
estatico de viento podran ser asignadas a los objetos del modelo como cargas

concentradas o distribuidas, pero no como cargas de presion de viento.
3.3 Andlisis Dinamico Elastico

En el Andlisis Dinamico, los desplazamientos de la estructura varian con el tiempo,
generando velocidades y las aceleraciones que también varian con el tiempo.

Los desplazamientos, velocidades y aceleraciones de la estructura generan
respectivamente fuerzas restitutivas, fuerzas de amortiguamiento y fuerzas de
inercia variables en el tiempo, que deben tenerse en cuenta al momento de plantear

la ecuacién de equilibrio dinamico:

MxX+ C X+ KX = —-Ms

Donde:
M = Matriz de masa.
C = Matriz de amortiguamiento.
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Matriz de rigidez lateral.
= Desplazamiento relativo con respecto al suelo.

s = Desplazamiento del suelo.

S = Aceleracion del suelo.

Desde el punto de vista dinamico solo interesan los grados de libertad (GDL) en los
que se generan fuerzas de inercia significativa. Estos grados de libertad se
denominan grados de libertad dinamicos.

La figura 3-51a representa una vista en elevacion de un edificio con un diafragma

rigido en cada uno de sus dos pisos y por tanto con 10 GDL estéticos.

7 T 10 T
) }» 8
6 9
5 3
) }> 1
4 2
7 7 ’ 7
a.- Grados de libertad estaticos. b.- Grados de libertad dinamicos.

Figura 3-51.- Grados de libertad estaticos y dinamicos de un pértico plano de 2 pisos.

Cuando el edificio recibe un movimiento en su base, éste oscila lateralmente y las
masas ml y m2 de cada nivel se aceleran, produciendo dos fuerzas de inercia
horizontales importantes. Por tanto el edificio s6lo tiene dos grados de libertad

dindmicos que son los desplazamientos 1 y 2, mostrados en la figura 3-51b.

Figura 3-52.- Grados de libertad dinamicos en un edificio de un piso
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En estructuras tridimensionales con diafragmas rigidos, como la mostrada en la
figura 3-52. El diafragma en cada piso posee 3 GDL dinamicos, que son los
desplazamientos horizontales u y v, en la direccion X y Y respectivamente, y el giro
6 alrededor del eje vertical Z.

El programa ETABS realiza tres tipos de andlisis dindmicos elasticos que son el
Andlisis de Modos y Frecuencias, el Andlisis Tiempo — Historia y el Andlisis de
Respuesta Espectral.

Para el Analisis Tiempo — Historia y para el Andlisis de Respuesta Espectral, es

necesario especificar una funcion que represente las solicitaciones sismicas.

3.3.1 Analisis de Modos y Frecuencias

Cada modo representa una tendencia de movimiento de una estructura. Esta
tendencia se describe por medio de una forma y un periodo natural que
corresponden al caso en que la estructura estuviese en vibracion libre sin
amortiguamiento.

Se puede demostrar que después de liberar una estructura sin amortiguamiento,
gue ha sido forzada a adoptar inicialmente una forma igual a la de un modo de
vibracion, ésta seguira vibrando libremente con la frecuencia circular del modo y
manteniendo la forma modal®.

El analisis modal permite calcular la forma y el periodo de vibracién de cada modo,
utilizando las masas y rigidez del edificio.

En el caso de edificios se asume que la masa se encuentra concentrada en los
pisos del edificio, y que estos sélo tienen tres grados de libertad dinamicos.

El programa ETABS, calcula estas tendencias de vibracién de los edificios y permite
seleccionar el numero de modos que se deciden usar en el analisis, asi como el
procedimiento para hallar estas tendencias de vibracién representativas
(eigenvectors o vectores Ritz).

Para el andlisis de vectores propios (eigenvectors), se debera especificar ademas el
rango de frecuencias de los modos, usando los parametros “fy” y “fmax’, que
representan respectivamente el centro del rango de frecuencias y el radio del rango

de éstas. De esta manera el programa buscara solamente los modos con una

frecuencia “f” que satisfagan la ecuacion |f —fy|<f .

Si no se desea restringir el rango de frecuencia de los modos, se asigna un valor de

cero al parametro fmax.

2 Informacion referida del manual de Ingenieria Sismorresistente, Alejandro Mufioz Peldez, 1999,
Primera edicion, Pontificia Universidad Catdlica del Peru. Lima, pg 111.
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A modo de ejemplo se muestra en la figura 3-53 la planta y elevacion de un edificio

de tres niveles.

— c
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Peso: 1 ton/m?2 en los 3 pisos

Figura 3-53.- Planta y elevacion de un edificio de tres niveles.

La figura 3-54 muestra las formas y periodos naturales de los modos fundamentales

en las direcciones X, Y y alrededor del eje Z.

T =0.2386 T =0.2383 T =0.0301

Figura 3-54.- Modos fundamentales en las direcciones X, Y y alrededor del eje Z

El programa ordena los modos en orden decreciente con respecto a los periodos de

vibracion.

3.3.2 Analisis Tiempo-Historia

El analisis tiempo-historia permite calcular la respuesta en el tiempo de una
estructura ante una carga dindmica cualquiera.

El programa ETABS puede realizar dos tipos diferentes de analisis tiempo historia.
El primero corresponde al caso de un edificio sometido a una aceleracion en su
base y el segundo al caso de un edificio, con base fija, sometido a un conjunto de
cargas que varian en el tiempo, como sucede en el caso de un edificio ante la

accion de rafagas de viento.
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Tanto para el caso de un movimiento en la base como para el de cargas dindmicas

externas es necesario definir una funcion en el tiempo.

Funcion de Tiempo-Historia

La funcion de tiempo-historia es un conjunto de pares de valores (t, f().

Los valores de la funcion (fp) pueden usarse como valores de aceleraciones

basales o como factores de multiplicacién de los casos de carga estética de fuerza

0 desplazamiento.

El programa ETABS permite identificar la funcion por medio de un nombre y

definirla de alguna de las siguientes maneras:

- Seleccionando un archivo de texto que contenga una funcién de tiempo historia.

El archivo puede tener las siguientes caracteristicas: un namero de lineas de
cabecera ‘nl' y ‘nc’ caracteres iniciales al principio de todas las lineas que
contienen los valores de la funcién. En el archivo, la funcién puede estar
constituida por pares de valores (t, f;)) 0 s6lo por los valores de f espaciados
un intervalo de tiempo constante (dt).
Para que el programa lea la funcién del archivo se debe especificar: ‘nl' y ‘nc’,
asi como el nimero de puntos por linea, la forma como se separan los valores
de la funcién (espacios, tabulaciones o sin separacion) y si el archivo contiene
pares de valores (t, i) 0 s6lo valores de f(. Si el archivo contiene solo valores
fw, entonces, sera necesario especificar ‘dt’.

- Ingresando directamente, por medio del teclado, los pares de valores (t, f).

- Seleccionando una funcién disponible en el programa El programa cuenta con

las siguientes funciones: seno, coseno, rampa, diente de sierra y triangular.

Tipos de Analisis Tiempo-Historia

En ETABS los dos tipos de analisis tiempo historia son:

e Aceleracion en la Base

Cuando un edificio esta sujeto a una accién sismica en su base, se puede
representar la aceleracion del suelo mediante 3 componentes ortogonales. El
programa ETABS permite asignar a las direcciones locales del suelo 1, 2 y global Z
tres funciones de tiempo historia.

Por defecto las direcciones positivas de 1 y 2 coinciden con las direcciones
positivas de los ejes globales X y Y, sin embargo el programa permite definir un
angulo de giro (a) para el triedro 1,2 y Z respecto al eje Z, tal como se muestra en la
figura 3-55.
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Figura 3-55.- Componentes octogonales de un sismo en las direcciones 1, 2 y vertical, rotados un
angulo a respecto al eje global Z

Para cada caso de analisis de aceleracién en la base, el programa calcula la
historia de aceleraciones de cada punto de la estructura y permite obtener el

espectro de respuesta correspondiente en dichos puntos (espectros de piso).

e Cargas Dinamicas Externas

Para configurar los casos de cargas dinamicas, las cargas de los casos estaticos de
fuerza o desplazamiento, se multiplican por los valores de la funcion de tiempo-
historia para convertirse en un conjunto de cargas externas variables en el tiempo.
En la figura 3-56 se muestra un conjunto de cargas estaticas concentradas en los
niveles de piso de un edificio de tres pisos, que serdn convertidas en cargas

dindmicas al multiplicarse por la funcién: f(t) = 0.7 sen (20t).

f(t)=0.7 sen (20t) *

Figura 3-56.- Edificio de tres pisos sometido a cargas estaticas concentradas, que se multiplican por
una funcién de tiempo.
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Configuracion de un Caso de Anélisis Tiempo-Historia
Para cada andlisis que se desee realizar se debe configurar un caso de andlisis
tiempo-historia indicando un nombre y especificando el amortiguamiento modal, el
numero y tamafio de los intervalos de tiempo de salida, una funcién de tiempo y
eligiendo en la opcion de carga si esta funcion multiplica a los casos de carga
estatica o si representa a un acelerograma en la base.

Los valores de la funcién pueden ser multiplicados por un factor de escala, que es
cualquier namero real. Este factor puede presentar unidades de Longitud/Tiempo?,
si los valores de la funcibn se usan como aceleraciones basales, o ser
adimensionales, si los valores de la funcién se usan como multiplicadores de los

casos de carga estatica.

Resultados del Analisis Tiempo-Historia

El programa calcula la respuesta en el tiempo del edificio, y permite visualizar

graficamente la historia de:

- Energia (cinética, potencial, disipada por el amortiguamiento).

- Momentos y cortantes en la base del edificio.

- Desplazamientos, velocidades, aceleraciones, reacciones y fuerzas de resorte
en los objetos de punto.

- Fuerzas internas en los objetos de linea y en los elementos Pier y Spandrel.

3.3.3 Analisis Espectral de Respuesta

Un espectro elastico es el conjunto de las respuestas maximas de diferentes
estructuras de un grado de libertad, caracterizadas por un periodo y un
amortiguamiento, sometidas a un acelerograma, y se representa como una funcién
de aceleraciones espectrales vs. valores de periodo o de frecuencia.

El Andlisis Espectral de Respuesta permite calcular la respuesta maxima probable
de la estructura cuando la solicitacibn sismica se representa por un espectro
elastico, combinando las respuestas de los diferentes modos por medio de un
método de combinacién modal y las respuestas en las diferentes direcciones por
medio de un método de superposicion direccional.

En el programa, las funciones espectrales deben ser asignadas a las direcciones
locales 1, 2 y 3. Por defecto las direcciones positivas locales coinciden con las
direcciones positivas de los ejes globales X, Y y Z, sin embargo ETABS permite
definir un angulo de giro (a) respecto al eje Z para el triedro 1, 2 y 3, medido desde

el eje positivo global X, tal como se muestra en la figura 3-57.
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Z

Figura 3-57.- Rotacion de los ejes locales un angulo a alrededor del eje Z.

Funcion Espectral de Respuesta

La funcion Espectral de Respuesta es una conjunto de valores de periodos (T) o de

frecuencias (f) vs. valores de aceleracion espectral (SA).

El programa ETABS permite identificar la funcién por medio de un nombre y

definirla de alguna de las siguientes maneras:

- Seleccionando un archivo de texto que contenga una funcién. El archivo puede
tener las siguientes caracteristicas: un numero de lineas de cabecera ‘nl’ y un
conjunto de lineas donde se distribuyen los pares de valores de la funcion, que
pueden ser valores de (T, SA) o (f, SA).

Para que el programa lea la funcién del archivo se debe especificar ‘nl’ y si la
funcién esta conformada por periodos o frecuencias.

- Ingresando directamente, por medio del teclado, los pares de valores (T, SA).

- Seleccionando un espectro disponible en el programa, correspondiente a alguno
de los siguientes cdodigos: UBC94, UBC97, BOCA96, NBCC95, I1BC2000,
NEHRP97, Eurocode 8, NZS4203.

Configuracion de un Caso de Analisis Espectral de Respuesta

Para cada analisis que se desee realizar, se debe configurar un caso espectral de
respuesta, indicando un nombre, especificando una funcién espectral e indicando el
factor de escala de la funcion, la orientacién de los ejes locales del suelo por medio
de un angulo de giro, el amortiguamiento modal que estara presente en todos los
modos, el tipo de combinacién modal y el tipo de combinacién direccional.

El factor de escala que multiplica a los valores de la funcién debe tener unidades

correspondientes a Longitud / Tiempo?.

e Combinacién Modal.

Para cada caso de analisis espectral, se puede combinar por medio de un método
de combinacion modal los valores de desplazamiento, fuerza y esfuerzo de cada

modo, con la finalidad de hallar la respuesta maxima de cada uno de estos
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parametros.

Los métodos de combinacion modal son: Combinacion Cuadratica Completa
(CQC), Combinacién de la Raiz de la Suma de los Cuadrados (SRSS), Suma de
Absolutos (ABS) y Combinacion Modal General (GMC).

¢ Combinacion Direccional

La combinacion modal produce un Unico resultado positivo para cada direccion de
aceleracién. Los resultados direccionales de estos valores espectrales se pueden
combinar por un método de combinacién direccional para producir un nuevo y Unico
resultado positivo.

Los métodos de combinacion direccional son: Combinacion de la Raiz Cuadrada de
la Suma de los Cuadrados (SRSS), Suma de Absolutos (ABS) y el de la Suma de

los Absolutos Escalados.

3.4 Efecto de la Secuencia Constructiva

Las cargas de peso propio de un edificio, las cuales constituyen un gran porcentaje

de la carga gravitacional total, actlan paulatinamente durante las etapas de

construccion del edificio.

Muchos programas de cédmputo no consideran la secuencia constructiva y aplican la

carga completa al edificio cuando éste ya esta construido.

El no considerar la aplicacion de las cargas segun la secuencia constructiva

produce que en los Gltimos pisos de un edificio alto (mas de 10 pisos) se presenten

diagramas de momentos flectores irreales.

En edificios de concreto armado, hay que tomar en cuenta también los cambios

volumétricos que sufre el material a lo largo del tiempo debidos en su mayoria al

flujo plastico (creep) y a la retraccién (contraccién de fragua), ya que producen

esfuerzos adicionales en la estructura.

Para resolver manualmente la secuencia constructiva existen métodos aproximados

como el propuesto por el ACI, que considera:

- Realizar el metrado de las cargas por nivel (Pi).

- Evaluar los desplazamientos verticales absolutos de cada eje de columna.

- Determinar los momentos considerando que los extremos lejanos de la viga en
estudio se encuentran empotrados, es decir, que no existe repercusion de los
giros entre los niveles consecutivos.

Cuando se usa programas para resolver porticos planos, existe un modelo
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alternativo que consiste en calcular unas cargas equivalentes “F” (positivas cuando
estan dirigidas hacia abajo), que aplicadas de una sola vez sobre la estructura ya
construida, reproduzcan los desplazamientos generados durante el proceso
constructivo, garantizando la compatibilidad de desplazamiento vertical que debe
existir en una columna que pertenece a dos pérticos que se interceptan
ortogonalmente (efecto espacial). El programa PROCONST es uno de ellos.
Para ilustrar el efecto de la secuencia constructiva, se muestra en la figura 3-58 dos
porticos de 20 pisos, analizados con ETABS, junto con los momentos flectores en
las vigas de sus ultimos pisos.
En el pértico de la izquierda no se ha considerado la secuencia constructiva y
puede notarse que sobre el eje 1-B practicamente no aparecen momentos
negativos. Esto se debe en parte a que las deformaciones axiales y las rotaciones
producidas en los niveles inferiores se van acumulando piso a piso, generando una
distorsion en el diagrama de momentos en los Ultimos pisos.
En el portico de la derecha, donde se ha analizado el efecto de la secuencia
constructiva, se considera que las deformaciones (rotaciones o desplazamientos
verticales) producidas en los pisos construidos no generan esfuerzos sobre los
pisos superiores que seran construidos posteriormente. Esto se debe a que en la
realidad:
- Las columnas son construidas a plomo con lo cual se corrige la rotacién del
nudo inmediato inferior
- Las vigas son encofradas de manera horizontal, por lo que se compensa la
pérdida de altura en las columnas, producida por su deformacion axial.
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Figura 3-58.- Diagrama de momentos flectores en los ultimos pisos de un pdrtico de 20 pisos.
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3.4.1 Secuencia Constructiva en ETABS

Para modelar la secuencia constructiva en ETABS, es necesario definir el orden en
que seran construidos los elementos del edificio (columnas, vigas, losas, etc.) y las
cargas que presentaran en cada etapa, en un caso de andlisis, denominado de
secuencia constructiva.

Para ello se deben crear grupos activos que consideren a los elementos de cada
etapa de construccion. Estos grupos pueden ser creados de manera automatica por
el programa o de manera manual.

Se debe tener en consideracion si se decide agrupar la estructura del edificio de
manera manual, que cada grupo activo (o etapa) subsiguiente de construccién esta
conformado por los objetos del grupo previo y por los objetos del piso que se
construye.

Es posible también que los objetos de un grupo activo sean removidos y asignados
a una etapa siguiente, como ocurre por ejemplo en el caso de los puntales que
controlan la deformacién de una losa colaborante, mientras que el concreto esta
fresco. En un momento los puntales seran utilizados en un nivel y luego seran
retirados de ese nivel y utilizados en el siguiente.

Los objetos removidos y agregados a una etapa posterior comienzan nuevamente

con un estado inicial sin esfuerzos.

Casos de Secuencia Constructiva

El analisis de la secuencia constructiva es tratado por ETABS como un tipo especial
de andlisis estatico no lineal, ya que la estructura puede estar sometida a
deformaciones inelasticas.

Para crear un caso de secuencia constructiva es necesario en primer lugar definir
todos los casos de carga estética que estan presentes durante la construccion del
edificio, previamente a la aplicacién de las cargas en los elementos.

Posteriormente, se establecen los grupos activos que representaran las etapas de
construccion del edificio. Es posible hacerlo de una manera automatica, al indicar
simplemente cada cuantos niveles se creara un grupo activo o de manera manual,
definiendo qué elementos conforman el grupo activo para cada nivel del edificio.
Los casos de secuencia constructiva también pueden considerar efectos
geomeétricos no lineales (efectos P-Delta).

Para definir un caso de secuencia constructiva debe llenarse en un formulario,
como el mostrado en la figura 3-59, lo siguiente:

- El nombre del caso de secuencia constructiva.

- La consideracion de los efectos geométricos no lineales (efectos P-Delta).
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El patron de cargas presente en todas las etapas de construccion.

- Si los objetos de la estructura seran agrupados de manera automética por el
programa o de manera manual.

- Si el caso es creado de manera automatica, cada cuantos niveles el programa
creard un grupo activo.

- Si el caso es creado de manera manual, para cada nivel un grupo previamente

definido.

Auto Construction Sequence Case

—dctive Structure
" Mone * Auto Create Active Structure
* Constuction Sequence Caze IEM-SE! = User Specified Active Stucture
r Replace Dead Type Cases with thiz Caze in all
Drefault Dezign Comboz
— Geometric Monlinearity Effects —bubo Create dotive Stucture
Create Construction Sequence every |1 Staries
hane -~ [ Erclude Group I 'I until Last Step
— Load Pattern  Uszer Specified Active Stucture
Load Scale Factor Active Grouo
CH - || Stage vI
_" Add | Add |
M odify | W odity |
Delete | |zert |
[elete |
¥ | Loads Apply e Added Elements Dl
Cancel |

Figura 3-59.- Formulario de caso de secuencia constructiva.

3.5 Combinaciones de Casos de Carga

Una combinacion de casos de carga es la composicién de dos o mas casos de
carga individuales mediante factores de escala, que pueden ser positivos o
negativos.

Con estas combinaciones se pueden superponer los desplazamientos, las
reacciones, las fuerzas internas, etc. de los casos de carga individuales, con la
finalidad de obtener solicitaciones de carga mas desfavorables en los elementos y
posteriormente realizar envolventes de carga que sean Utiles para el disefio.

Con los casos de carga se pueden hacer combinaciones del siguiente tipo:
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e Adicionar (ADD)

La combinacién corresponde a la composicion algebraica de los valores de los
casos de carga involucrados.

s Absoluto (ABS)

La combinacién corresponde a la suma de los valores absolutos de los casos de

carga involucrados.

e SRSS

La combinacion corresponde a la raiz cuadrada de la suma de los cuadrados de los

valores absolutos de los casos de carga involucrados.

e Envolvente (ENVE)

La combinaciéon corresponde a los valores maximos de los casos de carga
involucrados.

Para crear una nueva combinacién se debe elegir los casos de carga involucrados,
asignarles sus factores de escala y especificar alguno de los cuatro tipos de
combinacion.

El programa ETABS cuenta también por defecto con una serie de combinaciones,
del tipo adicionar, que son Utiles para el disefio de porticos de acero y concreto,
vigas compuestas y muros de corte, las cuales se pueden cargar facilmente a la
lista de combinaciones.

Las combinaciones con las que cuenta el programa por defecto varian segun el
cbdigo de disefio, por lo tanto es importante elegir el cédigo de disefio antes de
realizar la carga de las combinaciones y correr el analisis.

El programa por defecto realiza el disefio de los porticos de concreto y muros de
corte con el cédigo del ACI 318-99 y el disefio de los pérticos de acero y vigas
compuestas con el cddigo AISC — LRFD93. Se puede sin embargo elegir otros

cbdigos de disefio.

3.6 Pre Procesamiento

El pre procesador, es el entorno y el conjunto de herramientas que permiten el
modelaje de cualquier edificio de una manera amistosa, rapida y sencilla. Una parte

de él es la Interfase Grafica del Usuario (IGU) en donde se encuentran: la Ventana
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Principal del programa, la Barra de Titulo Principal, la Barra de Titulo de las
Ventanas, la Barra de Menu, las Barras de Herramientas, la Barra de Estado,
Sistema de Coordenadas usado por las Coordenadas del mouse y las unidades
actuales. La figura 3-60 muestra el entorno de ETABS.

—i Barra de Herramientas ’ ‘ Barra de Titulo Principal | ’ Barra de Menu ‘

™ ETABS Nonlinear v9.2.0 - Pantalla de ETABS t . |D|ﬂ

Fie Edt View Defne Diaw Select Assign Analze Display Design Options Help
— D BP0/ (& »EL SO P HWRH e 08 B %. N0
— X o n 8. (SEHE NS (8. | |rxS| RN Yo e, |I-a- T 2

NEE
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| D04 i HEZA/

.‘
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Figura 3-60.- Interfase grafica del usuario del programa ETABS

ETABS permite importar definiciones y preferencias de algin archivo anterior, como
propiedades de los materiales, tipos de secciones, funciones de andlisis, casos de
analisis, casos de carga, combinaciones de carga, etc.

Para contar con una distribucién inicial de elementos se pueden utilizar las plantillas
estandar de ETABS, que facilitan modelar edificios de cobertura metalica, armadura
alternada, losa plana, losa plana con vigas perimetrales, losa tipo wafle y losa

armada en dos sentidos (ver figura 3-61).
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Figura 3-61.- Plantillas estandar de ETABS.

El entorno del pre procesador simplifica la creacion y visualizacion de la estructura
del modelo a través de ventanas.

Para modificar la plantilla inicial y continuar con la creacion del edificio, se cuenta
con comandos para replicar objetos !, modificar los espaciamientos de la malla

st modificar los alturas de los niveles de piso 1A, visualizar el modelo (3D, planta

o elevacion ¥d PR ®F) desplazar vistas &1, ampliar o reducir vistas # - £,
especificar limites de visualizacion, crear grupos de objetos, dibujar objetos de linea
o de area para las diferentes vistas, capturar puntos mediante opciones de snap i,
seleccionar objetos, asignar propiedades de seccion y visualizar multiples ventanas
de exhibicion.

El pre procesador permite seleccionar elementos del modelo por: su tipo de
seccion, su tipo de objeto, el nivel en que se encuentran, el grupo al que pertenecen
y hasta por el plano en el que pueden encontrarse

Cuando la ventana de exhibicién activa muestra una vista en planta se puede elegir
alguna de las tres opciones de ETABS para el dibujo y edicion de elementos: one
story, all stories, similar stories. De esta manera se puede controlar si las
operaciones se haran sobre un piso, sobre todos los pisos o sobre los pisos
similares.

A continuacién se revisan algunas facilidades importantes del pre procesador:

e Creacidon de materiales y secciones

El pre procesador permite crear materiales de cualquier tipo y definir secciones para
elementos tipo barra y tipo area de plantillas predefinidas, mediante la carga de

archivos o por medio del sub programa “Disefador de Secciones”.

e Modelaje de elementos tipo barra

Existen diferentes comandos de dibujo que permiten crear un elemento tipo barra
para las diferentes vistas en pantalla.

Estos se muestran y detallan en la tabla 3-2.
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Tabla 3-2.- Comandos de dibujo de elementos tipo barra

%% Dibuja un objeto de linea en una vista en planta, elevacion o 3D al definir sus
extremos.

i Dibuja un objeto de linea en una vista en planta, elevacién o 3D al hacer clic
---* | sobre una linea de malla con el botén izquierdo del mouse.

i3C: | Dibuja una columna en cualquier ubicacion dentro de una vista en planta al hacer
clic con el botén izquierdo del mouse.

Dibuja vigas secundarias en una vista en planta dentro de una region limitada por
lineas de malla.

m Dibuja diagonales en una vista en elevacion dentro de una regién limitada por
lineas de malla.

Es posible asignar una roétula para liberar cualquier restriccion al giro en los
extremos de un elemento tipo barra. Esto permite modelar por ejemplo los
elementos que conforman una armadura.

El pre procesador permite asignar longitudes de extremo rigido (brazos rigidos)
para tomar en cuenta los traslapes de las secciones transversales de los elementos
tipo barra que se conectan en un nudo, como ocurre por ejemplo en la unién de una

columna y una viga.

e Modelaje de elementos tipo area

Existen diferentes comandos de dibujo que permiten crear un elemento tipo area
para las diferentes vistas en pantalla.

Estos se muestran y detallan en la tabla 3-3.

Tabla 3-3.- Comandos de dibujo de elementos tipo area.

Dibuja un objeto en cualquier ubicacién dentro de &rea en una vista en planta,
elevacion o 3D al definir sus extremos.

esquinas opuestas.

|:| Dibuja éareas rectangulares en una vista en planta y elevacién al definir dos

Dibuja areas en una vista en planta y elevacion dentro de una regién limitada por
lineas de malla al hacer clic con el botdn izquierdo del mouse.

Dibuja un muro en una vista en planta al definir sus extremos

ie=i | Dibuja un muro en una vista en planta sobre una linea de malla o entre dos
- | nudos ya definidos.

e Diafragmarigido

El programa permite asignar un diafragma rigido tanto a objetos de punto como a

objetos de area y también calcular automaticamente y visualizar su centro de masa.
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e Cargas

Se pueden definir casos de carga y modelar diferentes tipos de carga, como: cargas
de asentamiento, concentradas, distribuidas, temperatura y de viento.

El pre procesador permite afiadir, reemplazar o eliminar cualquier tipo de carga y
mostrarla en pantalla para un caso de carga en particular las asignaciones

realizadas.

e Visualizacion de datos de entrada

Los datos se pueden visualizar en pantalla, por medio de gréficos, de tablas (que se
pueden copiar a Excel) o por medio de archivos de texto.

e Visualizacion gréfica

El pre procesador permite visualizar a través del formulario de opciones de vista del

edificio E, de la figura 3-62, opciones como:

- Los elementos del edificio con los colores correspondientes a: los tipos de
objeto, materiales, secciones, grupos y el tipo de disefio asignado.

- Los tipos de objetos presentes en las ventanas de visualizacion.

- Los nombres de las secciones asignadas a los elementos del modelo.

- Los ejes locales de los elementos.

- Los nombres de las etiquetas de los Pier y Spandrel.

- Las rétulas y brazos rigidos asignados.

- Efectos de relleno y extrusion de las secciones.
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" Design Type I Al Mull Areas ™ Line Sections ¥ Grid Lines ™ Monlinear Hinges
" Typical Members ¥ Calumn [Ling) [~ Link Sections ¥ Secondary Grids ™ Panel Zones
€ B & W Printer W Beam [Line] ™ 4rea Local sves ¥ Global Axes [~ End Offsets
" Color Printer ¥ Erace [Line) [T Line Local Axes W Suppaorts I~ Joint Offsets

—Special Effects ¥ Links [Line] — Piers and Spandrels I~ Springs ™ Output Stations

v Al Ml Li — i
[~ Object Shink :; i E“th"ets [~ Pier Labels Other Special ltems
v Object Fil I_D": ) .':cs [~ Spandrel Labels I~ Diaphragm Extent
I3

v Object Edge L an: 'et [~ Pier Ares ™ Auto Area Mesh
W Extrusion inks [Paint] [~ Spandrel Axes I~ Additional Masses
I Apply to All Windows Defaults | Ok I Cancel |

Figura 3-62.- Formulario de las opciones de vista del edificio.
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3.7 Procesamiento

En la etapa de Procesamiento el programa analiza el modelo y genera
automaticamente un archivo de registro que se identifica por la extensién “LOG”.

Este archivo contiene todo el proceso del analisis junto con las advertencias y
mensajes de error que se pudieran presentar, por lo tanto es importante revisarlo

cuidadosamente antes de visualizar los resultados del andalisis.

3.8 Post Procesamiento

El Post Procesamiento recoge los resultados del Procesamiento y permite
mostrarlos directamente en la pantalla del programa de manera tabular o en

archivos de texto.

3.8.1 Visualizacién de Resultados en Pantalla

Los resultados del analisis pueden ser mostrados en pantalla por medio de:

gréaficos, tablas o el trazo de funciones.

Visualizacion Grafica
Se puede visualizar graficamente las deformadas correspondientes a un caso de
carga [T, las formas modales #  las reacciones en la base, las fuerzas internas en

los objetos de linea %, y la representacion (en colores) de la distribucién de fuerzas
y esfuerzos en los objetos de area.

La deformada de un caso de carga y las formas modales pueden mostrarse de
manera animada y ademas ser escaladas por un factor (negativo o positivo).

Se puede ver en pantalla los valores de los desplazamientos y rotaciones en los

nudos (al hacer clic sobre ellos con el botdén derecho del mouse).

Visualizacién Tabular

Se puede visualizar de manera tabular, en una ventana independiente, los
desplazamientos, rotaciones y reacciones en los nudos, los modos del edificio, las
fuerzas internas en los elementos, etc. Las opciones de seleccién se muestran en la
figura 3-63.
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Choose Tables for Display

Edit

i~ Load Cases [Model Def |

=[] MODEL DEFINITION [0 of 74 tables selected)

- Building Data Select Load Cases...
- Property Definitions 3 of 2 Loads Selected

O Load Definitions

-0 Point Assignments i~ Load Cases/Combosz [Results]

-0 Frame Assignments Select Cases/Combos...

-0 Area Assignments 4 of 13 Loads Selected

- Input Design Data

O Design Overwrites todify/Shaw Options:

-0 Optionz/Preferences Data

-0 Miscellaneous Data - Options———————————
E ANALYSIS RESULTS (10 of 25 tables selected] I~ Selection Drly

& Displacements

-& Reactions

-@& Modal Information
BIE Building Modes]
&0 Building Modal Information

-0 Building Dutput

B B

=& Frame Output ~ Mamed Sets
# & Frame Forces Save Named Set...
-] Area Output
-5 wall Dutput Shiow Named Set
e[ Wall Forces

-0 Objects and Elements

Cancel |

Figura 3-63.- Formulario de resultados del andlisis del modelo.

Esta informacion puede ser mostrada para todos los elementos de la estructura o

sélo para algunos elementos seleccionados y posteriormente ser copiada a Excel.

Trazo de Funciones
Las funciones generadas después del analisis que pueden ser trazadas son: las
curvas espectrales de respuesta i, las trazas de tiempo-historia il y las curvas

Estaticas de Pushover .

3.8.2 Visualizacion de Resultados en Archivos de Texto

El programa ETABS guarda la informacién de los resultados del andlisis en archivos
de texto, que podran ser impresos directamente o visualizados en pantalla. Existen

dos tipos de archivos de resultados:

Archivo con Extension OUT

Se crea automaticamente después de la ejecucién del analisis y se identifica porque
tiene el mismo nombre del modelo y la extension “OUT”.

Este archivo muestra informacion de todo el modelo, relativa a: restricciones,
grados de libertad de desplazamiento, masas en los nudos, periodos y frecuencias
modales, factores de participacion modal, porcentaje de masa de participacion

modal, porcentaje de participacion de carga modal, balance de fuerza, etc.
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Archivo con Extension TXT

Como una opcion a la impresion de las tablas de resultados, se puede crear un
archivo de texto que contenga los resultados seleccionados que se desean mostrar,
como por ejemplo: informacion relativa a desplazamientos y reacciones en los

nudos, fuerzas en los elementos, modos del edificio, etc.

3.9 Disefo en Concreto Armado

El programa ETABS, después de correr el andlisis es capaz de realizar el disefio a
flexo compresion y corte de los porticos y muros de corte de concreto armado, para
las combinaciones de disefio elegidas.

A través del disefio, ETABS calcula los requerimientos de acero longitudinal y
transversal y verifica si las secciones asignadas son apropiadas.

Este proceso es iterativo, e inicia con el pre dimensionamiento de las secciones y la
colocacién de una armadura inicial, que seran chequeadas por el programa para
verificar que cumplan con los requisitos minimos que el cédigo de disefio elegido
exige cada vez que se corra el disefio. En el caso de tener secciones insuficientes,
el programa permite realizar modificaciones en la seccidon de los elementos, la
resistencia de los materiales, los requerimientos de ductilidad, en los coeficientes
gue afectan la resistencia de la seccion o en ciertos factores de disefio que varian
segun el cadigo elegido, etc., a fin de cumplir con estos requisitos.

El programa cuenta con diversos cédigos para el disefio de porticos de concreto
armado y muros de corte, como por ejemplo los codigos: ACI 318-05/IBC 2003, ACI
318-02, ACI 318-99, UBC 97, BS8110 89, BS8110 97, CSA-A23.3-94, Indian IS
456-2000, etc. La Norma Peruana no estad incluida dentro de los cédigos
predeterminados, sin embargo, se puede cumplir con muchos de sus

requerimientos modificando ligeramente los parametros del cédigo ACI 318-99.

3.9.1 Disefo de Pérticos de Concreto Armado

El disefio de pérticos de concreto armado comprende al disefio de vigas y al disefio

de columnas.

Disefio de Vigas

El programa puede disefiar secciones de vigas T y rectangulares.

Para su disefo, se deberé utilizar la envolvente de las combinaciones de los casos
de carga, a fin de trabajar con las solicitaciones maximas a lo largo de ella.

Para el disefio del refuerzo longitudinal, primero se calcula la resistencia nominal de
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la seccion con un refuerzo a traccion y se verifica si es mayor a la demandada por
los momentos flectores provenientes de la envolvente, en caso de ser menor, se
calcula el refuerzo en compresién necesario.

Para el disefio del refuerzo transversal o de corte (estribos), el programa calcula
primero la resistencia al corte del concreto y verifica si es mayor a la demandada
por las fuerzas cortantes provenientes de la envolvente. Si es menor, calcula la
diferencia de resistencia que debera ser aportada por los estribos y posteriormente
el &rea de acero necesaria como una cuantia, en unidades de Longitud2/Longitud.
Si la resistencia al corte del concreto es mayor a la resistencia demandada, el
programa calcula la cuantia de acero minimo que debera colocarse a lo largo de la
viga.

En la figura 3-64 y en la figura 3-65 se muestran el diagrama de deformaciones y de
esfuerzos utilizado por el ACI y la Norma Peruana, para el calculo de la resistencia

de disefio de vigas con secciones rectangularesy T.

0.85fc
Co a= f3c
Seccion de Diagrama de Diagrama de
laviga Deformacion Esfuerzos

Figura 3-64.- Diagramas de deformaciones y esfuerzos de una seccion de viga rectangular.

bf ecu =0.003 0.85f¢ 0.85f¢c

a= Rlc

Cw

bw

Seccion de Diagrama de Diagrama de
la viga Deformacion Esfuerzos

Figura 3-65.- Diagramas de deformaciones y esfuerzos de una seccion de viga T.
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Diseio de Columnas

El programa puede calcular el acero longitudinal requerido de una seccién o

chequear la capacidad de la seccién para un acero longitudinal especificado, en

términos de la Razén de Capacidad (RC), que es un factor que indica la condicién

de esfuerzos de la columna, con respecto a su capacidad. Para que una seccion

sea disefiada directamente, se debe indicar al momento de ser creada, que su

refuerzo sera disefiado, de lo contrario, sera chequeado por medio de la RC.

El procedimiento de disefio de columnas que realiza el programa, consta de los

siguientes pasos:

- La generacion de una superficie o volumen de interaccion de la fuerza axial y
los momentos flectores biaxiales para una secciéon deseada, como la mostrada

en la figura 3-66.

Compresion Axial

Traccion Axial
Figura 3-66.- Superficie de interaccion para fuerza axial y momentos flectores biaxiales.

- El chequeo de la capacidad de la columna, con las combinaciones factorizadas
de fuerza axial y momentos flectores de los casos de carga, en ambos extremos
de la columna. En este paso, también se calcula el refuerzo longitudinal
requerido (si no ha sido especificado) con una RC de 1, o en su defecto la RC
de la columna con el refuerzo especificado.

El chequeo de la capacidad esta basado en si los puntos de la carga de disefio
se encuentran dentro del volumen de interaccion, para lo cual se tendra una
seccion adecuada y una RC < 1, sin embargo, si algin punto se encuentra
fuera del volumen de interaccion la columna estard sobre esforzada y el

programa tendra que calcular la RC, que es mayor a 1, por medio del cociente
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entre la demanda de capacidad (OL) y la capacidad de la columna (OC), RC =
OL / OC, tal como se ilustra en la figura 3-67.

Compresion Axial

__— Lineasdela
Superficie de falla

 J
Traccion Axial

Figura 3-67.- Superficie de interaccion para el calculo de la razon de capacidad de secciones sobre
esforzadas.

- El disefio del refuerzo por corte, de manera similar al de una viga, pero tomando
en cuenta el efecto de la fuerza axial en la capacidad de corte del concreto.

En la figura 3-68 se muestra el diagrama de deformaciones y de esfuerzos utilizado

por el ACI y la Norma Peruana, para el calculo de la resistencia de disefio de una

columna.

ecu = 0.003

0.85fc

a= [c

Seccion de
la viga

Diagrama de
Deformacion

Diagrama de
Esfuerzos

Figura 3-68.- Diagramas de deformaciones y esfuerzos de una seccion de columna.
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3.9.2 Diseno de Muros de Corte

Al igual que en las columnas, el programa puede disefiar o chequear la seccion de
un muro de corte.

Para el disefio de muros de corte, se debera asignar etiquetas de muro pier (a los
elementos verticales) y spandrel (a los elementos horizontales) a los objetos de
area o linea que conforman los muros de corte.

El programa, a partir de las combinaciones de los casos de carga que se
consideren criticos para el disefio, calcula las cuantias de acero requeridas, para su
comportamiento a flexién (refuerzo vertical) y corte (refuerzo horizontal).

Sin embargo, es posible utilizar el sub programa “Disefador de Secciones”, que
permite dibujar la seccion del muro de corte y asignarle un acero vertical tentativo,
gue podria ser el recomendado por las cuantias que calcula directamente ETABS, a
fin de obtener la superficie de interaccion, que indica la capacidad de la seccion.

A partir de esta superficie de interaccion, se puede realizar el chequeo de la
capacidad del muro de corte, con las combinaciones factorizadas de fuerza axial y

momentos flectores de los casos de carga, como en el caso de las columnas.
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4 EJEMPLO ILUSTRATIVO

4.1 Analisis Espectral de Respuesta de un Edificio de Concreto
Armado

4.1.1  Objetivo

Mostrar la aplicacion de las herramientas que ofrece el programa para realizar la
creacion del modelo, el andlisis y el disefio de los elementos en concreto armado de
un edificio.

4.1.2 Descripcion de la Estructura

El edificio mostrado en la figura 4-1 es de concreto armado, cuenta con 10 pisos 'y 2
sétanos y esta ubicado en el distrito de Surco, en una zona en donde el suelo

puede ser considerado como rigido.

Figura 4-1.- Perspectiva del edificio Pinar I.

Presenta en la direccion X y Y un sistema sismorresistente conformado
principalmente por muros de corte. Es irregular en planta por la presencia de

esquinas entrantes en los pisos tipicos, tal como se muestra en la figura 4-2.
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Figura 4-2.- Planta tipica del edificio

Las losas de color azul, que se aprecian en la figura 4-2, son aligeradas de 25 cm.
de espesor y las losas anaranjadas son macizas de espesor variable, entre 15y 25
cm.

Los dos sétanos y las dos primeras plantas se han destinado para el uso de
estacionamientos y las plantas superiores para el uso de oficinas. Sobre el piso 10

se encuentra el tanque elevado y el cuarto de maquinas del ascensor.

4.1.3 Modelo Estructural

Para la elaboracion del modelo estructural (detallado en el capitulo 5) se utilizé la

versiéon 9.2.0 del programa ETABS y se tomo en cuenta:

- Anular la rigidez a torsién de las vigas, por medio del coeficiente 1E-5, dentro de
sus propiedades de seccion.

- Utilizar como espesor de los objetos de area tipo losa un espesor muy pequefio,
igual a 1 * 10" para anular su peso propio, el mismo que se asignara
directamente de manera manual como una carga por unidad de area. Para el
caso de losas aligeradas es necesario aplicar este artificio, pues los materiales
gue la conforman tienen distintos pesos especificos.

- Asignar las liberaciones de momento en los extremos de las secciones de viga
que se encuentren apoyadas en otras vigas 0 apoyadas en muros
perpendiculares a ellas.

- Relacionar los grados de libertad de todos los nudos, en cada nivel, para
simular un comportamiento de diafragma rigido.

- Restringir las traslaciones horizontales (X, Y) y la rotacién vertical (Z) en las

plantas de los s6tanos para modelar el confinamiento del terreno que los
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circunda.

- Definir que la fuente de masa del edificio proviene de las cargas asignadas a
través de los diferentes casos de carga.

- Asignar para el analisis dindmico, 3 modos dindmicos por cada planta del
edificio, sobre el nivel del terreno. De esta manera se asigné 3*(10+2) = 36
modos dindmicos.

En la figura 4-3 se muestra el modelo tridimensional del edificio.

Figura 4-3.- Modelo tridimensional del edificio.

4.1.4  Analisis Espectral de Respuesta (Norma Peruana E.030)

Para obtener el espectro de aceleraciones, se utilizaron los siguientes parametros
indicados en la Norma Sismorresistente E.030:
- Factor de Zona (2):
Ubicacion del edificio: Lima (Zona 3) - Z = 0.40.
- Parametros del Suelo (T, y S):
Suelo rigido (Tipo S;) > T, =040 sy S = 1.0. T, es el periodo que define la
plataforma del espectro para cada tipo de suelo y S es el factor de amplificacion
del suelo.
- Factor de Amplificacion Sismica (C):
C=25*(T,/T);C=<25
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- Coeficiente de Uso e Importancia (U):
Edificacion comun para uso de oficinas (Categoria C) > U = 1.0.
- Coeficiente de Reduccion de Solicitaciones Sismicas (R):
Sistema de muros estructurales de concreto armado - R = 6. Por la
irregularidad en planta, el coeficiente R, se reduce a ¥4*6 = 4.5.
En la figura 4-4 se muestra el grafico del espectro inelastico de pseudo aceleracion
utilizado en ambas direcciones horizontales (X y Y) y definido por Sa = Z*U*C*S*g /
R, en donde g es la gravedad (9.80665 m/s?).

Espectro de Pseudo Aceleraciones

2.4
2.2

. \
1.6 \

PSA (m/s2)
J

0.6 —
0.4
0.2

0 0.25 0.5 0.75 1 1.25 1.5 1.75 2 2.25 2.5
Periodo, T (s)

Figura 4-4.- Espectro de pseudo aceleracion.

Evaluacion de Resultados

El programa permite mostrar de manera tabular para los casos de carga elegidos:

- El desplazamiento de los centros de masa y el desplazamiento en todos puntos,
ya sean traslacionales o rotacionales, con lo cual es posible calcular la junta de
separacion sismica.

- Los desplazamientos relativos de entrepiso (Drifs), que podran ser comparados
con los limites permitidos en la Norma Peruana.

- Las reacciones en los apoyos.

- Las fuerzas cortantes de piso del andlisis dinamico, de donde se podra obtener
el cortante basal, necesario para calcular el factor de escala de los resultados
de este andlisis.

- La informacion modal, como por ejemplo la razén de masa modal participante,

necesaria para identificar los periodos maximos en cada direccion.
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Las fuerzas internas de los elementos de pértico (vigas y columnas), como la
fuerza axial, cortante y momentos flectores.

- Las fuerzas internas de los elementos de area con etiquetas Pier y Spandrel.

De manera gréfica, ETABS puede mostrar entre otras cosas, para un caso de
carga, la deformada de la estructura, la forma de los modos y las fuerzas internas
en los elementos.

Para el caso de carga de secuencia constructiva, tanto la deformada como las
fuerzas internas se pueden visualizar para las diferentes etapas de construccion. En
la figura 4-5 se muestra el diagrama de momentos para la etapa 10 de construccion

del caso de carga de secuencia constructiva.

ELAH T CRAC

ELAN P CM&E
FLAN P 01
ELANF O
[“ FLANF &
|1 P
‘[ [ FLAMPT
L 17 [~——
[] FLAN P &
L1 [~——
i -
ELANPE
I [——
i -
ELANF4
" P
e [_\
ELANP 3
" T
h“
L] el ELANF?
" |
1 -
[ [ FLAMF +
——
/ ELANE *
™ LAH & 3
E 11 T
- BASF
-r m

Figura 4-5.- Diagrama de momentos flectores, para la etapa 10 del caso de carga de secuencia
constructiva.

@ Tesis publicada con autorizacion del autor

SOME RIGHTS RESERVED Algunos Derechos Reservados. No olvide citar esta tesis




PONTIFICIA
UMIVERSIDAD

TESIS PUCP 5L

NEL PERU

GUIA PARA EL MODELAJE, ANALISIS Y DISENO DE
ELEMENTOS DE CONCRETO ARMADO EN ETABS

En este capitulo se va a desarrollar paso a paso en ETABS, el modelo del edificio

presentado en el capitulo 4 (Ejemplo llustrativo).

5.1 Etapa de Pre Procesamiento

Para la creacién del modelo estructural, se ha utilizado la version 9.2.0 del
programa ETABS.

En esta etapa, se recomienda trabajar de una manera ordenada, siguiendo las
instrucciones indicadas en los pasos que se desarrollan a continuacion.

Debido a que en cada paso, seria engorroso y poco didactico estar repitiendo las
mismas instrucciones en mas de un elemento del modelo, se ha preferido
complementar su creacion a través de archivos con extension “EDB”, que deberan
ser abiertos antes de continuar con el paso siguiente.

Los archivos de los pasos se encuentran en el CD, dentro del Anexo B, en la
carpeta “Archivos del Modelo” > Pasos del Modelo ETABS.

Antes de iniciar es recomendable familiarizarse con la nomenclatura de los

elementos que conforman un formulario de ETABS, mostrados en la tabla 5-1.

Tabla 5-1.- Elementos de los
formularios de ETABS.

]

utﬁﬂ@“LEﬂE

Cuadro

Casilla de verificacion

Cuadro de texto

Boton de comando

Boton de opcidn

Cuadro de lista

Cuadro combinado

Barra de desplazamiento
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51.1 Creacion del Modelo Estructural en ETABS

PASO 1. Creacion de las lineas de mallay definicién de la informacion de

los pisos

La malla del modelo se puede crear:

- Importando las lineas de malla, directamente desde un archivo de AutoCAD,
con extension “DXF”.

- Mediante su definicion directa, al momento de iniciar la creacién del modelo del
edificio.

- Editando posteriormente la malla que muestra el programa por defecto.

Para el ejemplo, la malla del edificio se va a definir al momento de iniciar la creacion
del modelo. Para facilitar esta operacion, se va a copiar la informaciéon de sus
coordenadas desde un archivo de Excel, de la siguiente manera:

- Ingresar al menu File > New Model (|_h ) y presionar el boton de comando NO.

- En la ventana Building Plan Grid System and Story Data Definition, elegir
dentro de la lista del cuadro Units, las unidades Ton-m. Dentro del cuadro Grid
Dimensions (Plan), seleccionar la opcion Custom Grid Spacing y presionar el
boton de comando Edit Grid, para abrir la ventana Define Grid Data.

- Abrir el archivo “MALLA.xIs” que se encuentra en el CD, dentro del Anexo B, en
la carpeta “Archivos del Modelo” y copiar los datos coloreados de marrén en la
celda superior izquierda del cuadro X Grid Data de la ventana abierta de
ETABS. Repetir el Gltimo paso, pero ahora pegar los datos coloreados de azul
dentro del cuadro Y Grid Data. En la figura 5-1 se muestra la ventana de

definicion de las lineas de malla.
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Edit Format |
—# Grid Data
GridID | Omdinate | Line Type | Vishiity | Bubbleloc | Grid Color

1 1 i} Frimary Shiow Top

2 12 IR:] Primary Shiow Battom

3 1B 34 Primary Show Bottomn [

4 iC 4. Prirmary Show Bottorn [

5 2 4E5 Primary Show Top

5 28, 8.75 Prirnary Show Batton [

7 E] 9.95 Primary Show Top

] 38 11.38 Primary Show Botom [

] ;® 125 Primary Show Botom [

10 4 1E.55 Primary Show Top N ~| ~ Unit
¥ Grid Data [Tonm =]

GridID | Omdinate | LineTwpe | Vishiity | Bubbleloc | Grid Color ~ Display Grids as

1 E 0. Primary Show Left ' Ordinates ¢ Spacing

2 D1 353 Frimary Shiow Right

3 ] 508 Primary Show Let . L

4 c4 5.57 Primary Show Right D] M i) B s

5 C3 £.E3 Prirmary Show Right [ I™ Glue to Grid Lines

5 Cz 605 Primary Show Right I .

[1524
7 cl 716 Primary Show Right ] Bubble Size
] C 751 Primary Show Let
Rieset to Default Col
3 B4 7.86 Primary Show Right B esetto Defauit olor_|
10 B3 816 Frimary Show Right [ ~ | Reorder Ordinates |
Ok, | Caticel I

Figura 5-1.- Ventana de definicion de las lineas de malla.

Para definir la informacién de los pisos, dentro de la ventana Building Plan Grid

System and Story Data Definition:

- Dentro del cuadro Story Dimensions, verificar que esté activada la opcion

Simple Story Data. Escribir 14 en el cuadro de texto Number of Stories y 2.88

en los cuadros de texto restantes (Typical Story Height y Bottom Story

Height), tal como se muestra en la figura 5-2. En este caso 14 representa la

cantidad de pisos del edificio incluyendo los sé6tanos y 2.88 la altura promedio

de los so6tanos.
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Building Plan Grid System and Story Data Definition

— Gnid Dimensions [Flan) — Story Dimensions
" Unifarm Grid Spacing + Simple Stary Data
Murnber Lines in# Direction |4 Mumber af Storigs |1 4
Mumber Lines in'' Direction |4 Tupical Stary Height 2858
Spacing in ¥ Direction IT.31 52 Bottam Stary Height |2.83
SREEE 1§ el I?'31 i " Custom Story Data Edit Stary [ata. . I
% Cusztom Grid Spacing Urits
Grid Labels. | EditGrid.. | |Tc.n.m -]

—a&dd Stuctural Objects

i ] = 5
1 I o
=l
I—H—TI H—H—H o - L g
Steel Deck Staggered Flat Slab Flat Slab with Wiatfle Slab Twowiay or Grid Only
Truss Perimeter Beams Ribbed Slab
QK I Cancel

Figura 5-2.- Ventana de definicién de la malla y pisos del modelo.

- Dentro del cuadro Story Dimensions, seleccionar la opcion Custom Story
Data y presionar el boton de comando Edit Story Data.

- Enlaventana Story Data, copiar la informacion de la figura 5-3.
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Story Data
Label Height Elevation I aster Story Similar Ta Splice Paoint | Splice Height
15 | PLAM T CHEC 24 1.1 Yes Mo 0
14 | PLAM P CH&C 1.85 3881 Mo NOME Mo 0
13 PLAM P10 3 36.96 Mo NOME Mo 0
12 PLAM P9 3 3396 Mo NOME Mo 0
11 PLAM P8 3 3096 Mo PLAN P3 Mo i}
10 FPLAM P7 3 2796 Mo PLAMN P3 Mo i}
g FLAM PE 3 24 96 Mo PLAMN P3 Mo i}
g FLAM P5 3 21.96 Mo PLAMN P3 Mo i}
7 FLAM P4 3 18.96 Mo FPLAMN P3 Mo i}
B PLAN P3 3 15.96 Tes Mo i}
3 PLAN P2 36 1296 Mo MOME Mo i}
4 PLAMN P1 36 936 Mo MOME Mo i}
3 PLAM 51 288 576 Mo MOME Mo i}
2 PLAM 52 288 288 Mo MOME Mo i}
1 BASE 0.
— Reset Selected Rows Urits
Height |2.4 Feseat | ’7 Change Lits ITu:un-m vl
Master Stary IND Reset |
Simlar Ta  [NONE ~] Reset |
SpliesPoint Mo ]| _ Reset |
Splice Height ID Reset | Cancel |

Figura 5-3.- Ventana de definicion de los pisos.

Nota: En caso de que se requiera modificar la definicién inicial de las lineas de
malla, como por ejemplo, cuando hay que afiadir, borrar o cambiar el espaciamiento
de alguna de ellas, se podra ingresar al mena Edit > Edit Grid Data > Edit Grid (
o ), presionar el boton de comando Modify/Show System y realizar las
modificaciones de manera manual.

Para modificar la informacién de los niveles de piso, ingresar al mena Edit > Edit

Story Data > Edit Story ( 1H).

En el archivo Paso 1 Malla y Pisos.EDB, se encuentran las instrucciones

realizadas en este paso.

PASO 2. Definicion de las propiedades del material

Para definir las propiedades del material concreto armado, modificaremos las
propiedades del material CONC, que se encuentra dentro de la lista de materiales

por defecto de ETABS, para ello:
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- Seleccionar las unidades Ton-m (ITenm > ) en la parte inferior derecha de la
pantalla.

- Ingresar al menu Define > Material Properties ( VE ).
- Elegir el material CONC y apretar el boton de comando Modify/Show Material.
- Definir en la ventana Material Property Data las propiedades para el andlisis y

disefio, tal como se muestra en la figura 5-4.

Material Froperty Data
— Digplay Color
M aterial Hame IEDNC Calor I
— Tupe of b aterial — Tupe of Dezign
@ |sotropic  © Orthotropic Design IEDncrete "'I
—Analyziz Property [ata — Diesign Property Data [AC] 318-05/ABC 2003)
Mazs per unit Yolume IU. Specified Conc Camp Stength, o |21 0o.
Wieight per unit Yalume |2.4 Bending Reinf. *ield Stress, fu |42E|D|1
Moduluz af Elasticity |21 FIF07. Shear Reinf. rield Strezs, fys |42EIDEI.
Poizzon's B atio ID.15 I~ Lightweight Concrete
Coeff of Thermal Expansion IS.SDUE-UE Shear Strength Feduc. Factar I
Shear Moduluz IEMEEIEIEI.
Ok I Cancel

Figura 5-4.- Ventana de definicion de las propiedades del material (concreto armado).

El archivo Paso 2_Material. EDB, comprende al paso previo e incluye la instruccién

realizada en el paso 2.

PASO 3. Definicion de las secciones de los elementos tipo barra

(Columnas y Vigas)

Las secciones de los elementos tipo barra (columnas y vigas) se definen a través

del menu Define > Frame Sections, o del botén de comando T (Define Frame

Sections).

Recomendacion: Al abrir la ventana Define Frame Properties, se muestra la lista
de secciones que el programa tiene por defecto. Es recomendable, aunque no
indispensable, borrar todas estas secciones antes de definir las secciones del

modelo, ya que con ello se simplifica su posterior asignacion.
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Definicion de secciones de las columnas:

A manera de ejemplo se define la seccion de la columna de 0.25 x 0.60 m:

- Presionar el boton de comando “I (Define Frame Sections), ubicar el cuadro
de lista para afiadir secciones y seleccionar la opcion Add Rectangular.
- Enla ventana Rectangular Section:
Definir el nombre de la seccion, las dimensiones y el material, como se
muestra en la figura 5-5a.
Presionar el botén de comando Reinforcement, para especificar la
distribucion del acero de refuerzo y llenar la ventana Reinforcement Data,

como se muestra en la figura 5-5b.

Reinforcement Data
Rectangular Section — Brests T
]  Beam
Section Hame |C.D_25><D_ =] — Configuration of Reinforcement
* Rectangular = Circular
—Propetties———— [ Propeny Modifiers—— [ Material————————
Section Properties... | ’7 SetModifiers...l ’7 ICDNC 'l et e RlmEETmEl
i Ties = Spiral
— Dimensions
Depth (3] ID-25 P — Rectangular Reinforcement——————————————————
IDB— Cover to Rebar Center ID.DB
e (2 . o o Mumber of Bars in 3-dir |3
3 * - : EEE Mumber of Bars in 2-dir |3
Bar Size #9 hd
Carner Bar Size #9 hd
— Concrete
Reinforcement.... | — Check/Design
Display Cal
AR . " Reinforcement ta be Checked
0K I Cancel * Reinforcement ta be Designed
Cancel_|
a.- Ventana de definicion de propiedades de la seccion. b.- Definicion del acero de refuerzo.

Figura 5-5.- Definicién de una columna con seccion rectangular.

El archivo Paso 3a_DefColumnas.EDB, comprende a los pasos previos e incluye

la definicion de las demas secciones de columna.

Definicién de secciones de las vigas:

Para el caso de la seccion de la viga de 0.10 x 0.70 m, se define el nombre de la
seccion, las dimensiones y el material de manera similar al caso de la columna,
como se muestra en la figura 5-6a. En la figura 5-6b, se muestra la definicién del

refuerzo de la viga.
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Reinforcement Data

Rectangular Section ~ Bresli T
" Calumn o
Section Hame |V.D_1[¢<D_ 70 — Concrete Cover to Febar Center
Properli Prapety Modii Material 13 o
[ Fropetes roperty Modiners atenal
ID.DB
Section Properties... | ’7 Set Modifiers... | ’7 IEDNE j' Battom
i~ Dimensions -~ Reinforcement Overrides for Ductile Beams
Depth (3] [o7 £ Left Right
Width [£2] [0 Teo [0 [0
3 Battom [0, Jo.
— Concrete T
Reinforcement... | Display Color l_
]S I Cancel
Cored |
a.- Ventana de definicion de propiedades de la seccion. b.- Definicion del acero de refuerzo.

Figura 5-6.- Definicién de una viga con seccion rectangular.

Nota: El recubrimiento de acero para las vigas y columnas es determinado
automaticamente por el programa. Sin embargo, se debe verificar este
recubrimiento teniendo en cuenta los valores minimos de la norma y, en el caso de
las vigas, la posibilidad de usar acero en mas de una capa, segln su seccion y su
luz.

Para trabajar con secciones agrietadas, usando las sugerencias del ACI, existe la
posibilidad de afectar las propiedades de la seccién por coeficientes que multiplican
a los valores de la seccion neta. Por ejemplo, si se desea anular la rigidez a torsion
de una viga y reducir al 60% su rigidez a la flexion, se debera presionar dentro de la
ventana de definicién de las propiedades de la seccion, el botéon de comando Set
Modifiers y escribir en la ventana Analysis Property Modification Factors, los

coeficientes indicados en la figura 5-7.
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Analysis Property Modification Factors

— Property tModifiers

Crozg-gection [axial] &rea
Shear Area in 2 direction
Shear &rea in 3 direction
Torsional Constant 0.00001
Moarnent of Inertia about 2 axis
toment of Inertia about 3 axis

M azz

Wieight

LTI

Cancel

Figura 5-7.- Factores de modificacion de propiedades para el analisis.

El archivo Paso 3b_DefVigas.EDB, comprende a los pasos previos e incluye la

definicion de las demas secciones de viga.

PASO 4. Definicion de las secciones de los elementos tipo area (Muros y

Losas)

Las secciones de los muros y las losas se definen a través del menu Define >

Wall/Slab/Deck Sections, o del boton de comando = (Define Wall/Slab/Deck

Sections).

Recomendacion: Al abrir la ventana Define Wall/Slab/Deck Sections, se muestra
la lista de secciones que el programa posee por defecto (DECK1, PLANK1, SLAB1
y WALL1). Es recomendable, aunque no indispensable, borrar estas secciones y

agregar las que se utilizaran.

Definicion de secciones de los muros:
A manera de ejemplo se define la seccién del muro de concreto armado de 0.10 m

de espesor:

- Presionar el boton de comando = (Define Wall/Slab/Deck Sections), ubicar el
cuadro de lista para afadir secciones y seleccionar la opcion Add New Wall.

- En la ventana Wall/Slab Section, definir el nombre de la seccién, el material,
los espesores de membrana y flexion y el tipo de comportamiento del elemento,

tal como se muestra en la figura 5-8.
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Wall/Slab Section
Section Hame IMLIFIEHEI

b aterial IEEINE "I
— Thicknesz

tembrane IEI.1
Bending IEI.1

— Type
& Shell " Membrane  Plate
[ Thick Plate

— Load Distribution

[T Use Special Oneway Load Distibution

SetMDdifiers...I Dizplay Color .
] I Cancel |

Figura 5-8.- Ventana de definicion de una seccion de muro.

El archivo Paso 4a_DefMuros.EDB, comprende a los pasos previos e incluye la

definicion de las demas secciones de muro.

Definicion de secciones de las losas:

En el modelo se crearan dos secciones de losa, ALIGERADO y MACIZA, como un
medio para incluir las cargas de las losas y todo lo que esté directamente sobre
ellas.

A manera de ejemplo, se va a definir la seccién de losa ALIGERADO, que se usara

para distribuir las cargas en una sola direccién (F Use Special One-Way Load
Distribution).
Como el peso propio del aligerado y sus cargas se aplican sobre los elementos de

este tipo, el espesor se define con un valor muy pequefio (1 x 10™):

- Presionar el botén de comando = (Define Wall/Slab/Deck Sections) vy
seleccionar del cuadro de lista la opcién Add New Slab.

- En la ventana Wall/Slab Section, definir el nombre de la seccién, el material,
los espesores de membrana vy flexion, el tipo de comportamiento del elemento y
la manera como se distribuye la carga vertical, tal como se muestra en la figura
5-9.
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Wall/Slab Section
Section Hame I.-’-‘-.LIGEFE.-‘E-.DEI

b aterial IEEINE "I
— Thicknesz

kembrane |1 O00E-04
Bending |1 (O00E-04

— Type
" Shell & Membrane  Plate
[T Thick Plate

— Load Distribution

v Use Special Oneway Load Distibution

SetMDdifiers...I Dizplay Color .
] I Cancel |

Figura 5-9.- Ventana de definicion de una seccion de losa.

Nota: El tipo de comportamiento se define como membrana para hacer que el
programa no tome en cuenta estos elementos como componentes estructurales y

sélo reparta unidimensionalmente la carga que actua sobre ellos.

El archivo Paso 4b_DefLosas.EDB, comprende a los pasos previos e incluye la

definicion de las demas secciones de losa.

PASO 5. Dibujo y asignacién de elementos tipo barra (Columnas y Vigas)

En este paso se dibujaran los elementos tipo barra (columnas y vigas) del modelo y
se les asignard las secciones definidas en el paso 4.

Es importante utilizar un orden y sentido en el dibujo de los elementos, para saber
posteriormente cudles seran sus extremos iniciales y finales y llevar un facil control
de sus ejes locales. Para ello, las columnas se dibujaran de abajo hacia arriba, en
una vista en elevacion, y las vigas de izquierda a derecha y de abajo hacia arriba,

en una vista en planta.
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Recomendacion: Antes de iniciar el dibujo, es recomendable presionar el boton de
comando [+ (Set Building View Options) y activar la casilla Line Sections, dentro

del cuadro Object View Options, para poder visualizar las secciones asignadas.

Dibujo y asignacion de columnas:

A manera de ejemplo se va a dibujar y asignar en todas las plantas tipicas, la

seccion de columna C-0.40X0.60, ubicada en la interseccién de las lineas de malla

4y C:

- Presionar el botén de comando PIR (Set Plan View) y seleccionar la planta tipica
PLAN P 3.

- Seleccionar la opcién Similar Stories, en el cuadro de lista con las opciones de
asignacion para las vistas en planta (parte inferior derecha de la pantalla).
(Plan)).

- Enla ventana Properties of Object, elegir la seccién C-0.40X0.60, en la casilla

Property, tal como se muestra en la figura 5-10.

Properties of Object x|
Property C-0.40=060

Moment Releazes Continuous

Angle 0.

Flarn Offzet 0.

Flan Offzet % 0.

Figura 5-10.- Ventana de propiedades de objetos, para el dibujo de columnas.

- Hacer un clic en el punto de interseccién de las lineas de malla, con el nombre
de etiqueta Grid Point 4 C.

El archivo Paso 5a_DAColumnas.EDB, comprende a los pasos previos e incluye el

dibujo y asignacion de las demas secciones de columna.

Dibujo y asighacion de vigas:

A manera de ejemplo se va a dibujar y asignar en todos los pisos tipicos, la seccion
de viga V-0.30X0.65, ubicada entre los ejes Ay E del gje 3:

- Seleccionar la planta tipica PLAN P 3 y la opcidén Similar Stories, de la misma

forma que se hizo para el Dibujo y asignacion de columnas.
- Presionar el boton de comando (Draw Lines (Plan, Elev, 3D)).

- Enla ventana Properties of Object, elegir la seccion V-0.30X0.65, en la casilla

Property, tal como se muestra en la figura 5-11.
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Type aof Line Frame
Property W0, 30=0.65
Moment Releazes Continuous
Flan Offzet Mormal 0.
Drawing Contral Type Mone <szpace bar:

Figura 5-11.- Ventana de propiedades de objetos, para el dibujo de lineas

- Ubicar el cursor en el punto con la etiqueta Grid Point 3 E y hacer clic sobre él,
luego, desplazar el cursor hasta encontrar el punto con la etiqueta Grid Point 3
C y dar clic sobre él.

- Hacer clic derecho para deseleccionar y repetir el paso anterior entre los puntos
con las etiquetas Grid Point 3 C y Grid Point 3 A. Se debe notar que el dibujo

de la viga se ha realizado de abajo hacia arriba.

El archivo Paso 5b_DAVigas.EDB, comprende a los pasos previos e incluye el

dibujo y asignacion de las demas secciones de viga.

PASO 6. Dibujo y asignacién de elementos tipo area (Muros y Losas)

En este paso se dibujardn los elementos tipo area (muros y losas) del modelo y se
les asighara las secciones definidas en el paso 5.
Para el control de la orientacion sus ejes locales, en una vista en plata, los muros

se dibujaran de izquierda a derecha y las losas en sentido anti-horario.

Recomendacion: Antes de iniciar el dibujo, es recomendable presionar el botén de
comando [+ (Set Building View Options) y activar la casilla Area Sections,
dentro del cuadro Object View Options, para poder visualizar las secciones

asignadas.

Dibujo y asignacion de muros:

A manera de ejemplo se va a dibujar y asignar en todos los pisos tipicos, la seccidon

de muro MUROZ20, ubicada entre los ejes 1B y 4 del eje A:

- Presionar el boton de comando PIR (Set Plan View) y seleccionar la planta tipica
PLAN P 3.

- Seleccionar la opcién Similar Stories, en el cuadro de lista con las opciones de

asignacion para las vistas en planta (parte inferior derecha de la pantalla).
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- Presionar el botén de comando = (Draw Walls (Plan)).
- En la ventana Properties of Object, elegir la seccion MURO20, en la casilla
Property, tal como se muestra en la figura 5-12.

Properties of Object x|
Type of Area Fier

Froperty MUROZ20

Plan Offzet Momal 0

Auto Pier/Spandrel [Ds? Mo

Drawing Control Mone <space bars

Figura 5-12.- Ventana de propiedades de objeto, para el dibujo de muros.

- Ubicar el cursor en el punto con la etiqueta Grid Point 1 B A y hacer clic sobre
él, luego, desplazar el cursor hasta encontrar el punto con la etiqgueta Grid

Point 4 Ay hacer clic sobre él.

El archivo Paso 6a_DAMuros.EDB, comprende a los pasos previos e incluye el

dibujo y asignacion de las demas secciones de muro.

Dibujo y asignacion de losas:

A manera de ejemplo se va a dibujar y asignar en todos los pisos tipicos, la seccion
de losa aligerada ALIGERADO, ubicada entre las lineas de malla 3, 4y A, B1:

- Seleccionar la planta tipica PLAN P 3 y la opcién Similar Stories, de la misma

forma que se hizo para el Dibujo y asignaciéon de muros.
- Presionar el botén de comando [] (Draw Rectangular Areas (Plan, Elev)).

- Enla ventana Properties of Object, elegir la seccion ALIGERADO en la casilla

Property, tal como se muestra en la figura 5-13.

Properties of Object x|
Property ALIGERADD

Local Auis 0.

# Dimenzion [if no drag) 0.

" Dimenzion [if no drag) 0.

Figura 5-13.- Ventana de propiedades de objeto, para el dibujo de areas.
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Ubicar el cursor en la esquina inferior izquierda de la losa, en el punto con la
etiqueta Grid Point 3 B1, y hacer clic en él. Luego arrastrar el cursor hacia la
esquina superior derecha, al punto con la etiqueta Grid Point 4 A y soltar el

botdn izquierdo del mouse.

Nota: En este caso no fue necesario modificar el &ngulo de giro de la losa porque
ésta se orientaba en la direccion del eje global X. Para los casos donde sea

necesario rotar esta orientacion un cierto angulo con respecto al eje X, se utilizara

el menu Assign > Shell/Area > Local Axes, o el boton de comando , (Assign
Shell Local Axes).

El archivo Paso 6b_DALosas.EDB, comprende a los pasos previos e incluye el

dibujo y asignacion de las demas secciones de losa.

PASO 7. Asignaciéon de Etiquetas Pier

Para poder apreciar las fuerzas internas en los objetos de area verticales, se les

asignan a éstos etiquetas pier. En nuestro caso se va a asignar una etiqueta pier a

cada muro de un piso que se quiera analizar por separado. Por ejemplo, se va

asignar la etiqueta PL1 a la placa de cada piso tipico del eje A, entre los ejes 1B y

4:

- Presionar el botén de comando PR (Set Plan View) y seleccionar la planta
PLAN 3P.

- Seleccionar la opcién Similar Stories, en el cuadro de lista con las opciones de
asignacion para las vistas en planta (parte inferior derecha de la pantalla).

- Seleccionar el muro ubicado en el eje A, entre las lineas de malla 1B y 4, es
decir entre las etiquetas Grid Point 1B Ay Grid Point 4 A.

- Presionar el botén de comando Ol (Assign Pier Label).

- Enla ventana Pier Names, escribir PL1 en el cuadro de texto y presionar luego
el boton de comando Add New Name vy finalmente elegir esta etiqueta dentro

de las que ya han sido creadas. Como se muestra en la figura 5-14.
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Pier Names

—wiall Piers———— [~ Click to
FL1 Add Mew MName |
HOME
P1 Change Mame |

Delete Mame |

Cancel |

Figura 5-14.- Ventana de creacion de etiquetas pier.

El archivo Paso 7_MPier.EDB, comprende a los pasos previos e incluye la

asignacion de las demas etiquetas de muro pier.

PASO 8. Re-etiquetacidn de los objetos de punto, lineay area.

Tanto los nudos como los objetos de linea y de area del modelo, se identifican a

través de etiquetas, las cuales son colocadas por defecto a medida que se va

dibujando el modelo. Es conveniente que luego de crear todos los elementos se
realice una re-etiquetacion:

- Ingresar al menu Edit > Auto Relabel All. De esta manera, el programa realiza
la re-etiquetaciéon de manera automatica, utilizando como referencia el sistema
de coordenadas global. Para ello, ordena primero a los objetos por su nivel de
entrepiso, luego por su ubicacién en el eje global Y y por Gltimo por su ubicacién

en el eje global X.

Recomendacion: Antes de re-etiquetar los elementos del modelo, seria bueno
mostrar las etiquetas creadas por defecto, con la finalidad de visualizar el cambio.
Para ello, presionar el botén de comando [ (Set Building View Options) y activar
las casillas Area Labels, Line Labels y Point Labels, dentro del cuadro Object

View Options y finalmente la casilla Apply to All Windows.

El archivo Paso 8 Reetiquetado.EDB, comprende a los pasos previos e incluye la

re-etiguetacion de los objetos del modelo.
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PASO 9. Asignacion de liberaciones en los extremos de las secciones de

Viga

Se liberaran totalmente los momentos en los extremos de las vigas que se

encuentren apoyadas en otras vigas 0 apoyadas en muros perpendiculares a ellas.

También se liberara parcialmente el momento en los extremos de las vigas muy

esforzadas que deban ser disefiadas por capacidad, hasta lograr un momento que

pueda ser manejado en el disefio.

A manera de ejemplo se va a liberar completamente el momento en la direccién 3,

Moment 33 (Mayor), en el extremo inicial de la viga ubicada en la planta PLAN S 2,

en el eje 2 y entre las lineas de malla Ay C:

- Presionar el boton de comando FIA (Set Plan View) y seleccionar la planta
PLAN S 2.

- Seleccionar la opcién One Story (porque la planta PLAN S 2 no es tipica), en el
cuadro de lista con las opciones de asignacion para las vistas en planta (parte
inferior derecha de la pantalla).

- Seleccionar la viga ubicada en el eje 2, entre las lineas de malla Ay C, es decir
entre las etiquetas Grid Point 2 Ay Grid Point 2 C.

- Ingresar al menu Assign > Frame/Line > Frame Releases/Partial Fixity y
activar la casilla Moment 33 (Major) para el extremo Start, tal como se muestra
en la figura 5-15 y aceptar el valor de 0 escrito en el cuadro de texto de la

seccion Frame Partial Fixity Springs.

Assign Frame Releases

— Frame Releazes
Heleaze Frame Partial Fixity Springs
Start  End Start End
Aial Load r - | |
Shear Force 2 [Major] [~ [T | |
Shear Force 3 (Minar] T | |
T orzsion o |
Maoment 22 [Minor] r I I
Moment 33 [k ajor] M I ID- I
[T MoReleazes 1] I Cancel

Figura 5-15.- Ventana de asignacion de liberaciones.
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El archivo Paso 9_Liberaciones.EDB, comprende a los pasos previos e incluye la

asignacion de las demas liberaciones en los extremos de las vigas.

PASO 10. Creaciony asignacion de diafragmas

Los sistemas de piso, que pueden considerarse como diafragmas rigidos, se
representan asignando a las areas o a los nudos del nivel una restriccion de
“Diafragma”.

Es recomendable asignar a una misma planta un diafragma de punto y

adicionalmente un diafragma de area, ya que algunos nudos presentes en la planta

pueden no coincidir con las esquinas de los elementos de area del nivel.

Esta restriccibn no es necesaria asignarla a las plantas del edificio que se

encuentran confinadas por una restriccién fisica, como el caso de los sétanos (que

estan enterrados).

A manera de ejemplo se va a asignar a la planta del ler piso, PLAN P 1 el

diafragma rigido D1:

- Presionar el botén de comando FIf (Set Plan View) y seleccionar la planta
PLAN P 1.

- Seleccionar la opcién One Story, en el cuadro de lista con las opciones de
asignacion para las vistas en planta (parte inferior derecha de la pantalla).

- Seleccionar todos los elementos de la planta, arrastrando el cursor desde una
esquina a otra opuesta y presionar el botén de comando = (Diaphragms - de
punto), dentro del menu Assign > Joint/Point.

- En la ventana Assign Diaphragm, seleccionar D1, dentro del cuadro

Diaphragms, como se muestra en la figura 5-16.

Assign Diaphragm

— Click to:

— Diaphragmz

Add Mew Diaphragm |

todify/Show Diaphragm |

[elete Diaphragm |

Cahcel |

[~ Disconnect fram &l Diaphragros

Figura 5-16.- Ventana de asignacion de diafragmas
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Volver a seleccionar todos los elementos de la planta y presionar ahora el boton
de comando = (Diaphragms - de &rea), dentro del menu Assign > Shell/Area.
- En la ventana Assign Diaphragm, seleccionar el mismo diafragma asignado a

los objetos de punto, D1.

Para crear un nuevo diafragma, por ejemplo el diafragma D2, que se asignara a la

planta PLAN P 2:

- Ingresar al menu Define > Diaphragms y presionar el boton de comando Add
New Diaphragm, dentro del cuadro Click to.

- En la ventana Diaphragm Data escribir D2 y seleccionar la opcion Rigid, tal

como se muestra en la figura 5-17.

Diaphragm Data
Diaphragm IDE

— Rigidity
* Rigid " Semi Rigid

0k, I Cancel

Figura 5-17.- Ventana de definicion de diafragmas.

El archivo Paso 10 _Diafragmas.EDB, comprende a los pasos previos e incluye la

definicion y asignacion de los demas diafragmas.

PASO 11. Asignacion de restricciones

A los sé6tanos del edificio, no se les ha asignado diafragmas rigidos, pero es

necesario restringir los desplazamientos horizontales y la rotacion vertical en sus

plantas para poder modelar su comportamiento.

A manera de ejemplo se van a asignar las restricciones necesarias en los nudos de

las plantas PLAN S 2y PLAN S 1:

- Presionar el botén de comando PR (Set Plan View) y seleccionar la planta
PLAN S 2.

- Seleccionar la opcién Similar Stories, en el cuadro de lista con las opciones de
asignacion para las vistas en planta (parte inferior derecha de la pantalla).

- Seleccionar todos los nudos del entrepiso, arrastrando el cursor desde una
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esquina a otra opuesta.

- Presionar el botén de comando &% (Assign Restraints (Supports)) y activar las
casillas Translation X, Translation Y y Rotation about Z, dejando
desactivadas las demés casillas, tal como se muestra en la figura 5-18.

Assign Restraints

— Restraintz in Global Directions

[¥ Tranzlabion ¥ [ Rotation about =
[¥ Tranzlabion % [ Rotation about %
[T Tranzlation 2

— Faszt Restraintz

NPV
ITI Cancel |

Figura 5-18.- Ventana de asignacion de restricciones.

En la planta BASE, si suponemos un suelo rigido en el que todos los elementos
estan restringidos, habria que llenar la ventana Assign Restraints como se indica

en la figura 5-19.

Assign Restraints

— Restraintz in Global Directions

¥ Translation =
[ Translation
¥ Translation £

[+ PFotation about 3
[+ PBotation about
[+ PRotation about 2

— Faszt Restraints

Figura 5-19.- Restricciones asignadas en la base.

El archivo Paso 11_Restricciones.EDB, comprende a los pasos previos e incluye

la asignacion de restricciones en los nudos de los s6tanos y de la base del edificio.
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5.1.2 Analisis por Cargas de Gravedad

PASO 12. Definicion de los casos de carga estética

Se usaran los casos de carga estatica muerta y viva. En el ejemplo se identifican
con los nombres CM y CV respectivamente. Estos casos se crean como se indica a

continuacion:

- Para la carga muerta, presionar el boton de comando . (Define Static Load
Cases) y en la ventana Define Static Load Case Names, tipear CM en el
cuadro de texto Load, seleccionar DEAD en el cuadro de lista Type, tipear 1 en
el cuadro de texto Self Weight Multiplier (para considerar el peso propio de los
elementos) y finalmente hacer clic en el botén Add New Load.

- Parala carga viva, tipiar CV en el cuadro de texto Load, seleccionar LIVE en el
cuadro de lista Type, tipear O en el cuadro de texto Self Weight Multiplier y

hacer clic en el botén Add New Load, tal como se muestra en la figura 5-20.

Define Static Load Case Names

—Loads — Click Ta:
Self wigight At : 1
e Type Multiplier Lateral Load LeAddNewload
Iev L = El Modiyload |
DEAD DEAD 1

El:;E HEED -|I:I fdodify Lateral Load).. I

. [
Delete Load I

)4 |
_Cancel |

Cancel

Figura 5-20.- Ventana de definicion de los casos de carga estética.

Recomendacion: para facilitar la posterior asignacién de los casos de carga, se

debera borrar los casos DEAD y LIVE, que aparecen por defecto.

El archivo Paso 12 DCCE.EDB, comprende a los pasos previos e incluye la

definicion de los casos de carga estatica.

PASO 13. Asignacion de cargas estaticas en losas

A las losas se asignaran las cargas uniformemente distribuidas, muerta (CM) y viva

(CV), correspondientes al peso propio y a la sobrecarga, respectivamente.
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A manera de ejemplo, se va a asignar en todos los pisos tipicos, los casos de carga

CMy CV a la losa aligerada ubicada entre las lineas de malla 3, 4y A, B1:

- Presionar el botén de comando PIR (Set Plan View) y seleccionar la planta
PLAN P 3.

- Seleccionar la opcién Similar Stories, en el cuadro de lista con las opciones de
asignacion para las vistas en planta (parte inferior derecha de la pantalla).

- Presionar el botén de comando % (Assign Uniform Load).

- En la ventana Uniform Surface Loads, elegir el caso de carga CM del cuadro
de lista Load Case Name, las unidades Ton-m del cuadro Units, escribir 0.45
en el cuadro de texto Load y seleccionar el botén de opcion Replace Existing

Loads, tal como se muestra en la figura 5-21.

Uniform Surface Loads

Units
Load Case Mame I Ch LI ’7| Ton-m ;I

— Uniform Load Ophions

Load G € Add to Existing Loads

+ Replace Existing Loads

Direction IG[‘EW“-"J j' ¢ Delete Exizting Loads
ok I Cahcel |

Figura 5-21.- Ventana de asignacion de carga uniformemente distribuida (CM) sobre una superficie.

- Repetir el paso anterior, pero elegir ahora el caso de carga CV del cuadro de
lista Load Case Name, escribir 0.30 en el cuadro de texto Load y seleccionar el
boton de opcién Replace Existing Loads en el cuadro Options, tal como se

muestra en la figura 5-22.

Uniform Surface Loads

Urits
Load Case Name I Cv ;I ’7| Ton-m LI

 Uniform Load Options

Load Ing— " Add o Existing Loads

i+ Replace Existing Loads

Direction IG[aVit-"' ]' i~ Delete Existing Loads
OF I Cancel I

Figura 5-22.- Ventana de asignacion de carga uniformemente distribuida (CV) sobre una superficie
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Nota: En el caso de de tener losas de mas de cuatro lados, se debe realizar el
metrado de cargas de la losa y distribuir la carga directamente sobre los elementos

gue la soportan.

El archivo Paso 13 ACEL.EDB, comprende a los pasos previos e incluye la

asignacion de todas las cargas estaticas en las losas.

PASO 14. Asignacion de cargas estaticas en vigas

En las vigas, se asignaran (de manera concentrada o distribuida) las cargas de los

tabiques directamente apoyados y el metrado de la carga del area tributaria de las

losas que tienen mas de cuatro lados.

A manera de ejemplo, se va a asignar a la viga del eje 4, entre los ejes Ay E, de

todas las plantas tipicas, la carga estatica proveniente de peso propio de los

tabiques:

- Presionar el botén de comando PR (Set Plan View) y seleccionar la planta
PLAN P 3.

- Seleccionar la opcion Similar Stories, en el cuadro de lista con las opciones de
asignacion para las vistas en planta (parte inferior derecha de la pantalla).

- Seleccionar la viga del eje 4, comprendida entre los ejes Ay E.

- Presionar el botdon de comando Z= (Assign Frame Distributed Load) y en la

ventana que aparece copiar la informacion de la figura 5-23.

Frame Distributed Loads

Units
Load Case Hame IEM ;I ’7| Ton-m ;I

—Load Type and Direction———— — Options

& Forces  © Moments ¢ Add to Existing Loads

t* Replace Existing Loads

Direction IGravil_l,l ;I
" Delete Existing Loads

— Trapezoidal Loads

2 K] 4
Distance 0. {025 {075 f1.
Load |0 i fo. o
¥ Relative Distance from End-| " absolute Distance from End-|
— Unikarmn Load
Load IF ITI Cancel I

Figura 5-23.- Ventana de asignacion de carga distribuida en secciones portico.
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El archivo Paso 14 ACEV.EDB, comprende a los pasos previos e incluye la

asignacion de todas las cargas estaticas en las vigas.

PASO 15. Definicién de la fuente de masa

Para el andlisis sismico, se debe definir la fuente de masa, tal como se indica:

- Presionar el botén de comando *¥ (Define Mass Source).

- En la ventana Define Mass Source, seleccionar la opcién From Loads, dentro
del cuadro Mass Definition.

- Dentro del cuadro Define Mass Multiplier for Loads, seleccionar CM en el
cuadro de lista Load, tipear 1 en el cuadro de texto Multiplier y presionar el
botén de comando Add.

- Realizar la misma operacion, pero esta vez, seleccionar CV en el cuadro de lista
Load y tipear 0.25 en el cuadro de texto Multiplier.

- Activar las casillas Include Lateral Mass Only y Lump Lateral Mass at Story

Levels, como se muestra en la figura 5-24.

Define Mass Source

kazz Defintion
" From Self and 5pecified Maszs
& ....................
¢ From Self and Specified Mazs and Loads

=

— Define Mazs Multiplier for Loads
Load b ultiplier

CH ~|l

oy 0.25 Add |
kA odify |
[elete |

¥ Include Lateral bMazs Only

[+ Lurnp Lateral Mass at Stary Lewvels

k. I Cancel

Figura 5-24.- Ventana de definicion de la fuente de masa.

El archivo Paso 15 DFM.EDB, comprende a los pasos previos e incluye la

definicion de la fuente de masa.
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PASO 16. Definicién del niumero de modos

Se deben definir 3 modos por piso (2 traslacionales y 1 rotacional). El edificio tiene

12 pisos, contabilizando los niveles del tanque elevado y cuarto de maquinas del

ascensor y descontando los niveles de los sétanos. Por lo tanto 36 modos.

Para definir los modos en el programa, se debe:

- Ingresar al menu Analyze > Set Analysis Options.

- Enlaventana Analysis Options, que se muestra en la figura 5-25, seleccionar
el boton de comando Set Analysis Parameters.

Analysis Options

— Building Active Degrees of Freedom
Full 30 2 Plane < Plane Mo Z Rotation

s a .y s Fay .y & oA A

WU MU' WUZ WRY WRY W FZ

¥ Dunamic Analysis Set Dynamic Parameters. . I

[ Include P-Delta Set B-Delta Farameters... I

[T Save Access DB File File Mame... I
]S Cancel

Figura 5-25.- Ventana de las opciones de analisis.

- Enla ventana Dynamic Analysis Parameters, escribir 36 en el cuadro de texto

Number of Modes, como se muestra en la figura 5-26.
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Dynamic Analysis Parameters
Mumber of Hodes IEE

— Type of Analyziz
* Eigenvectors " Ritz Vectors

— Eigertvalue Parameters

Frequency Shift [Center] ID-
Cutaff Frequency [Radiuz] ID-
Relative Tolerance |1 [00oE-o7

[ Include Residual-tass Modes

— Starting Ritz ectarz
Lizt of Loads Ritz Load Yectors

Add = I
<- Hemove I

| k. I Cancel

Figura 5-26.- Ventana de definicion del nimero de modos dinamicos.

El archivo Paso 16 DNM.EDB, comprende a los pasos previos e incluye la

definicion del nUmero de modos.

5.1.3 Andlisis Sismico Espectral

El espectro se encuentra en un archivo de texto, en donde la primera columna
corresponde a los datos del periodo (T) y en la segunda, el producto del factor de

amplificacién del suelo (S) y el factor de amplificacion sismica (C).

PASO 17. Definicion de la funcién del espectro de respuesta

Para definir la funcion del espectro de respuesta:

- Ingresar al mena Define > Response Spectrum Functions ( i ).

- En la ventana Define Response Spectrum Functions (ver figura 5-27),
seleccionar del cuadro de lista Choose Function Type to Add la opcion
Spectrum from File y dentro del cuadro Click to presionar el boton de

comando Add New Function.
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Define Response Spectrum Functions

—Responze Spectra—— [ Choose Function Type to Add——

=ctrum from File

— Click to:
Add Mew Function... I

raditp/Shaw Spectumm... I

[Delete Spectium I
Ok, I Cancel I

Figura 5-27.- Ventana de las funciones de espectro de respuesta definidos.

- Enla ventana Response Spectrum Function Definition, escribir FUNCION en
el cuadro de texto Function Name. Luego, presionar el boton de comando
Browse (dentro del cuadro Function File) y cargar el archivo de texto
“P17_TvsSC.txt” que se encuentra en la carpeta “Archivos del Modelo” y
escribir 1 en el cuadro de texto Header Lines to Skip. Finalmente, dentro del
cuadro Values are seleccionar el boton de opcién Period vs Value, y presionar
el boton de opcion Display Graph para visualizar el espectro, tal como se indica

en la figura 5-28.

Response Spectrum Function Definition

"Function Dramping Fatio—

Function Name IFUNCIDN ID.DE
~— Function File —Walues are:
File M.ame M i~ Frequency vz Value

c:vdocuments and
settinashistabdeskionhol 7 bessc.tet

Header Lines to Skip I‘I

& Period vs Value

Convert to Uzer Defined “iew File

— Function Graph

Dizplay Graph | I
Ok I Cancel |

Figura 5-28.- Ventana de definicion de la funcién del espectro de respuesta.
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El archivo Paso 17 _DFER.EDB, comprende a los pasos previos e incluye la

definicion de la funcién del espectro de respuesta.

PASO 18. Definicion de los casos de analisis espectral

Se van a definir para las direcciones X y Y los casos de analisis espectral:

- Ingresar al menu Define > Response Spectrum Cases ( I ).

- En la ventana Define Response Spectra (ver figura 5-29), presionar el botén
de comando Add New Spectrum.

Define Response Spectra

—Spectra———— [ Click ta:

I

Add Mew Spectum...

.............................................

Madifp/Show Spectum... I

[Melete S pechm I

Cancel |

Figura 5-29.- Ventana de los casos de andlisis espectral definidos.

- En la ventana Response Spectrum Case Data, para la direccion X, escribir
SPECXX en el cuadro de texto Spectrum Case Name. Luego, dentro del
cuadro Input Response Spectra, para la direccion UL, seleccionar en el cuadro
de lista Function, la funcién del espectro de respuesta FUNCION y escribir el
factor de escala, proveniente del producto de los factores Z*U*g / R =
0.40*1*9.80665/4.5 = 0.872, dentro del cuadro de texto Scale Factor.
Finalmente, verificar que el resto de pardmetros coincidan con los mostrados en
la figura 5-30.

- Repetir el mismo procedimiento para la direccion Y, pero escribir SPECYY en el
cuadro de texto Spectrum Case Name e ingresar la funcion FUNCION y el
factor de escala 0.872 (Z*U*g / R), en la direccion U2.
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Spectrum Case Mame SPECH-

— Structural and Function D amping

Dramping 0.05

Spectrum Case Name SPECYY

— Structural and Function D amping

Dramping 0.05

— Modal Combination
@ COC SR5S & ABS i GMC

n [ e

— Modal Combination
& COC SAS5 & ABS i GMC

i iz |

— Directional Combination

& SHSS

O ABS Orthoganal SF I

" Modified SR55 [Chineze]

— Directional Combination

& SHSS

O ABS Orthogonal SF I

" Modified SR55 [Chineze]

— Input Fesponse Spectra

— Input Response Spectra

Direction Function Scale Factor Dhirection Function Scale Factor
Uy |FUNCION =]  [o.s72 mo ~ ]
v2 | =l vz [FonCioN =] [os7z
uz | = iz | =~ |

Excitation angle IU Excitation angle IU-

— Eccentricity — Eccentricity
Ecc. Ratio [&ll Diaph.) ID Ece. Ratio [&ll Diaph.) ID.
Dverride Diaph. Eccen. Owenide. .. | Dverride Diaph. Eccen. Ovweride. . |
Ok I Cancel | Ok I Cancel |

Figura 5-30.- Ventana de definicion de los casos de analisis espectral, para las direcciones Xy Y.

El archivo Paso 18 DCAE.EDB, comprende a los pasos previos e incluye la

definicion de los casos de andlisis espectral.

51.4 Verificacion de la Fuerza Cortante Minima en la Base

La norma peruana especifica que para cada una de las direcciones consideradas
en el andlisis dinamico (X y Y), la fuerza cortante en la base del edificio debera ser
mayor o igual que el 90% (en edificios irregulares) de la misma fuerza calculada a
través de un analisis estatico. En caso contrario se deberan incrementar los
resultados del analisis dinamico por medio de un factor de escala.

Estos factores de escala van a servir para multiplicar a los casos de carga de
analisis espectral, definidos en el paso 18, con la con la finalidad de utilizarlos como
casos de carga de sismo dentro de las combinaciones de carga definidas en el

paso 20.
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Calculo del cortante en la base del caso estatico
El cortante en la base esté definido por V = Z*U*C*S*P / R, en donde P es el peso
total de la edificacion (sin considerar los s6tanos)y C/ R =2 0.125.

Para el célculo del factor de amplificacion sismica (C):

- Ingresar al menu Display > Show Tables, y en la ventana Choose Tables for
Display, seleccionar ANALYSIS RESULTS > Modal Information > Building
Modal Information > Table: Modal Participating Mass Ratios, tal como se
indica en la figura 5-31. En la figura 5-32 se muestra la tabla Modal
Paticipating Mass Ratios, que contiene los periodos fundamentales en cada

direccion (dentro de una circunferencia).

B AMALYSIS RESULTS [1 of 25 tables selected]
EE|:| Displacements

#-[] Reactions

= E Modal Information

-] Building Modes

=@ Building Madal Infarmation

-] Table: Modal Participation Factors

-] Table: Modal Participating Mazz R atioz

-[] Tahle: Madal Load Participation R atins

-[] Tahle: Responze Spectum Accelerations
-[J Table: Regponze Spectum Modal Amplitudes
-[] Tahle: Responze Spectum Base Reactions

Figura 5-31.- Seleccién de la tabla de las razones de masa participante modal.

Modal Participating Mass Ratios
Edit View
|Modal Participating Mass Ratios |
Mode Period | Ux uy uz SumUX SumUY -
» 1 1y = (1.323461) «€—6-8885—— 64.8304 0.0000 0.0085 64.8804 | |
2 | 0686038 | 19280 | 66913 | 00000 | 19365 | 715717 |
3Tx = (0643151 & 698808 | 01042 00000 | 718173 | 716760
4 | 0 | 00051 | 183043 00000 | 718224 | 899809
5 | 0117392 0.0004 27069 | 00000 | 71.8227 92,6878
6 0.112591 0.0438 2.7199 0.0000 71.8726 95.4076
7 0.101031 15.7998 0.0168 0.0000 87.6724 95.4245
8 0.074747 0.0581 2.0246 0.0000 87.7305 97.4491
9 0057432 | 24947 | 08115 | 0.0000 90.2252 | 98.2606
10 0056270 | 12357 | 00848 |  0.0000 91.4608 | 983554 |
1 | 0054832 | 12584 | 08815 | 00000 | 927192 | 992368 |
12 | 0043466 | 00323 | 04858 | 00000 | 927521 | 997226 |~
« | »
MM
Figura 5-32.- Ventana de las razones de masa participante modal, con periodos fundamentales

indicados.

- Enlas direcciones X y Y, para cada uno de los periodos fundamentales, calcular
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el valor de C = 2.5%(T,/ T); C < 2.5. En la tabla 5-2 se muestra el calculo de Cy
la verificacion de la condicion C/ R = 0.125.

Tabla 5-2.- Factor de amplificacion sismica (C)

Direccion X Direccion Y

Cx = . 0.76 |

Cx/R 0.169

I
o
w
N
i
9]

<

~
Py

I

Para el célculo del peso total del edificio (P):

- Para mostrar las masas en los pisos, ingresar al menu Display > Show Tables,
y en la ventana Choose Tables for Display, seleccionar MODEL DEFINITION
> Building Data > Mass Data > Table: Diaphragm Mass Data, tal como se
indica en la figura 5-33. En la figura 5-34 se muestra la tabla Diaphragm Mass

Data, con la informacién de la masa de los pisos del edificio.

‘B MODEL DEFIMITION [1 of 71 tables zelected]
=-H Building Data

EE|:| Cantral [ata

&[] Stary Data

EE|:| Coordinate Systems and Grids
Hal:l Fuoint Coordinates

-0 Line Connectivity

Hal:l Area Connechivity

EEI:I Diaphragrm Connectivity

EIE b azz Data

0 Table: Mass Source

Figura 5-33.- Seleccién de la tabla de datos de masa de los diafragmas
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Diaphragm Mass Data
Edit  Wiew
IDiaphragm tazz Data ;I
Story Diaphragm MazsX MazsY MMl XM b, |
b | PLAN T CHEC DTCHC 2. 7EE3 2. 7EE3 26,2629 20 450 7804
PLAN P Ch&C DPCHC V.8838 V.8E38 76 E052 20,478 7470
PLAM P10 D10 14,1891 14,1891 5231967 17.753 7042
FLAM P 5 (mls} 34 4903 34 4103 3057 447 18024 7 4E0
FLAN F 8 (15 40 2236 40 2236 37080013 17.950 7508
FLAN P 7 Dy 40, 4365 40 4365 7214896 17.958 7500
FLAN F B DE A0, 4365 A0 4365 7214896 17.958 7500
FLAN P 5 nls] 400, 4365 400 4365 3721, 4896 17.958 7500
FLAM F 4 (i} 40 4600 40 4600 Arz2 av40 17 953 7.A00
FLAN F 3 03 40,4330 40,4330 3r24. 3385 17.947 7500
PLAN P 2 (e 41,7962 41, 7962 3064 9532 18.031 7508
FLAN P 1 01 50,0635 50 0635 7208 4548 22173 7802
<D T

Figura 5-34.- Ventana de datos de masa de los diafragmas.

- Dentro de una hoja de Excel, multiplicar las masas por la gravedad y realizar
una sumatoria para obtener el peso del edificio, tal como se muestra en la tabla
5-3.

Tabla 5-3.- Peso total de la edificacién

. . Masa { Peso
Piso Diafragma

(Tn) (Tnf)
PLAN T CM&C DTCMC 2.7669 27.13
PLAN P CM&C DPCMC 7.8838 77.31
PLAN P 10 D10 14.1891 139.15
PLAN P 9 D9 34.4103 337.45
PLAN P 8 D8 40.2236 394.46
PLAN P 7 D7 40.4365 396.55
PLAN P 6 D6 40.4365 396.55
PLAN P 5 D5 40.4365 396.55
PLAN P 4 D4 40.46 396.78
PLAN P 3 D3 40.493 397.1
PLAN P 2 D2 41.7962 409.88
PLAN P 1 D1 50.0685 491

Suma = 3859.91

El calculo de los cortantes basales del caso estatico, para las direcciones Xy Y se

muestra en la tabla 5-4.
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Direccién X Direccién Y |
Vx est. 531.81| Vy est. 260.76 |
Tx = 0.643151| Ty = 1.323461
z = 04| z = 0.4
U = 1 u = 1
Cx = 1.55| Cy = 0.76
S = 1 s = 1
P = 385991 P = 3859.91
Rx = 45| Ry = 4.5

Céalculo del cortante en la base del caso dinamico

Para obtener el cortante en la base en las direcciones de andlisis X y Y:
- Ingresar al menu Display > Show Tables, y en la ventana Choose Tables for
Display, seleccionar ANALYSIS RESULTS > Building Output > Building

Output > Table: Story Shears, tal como se indica en la figura 5-35.

B AHALYSIS RESULTS [1 of 25 tables selected)
#-[1] Displacements
EE|:| Reactions
#-[] Modal Information
= B Building Dutput
=B Building Output
' |:| Table: Center Mazs Rigidity
B Table: Story Shears
[0 Table: Tributary Area and RLLF
[0 Table: Special Seismic Rho Factar

Figura 5-35.- Seleccién de la tabla de fuerza cortante en los pisos.

- En la misma ventana (Choose Tables for Display), dentro del cuadro Load
Cases/Combos (Results), presionar el boton de comando Select
Cases/Combos y seleccionar los casos de carga SPECXX Spectray SPECYY

Spectra, tal como se muestra en la figura 5-36.
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Select Output

— Select
v Static Load -
EMWOLY Combo _I
k5= Combo
k5% Combo
k% Combo

M5 Cambao

MySY Comba _Cancel |
SISMO% Combo
SISMOY Combo

Clear 41l |

Figura 5-36.- Casos de carga seleccionados para visualizar la fuerza cortante.

- En la tabla Story Shears (figura 5-37), se muestran las fuerzas cortantes en la

base del edificio para las direcciones X y Y (dentro de una circunferencia).

Edit View
[ Story Shears =l
Story Load Loc P X VY T a
PLAN P 2 SPECXX Top 0.00 394.05 1383 3231.436
PLANP2 | SPECXX |  Bottom | 000 | 39505 | 1383 | 3231436 |
PLANP2 | SPECYY | Top | 000 | 1437 | 22017 | 3868231 |
PLAN P 2 SPECYY |  Bottom 0.00 14137 22017 | 3868231 |
PLAN P 1 SPECXX Top 0.00 408.47 1555 3360.095
PLAN P 1 SPECXX ——Bottom——+———0:00—p ( 408.47 ) 1?5 3360.095
PLAN P 1 SPECYY Top 0.00 1555 240.01 4340.460
PLAN P 1 SPECYY ———Beottern 3:98 15:55—p+ (24001 ) | 4340.460 I
PLANS1 | SPECXX | Top | 000 | 3188 | 3359 | 952181 |
PLANS1 | SPECXX |  Botton | 000 | 3188 | 3353 | 952161 |
PLANS1 | SPECYY | Top | 000 | 429 | 39657 | 9487.780 |
PLANS1 | SPECYY |  Botton | 000 | 4296 | 39657 | 9487780 |
| KI »
WO

Figura 5-37.- Ventana de fuerzas cortantes, con fuerzas cortantes en la base indicadas.

Calculo de los factores de escala
Para calcular los factores de escala, se debe comparar la fuerza cortante del caso
dindmico contra la fuerza cortante del caso estatico y verificar que el cociente sea

mayor o igual a 0.90, como se muestra en la tabla 5-5.
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a b5-5.- Factores de escala del caso dinamico.

Vx din. = 408.47| Vydin. = 240.01
VX est. = b531.81| Vyest. = 260.76
Vxdin./Vxest. = 0.77| WVydin./Vyest. = 0.92
Cociente min. = 0.9|| Cociente min. = 0.9
\ Factor (fx) = 1.17| Factor (fy) = 1

5.1.5 Combinaciones de los Casos de Carga

PASO 109. Definicion del caso de secuencia constructiva

Para que se muestren las fuerzas internas en los elementos de la estructura,
tomando en cuenta que el edificio ha sido cargado en diferentes etapas durante su
construccion, se debe definir un caso de secuencia constructiva:

- Ingresar al menu Define > Add Sequential Construction Case.

- Enla ventana Auto Construction Sequence Case, verificar que la informacién

concuerde con la mostrada en la figura 5-38.

Auto Construction Sequence Case

—dutive Stucture

" MNaone i+ Auto Create Active Stiucture

% Construction Sequence Caze IEM-SQ € User Specified Active Stucture

r Replace Dead Type Cases with thiz Caze in all
Default Dezign Combos

— Geometic Nonlinearity Effects —Auto Create Active Structure
Create Construction Seguence everny |1 Stories
Nane -~ I Erclude Groum I 'I until Last Step
—Load Fattern r User Specified Active Stiucture
Load Scale Factar Active Grouo
Ch =/ Stage ~]
bk adify | I mdify |

Delete | |Fsert |
Delete |

¥ Loads Spplyto Added Elements Dnli

Cancel |

Figura 5-38.- Ventana de definicion del caso de secuencia constructiva.

El archivo Paso 19 DCSC.EDB, comprende a los pasos previos e incluye la

definicidon del caso de secuencia constructiva.

@ Tesis publicada con autorizacion del autor

SOME RIGHTS RESERVED Algunos Derechos Reservados. No olvide citar esta tesis




4 o PONTIFICIA
TESIS PUCP ;| g;‘!{_\éel_r:g?m

H NEL PERU

PASO 20. Definicion de las combinaciones de los casos de carga

En este paso se definen las combinaciones de los casos de carga para el analisis.

Como ejemplo se va a definir el caso de carga MV (Muerta-Viva), como la suma de

1.4*CMy 1.7*CV:

- Presionar el botén de comando %" (Define Load Combinations).

- En la ventana Define Load Combinations, que se muestra en la figura 5-39,
presionar el botén de comando Add New Combo para agregar la combinacion

de los casos.

Define Load Combinations

— Combinations — Click, tar

pr— AddMew Combo.. |

Modify/Show Comba.. |

[elete Combo I

Cancel |

Figura 5-39.- Ventana de definicion de combinaciones de carga.

- En la ventana Load Combination Data, escribir MV en el cuadro de texto Load
Combination Name, selecionar el tipo de combinacién ADD y en el cuadro
Define Combination seleccionar el nombre de un caso y su factor de
multiplicacion y posteriormente presionar Add. De esta forma, se seleccionara
el caso CM-SQ Static Nonlin y el factor 1.4 y posteriormente el caso CV Static

Load y el factor 1.7, tal como se muestra en la figura 5-40.
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..‘.." |

Load Combination Data

Load Combination Hame IM"v"

Load Cambination Type ADD -

— Defife Combination
Caze Mame Scale Factor

¥ StaticLoad = |17

Ch-50 Static Monlin -~ 1.4

b odify |
Delete |

k. Cancel I

Figura 5-40.- Combinaciones de carga para secuencia constructiva.

Nota: Hay que notar que se debe trabajar con el caso de carga CM-SQ Static
Nonlin, proveniente del caso de secuencia constructiva y no con el caso de carga
CM.

El archivo Paso 20 _CCC.EDB, comprende a los pasos previos e incluye todas las

combinaciones de los casos de carga.

PASO 21. Procesamiento

En este paso se corre el modelo y el caso de secuencia constructiva para que el
programa realice el analisis, para ello:
- Presionar el botén de comando * (Run Analysis) y posteriormente =r (Run

Construction Sequence Analysis).

52 Resultados del Analisis

Después de realizar el analisis, el programa permite visualizar de manera tabular,
para los casos de carga elegidos:
- El desplazamiento de los centros de masa y el desplazamiento en todos puntos,

ya sean traslacionales o rotacionales, con lo cual es posible calcular la junta de
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separacion sismica.

- Los desplazamientos relativos de entrepiso (Drifs), que podran ser comparados
con los limites permitidos en la Norma Peruana.

- Las reacciones en los apoyos.

- Las fuerzas cortantes de piso del analisis dindAmico, de donde se podra obtener
el cortante basal, necesario para calcular el factor de escala de los resultados
de este andlisis.

- La informacion modal, como por ejemplo la razén de masa modal participante,
necesaria para identificar los periodos méaximos en cada direccion.

- Las fuerzas internas de los elementos de poértico (vigas y columnas), como la
fuerza axial, cortante y momentos flectores.

- Las fuerzas internas de los elementos de area con etiquetas pier y spandrel.

En la figura 5-41 se muestra la ventana Chosse Table for Display, que permite

seleccionar los resultados que se requieren visualizar.

Choose Tables for Display

Edit
= ] MODEL DEFINITION (0 of 74 tables selected) B ) sl 7 )
B!I] Building D ata Select Load Cases. .. |
#-0 Property Definitions 2 & 2 ek Sdlbaed)

#-[0 Load Definitions
#-[] Point Assignments — Load Cases/Combos [Results)

B!D Frame Assignments Select Cazes/Combos. .. |

@0 Area Assignments 4 of 13 Loads Selected
#-[0 Input Design Data

#-00 Design Dverwrites Madify/Shaw Optians... |
#-[0 Options/Preferences Data
#-[J Miscellaneous Data — Optiohs

& ANALYSIS RESULTS (7 of 27 tables selected) = Selection Dnly

EI B Displacements

-5 E Dizplacement Data

[ Table: Point Displacements

[0 Table: Paint Drifts

B Table: Diaphragm Ch Displacements
& Table: Story Drifts

----- & Table: Diaphragr Drifts i Mamed Sets

E;]"D Reactions Save Mamed Set... |
E! O Modal Information

EI E Building Output ShavHamed Set..

- &8 Building Output

EI E Frame Dutput

Ba B Frame Forces

s O Frame Design Forces
El [ Area Output

EI B Wall Qutput

& E ‘wiall Forces

Bi [ Dbjects and Elements

HD DESIGN DATA [0 of 3 tables selected] [— -
& Concrete Frame Design ;I Cancel |

Figura 5-41.- Ventana de seleccion de los resultados del andlisis.
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53 Diseno de Elementos en Concreto Armado

5.3.1 Disefio de Vigas

A manera de ejemplo se va a disefar la viga V-0.30x0.65 del eje 3, de la planta

PLAN P 5:

- Ingresar al menu Design > Concrete Frame Design > Select Design Combo.

- En la ventana Design Load Combinations Selection, cargar de la lista de
combinaciones (List of Combos), la combinacién ENVOL. Ver figura 5-42.

Design Load Combinations Selection

— Choose Combos

Lizt of Combioz Deszign Combos

PS5 ErWOLY
b5

P Add - |
_<-Remove

bAWS
b5 <- Bemove
SISO
SISKOY

aF. Cancel

Figura 5-42.- Ventana de seleccion de combinaciones de carga.

- Ingresar al menu Options > Preferences > Concrete Frame Design y verificar
gue los valores mostrados en la ventana Concrete Frame Design Preferences

correspondan a los de la figura 5-43.
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Concrete Frame Design Preferences

Design Code AC] 31599 -]
Mumber of Inkeraction Curves 24
Mumber of Interaction Points 15
Congider Minimum Eccentricity Yes
Phi [Bending-T ension) nA4
Phi [Compreszion Tied) n7
Phi [Comprezsion Spiral] 0.75
Phi (Shear] 0.65 =]
Pattern Live Load Factor 0.75
Itilization Factor Limit 0.95
Cancel |

Figura 5-43.- Ventana de preferencias de disefio de pérticos de concreto.

- Presionar el botén de comando &% (Set Elevation View) y elegir la elevacion 3.

- Seleccionar la viga de la planta PLAN P 5 e ir al menu Design > Concrete
Frame Design > View/Revise Overwrites.

- Dentro de la ventana Concrete Frame Design Overwrites (ACI 318-99),
activar la casilla Element Type, y seleccionar la opcion Sway Ordinary, como

se muestra en la figura 5-44.

Concrete Frame Design Overwrites (ACI 318-99)

Element Section j
Element Type Sway Ordinary
Live Load Feduction Factor
|Inbraced Length Fiatio [Major]
|Inbraced Length Ratio [Minor)
Effective Length Factor (K Majar)
Effective Length Factaor (K. Minaor]
toment Coefficient [Cra Majar] j
torment Coefficient [Cr Minar]
MonSway Moment FactarDns Major]
HanSway Maoment Factor[Dng Minor)

Sway Moment FactorDs ajor]
Sway Moment Factor[Ds Minor]

A e e S

Cancel |

Figura 5-44.- Ventana de sobre escrituras, para definir el tipo de los elementos como ordinarios.

- Seleccionar nuevamente la viga y presionar el botén de comando kil (Start

Concrete Design/Check of Structure).

- Cambiar las unidades por Kgf-cm (Ikgt=m = ) en la parte inferior derecha de la
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pantalla, para que el programa muestre el area de acero longitudinal requerida
en cm?, tal como se aprecia en la figura 5-45.

m)
2 0)

w |

_(0_)
/
N\
—
NS
N\
—{

0.813 3,015 271563 | | 27.215 3.008 0.811 PLANP 5
10.818 18.134 4.924 4.907 15.129 10.816

Figura 5-45.- Visualizacién en pantalla de ETABS del &rea requerida para el refuerzo a flexion de la
viga V-0.30x0.65.

- Con los requerimientos maximos mostrados, plantear una distribucion inicial de
acero longitudinal.
En este caso, se puede realizar una redistribucion para disminuir el area de
acero superior, en el apoyo central (Eje C), de 27.563 cm? @ 25.5 cm? (561”) y
verificar que un area de acero inferior de 15.3 cm? (391”) es suficiente.

- Hacer clic derecho sobre el tramo de viga comprendido entre los ejes Ey C
para mostrar la ventana Concrete Beam Design Information (ACI 318-99),
gue contiene la informacién de las areas requeridas de acero tanto para las

solicitaciones de flexién (cm?), como de corte (cm?/cm). Ver figura 5-46.

Concrete Beam Design Information {(ACI 318-99)

Stary IPL-"B-N F3 Section Mame IV'D-3|15<U-E5

Bearn IB'I 4

COMED STATION TOP BEOTTOM SHEAR

iD Loc STEEL STEEL STEEL

ENVOLY 0.000 0,000 0.000 046 -
ENVOLY 45, 417 o. —
ENVOLY 92,833 0. —
ENVOLY 139,250 a.

ENVOLY 155.667 1.

ENVOLY .083 1. -
ENVOLY 27. -

Ovenarites | Summary I FIe:-:.DetaiIsI ShearDetaiISI Ervelope

(]9 I Cancel |

Figura 5-46.- Ventana de informacién del disefio de vigas de concreto, con areas requeridas de acero.
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De la tabla mostrada en la figura 5-46, obtener aproximadamente las
ubicaciones de los puntos teoricos de corte del acero superior e inferior,
teniendo en consideracion que se correra tanto arriba como abajo 2¢1” (10.2
cm?).
- Verificar que sera necesario cortar aproximadamente:
Acero superior : a 625 cm del extremo inicial.
Acero inferior :a130 cm y 448 cm del extremo inicial.

- Con las recomendaciones de la norma, se obtienen los puntos finales de corte:
Acero superior : a 562.5 cm de extremo inicial (a 165 cm de la cara
de la columna del eje C).
Acero inferior :a 70 cm y 507.5 cm del extremo inicial (a 50 cm y
220 cm de las caras de las columnas, de los ejes E y C respectivamente).

- Para calcular el espaciamiento de los estribos (3/8”), se divide el area de acero
entre la cuantia que presenta la tabla de resultados de ETABS. Asi, para una
cuantia de 0.095 cm?cm el espaciamiento maximo es de 14.95 cm y para una
cuantia de 0.046 cm?cm, de 30.87 cm. Para el ejemplo se utilizaran
espaciamientos de 15 cm y 30 cm, hasta cubrir los requerimientos de acero que

exige la tabla de la figura 5-46.

En la figura 5-47, se muestra el disefio de la viga entre los ejes C y E. La seccion de

la viga, entre los ejes Ay C es simétrica.

@ E—E A—A

221 \3alr

1e1” ol

0.50
5 83/8"%180.05,rio.@0.30

\

:

\

\

|
| 2.20 \ |
7 83/8%1@0.05,13@0. 15,rt0. @030 !

£.29 7.08

YT—05 (0.30x0.65m) TECHD 2 AL 8

181"

E) D{}iﬂ

2e1”

0.30 0.30
CORTE A—A CORTE B—B

Figura 5-47.- Esquema de la viga disefiada, entre los ejes Cy E.
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5.3.2 Diseno de Columnas

A manera de ejemplo se va a disefiar la columna C-0.90X0.45, ubicada entre los
ejes 3y C, del nivel PLAN P 1:

- Verificar que las unidades sean Ton-m (|Terrm = ) en la parte inferior derecha
de la pantalla.

- Presionar el botén de comando &l (Set Elevation View) y elegir la elevacion 3.

- Seleccionar la columna del eje C de la planta PLAN P 1.

- Ingresar al menu Display > Show Tables, y en la ventana Choose Tables for
Display, seleccionar ANALYSIS RESULTS > Frame Output > Frame Forces >
Table: Column Forces, como se indica en la figura 5-48.

- AMALYSIS RESULTS [1 of 25 tables selected)
Eal:l Dizplacements

#-[] Reactions

Eal:l Modal Information

#-[] Building Output

EIE Frame Output

- =@ Frame Forces

' [ Table: Column Forces

. [0 Table: Beam Forces
EHD Area Output

#- 0 Wall Dutput

#-[J Objectz and Elements

Figura 5-48.- Seleccion de la tabla de fuerzas internas de las columnas elegidas.

- En la misma ventana (Choose Tables for Display), dentro del cuadro Load
Cases/Combos (Results), presionar el boton de comando Select
Cases/Combos y seleccionar los casos de carga CM-SQ Static Nonlin, CV
Static Load, SISMOX Combo y SISMOY Combo, tal como se muestra en la
figura 5-49.
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Select Output

—Select

. . Combo
kS Combao
k5% Combo C I
My Combio _Carcal |
kWS Carmbio
kWS Combio

' |: ann tl [n]

Clear 41l |

Figura 5-49.- Casos de carga seleccionados para realizar el disefio de la columna.

- Copiar los valores mostrados en la tabla Column Forces en una hoja de Excel.
- Construir en Excel una tabla (ver tabla 5-6) con la fuerza axial (P) y los

momentos flectores (M2 y M3) para cada uno de los anteriores casos de carga.

Tabla 5-6.- Fuerzas internas de la columna, provenientes
del programa ETABS.
M3
(Tn-m)

P M2
(Tn) (Tn-m)
MUERTA: [Eeizke -0.15 16.31
-127.53 -0.01 3.03
SISMOX: 1.98 0.35 11.42
SISMOY: 0.22 8.28 -0.41

- Realizar el metrado manual de la carga axial para los casos de carga muerta y
viva, que recibe la columna en ese nivel, utilizando el criterio del area tributaria.

- Comparar con el resultado que obtiene el programa (ver tabla 5-7) y
posteriormente verificar si las cargas del programa se aproximan a las del
criterio de area tributaria. En este ejemplo se va a trabajar con la carga del

metrado manual.

Tabla 5-7.- Comparacién entre el metrado manual y de ETABS,
para la carga axial proveniente de los casos de carga muerta y viva.

P (Manual) P (ETABS)
MUERTA:
VIVA:

(Tn) (Tn)
- Enlatabla 5-8, se muestran las cargas seleccionadas que actian en la columna

-350.09 -384.18
-139.90 -127.53

para los diferentes casos de carga elegidos.
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8.- Fuerzas internas de los casos

M2 M3
(Tn) (Tn-m) (Tn-m)
MUERTA:

SISMOX:
SISMOY:

- Con las fuerzas de la tabla 5-8, realizar las combinaciones de los casos de
carga que se muestran en la tabla 5-9.

Tabla 5-9.- Combinaciones de los casos de carga, para el disefio de columnas.

. o Ny, Pu Mu2 Mu3
Nivel ‘Descrlpcmn Combinacion (Tn) @nm) @nem)
MV -727.96 -0.22 27.98

MSX -313.1 0.22 26.1

MSY -314.86 8.14 14.27

MVSX -610.51 0.15 35.59

PLAN P 1 | C-0.90X0.45 | MVSY -612.27 8.08 23.77
-MSX -317.06 -0.48 3.26

-MSY -315.3 -8.41 15.09

-MVSX -614.47 -0.55 12.76

-MVSY -612.71 -8.47 24.58

- Ingresar al menu Options > Preferences > Shear Wall Design vy verificar que
los valores mostrados en la ventana Wall Pier/Spandrel Design Preferences
correspondan a los de la figura 5-50. Para una mejor presentacioén del diagrama

de interaccion, el nimero de puntos (Number of Points) debe ser = que 15.

Design Cods A1 31599 4]
Febar Units cm’™2

Rebar/Length Urits o 2dm

Phi [Bending-T ension) [IR:]

Phi [Compression) 07

Phi [Shear) 085

Phi [Shear Seizmic) 06

Prax Factar ns ;I
Mumber of Curves 24

Mumber of Paoints 15

Edge Design PT-Max 0.06

Edge Design PC-Max 004

Section Deszign IP-Max 0.0z

Section Dezign IP-Min 0.0025

Utilization Factor Limit 0495 Cancel I

Figura 5-50.- Ventana de preferencias de disefio de secciones pier y spandrel.
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- Ingresar al menu Design > Shear Wall Design > Define Pier Sections for

Checking y en la ventana Pier Sections (figura 5-51) presionar el botén de
comando Add Pier Section.

— Sections — Click ta:

add Pier Sechion,

Add Copy of Pier Sechion... |

Madify/Show Fier Section... |

[Velete Pier Section I

] Cancel |

Figura 5-51.- Ventana de definicion de secciones pier.

En la ventana Pier Section Data, mostrada en la figura 5-52, escribir

C90X45INI en el cuadro de texto Section Name y presionar el botén de
comando Section Designer.

Pier Section Data
Section Mame IEEII}@EINI

Baze Material I COMC - I

—Add Pier
' Add Mew Fier Section

" Start from Existing *#all Pier
| = -

— Define/E dit/Show Section

| Section Dezsigner... I

[ I Cancel |

Figura 5-52.- Ventana de definicion de datos de una seccion pier.
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Dentro del Sub Programa Section Designer, graficar la seccion de la columna,
con una distribucion inicial de acero (16 ¢ 17, aprox. p = 2%), tal como se

muestra en la figura 5-53.

CSISD ﬂﬂlﬂ

File Edit %iew Draw Select Display Option:  Help
D] =[] 2| ole|e|#| oM =8|«
N Y

W |6 e e o 4

o R

El

¢ ¢ ¢ o o o 9

=

E

1 Areas Selected #»=000 %=030 ITn:nn-m vI Done |

Figura 5-53.- Refuerzo inicial colocado en la columna, dibujado en el Section Designer.

- Para obtener el diagrama de Interaccion (figura 5-54), presionar el botén de

comando & (Show Interaction Surface).
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Interaction Surface (ACI 318-99)
Edit
F 3 [l
1 -88.4873 0. 0.
2 -88.4873 351264 0. ™y
3 -A74.8955 B1.2742 0.
4 B21.9762 E5.0244 0.
5 -464.34 7256 0.
B -403.2721 876217 0. ____...-""/
7 -333.4553 9673 1}
a -253.4755 105.0268 1}
] -186.608 1055088 1}
10 -121.335 101.587 0.
1 -AE.285 94.3218 0. ~Optiong————— 30 Wiew
12 10.0218 1036327 0. . =
13 53,4781 766754 0 @ ph EB 5| Flan
14 1596. 4584 44,7508 0. ) -
15 | 3082523 i i ® o [ j Elevation
16 . .
17 1o phi with by increase a4 | M | P3| Pz
18
Curve 1
Ange O 1] «[» [M]

Figura 5-54.- Superficie de interaccion de la seccion inicial de columna dibujada.

- Copiar los resultados mostrados en la ventana Interaction Surface en una hoja
de Excel, y graficar las curvas del diagrama de interaccion para los pares P-M2
(90°-curva 7y 270°-curva 19) y P-M3 (0°-curva 13 y 180°-curva 1).

- Comprobar si la resistencia de la columna es mayor que la demandada por las
combinaciones de las fuerzas. En caso de no ser asi, iterar aumentando su
armadura, hasta llegar a cumplir con la demanda de resistencia.

- Como no se cumple este requisito con la armadura inicial, modificarla por 16 ¢
1%/5”. Para ello, crear una nueva seccion (C90X45FIN) en la ventana Pier
Section Data y presionar el botén de comando Section Designer. En la figura

5-55 se muestra el detalle de la nueva seccion.
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File Edit “iew Draw Select Digplay Optionz Help
D| =]« 2] B|o|e|p|o|H| =]&|4]
)i

¢ & ¢ 6 6 o O
* o e i
¢ 6 6 0 o o o

#=000 %=030 ITu:un-m vI Done

Figura 5-55.- Refuerzo modificado de la seccién de la columna, dibujado en el Section Designer.

- Comprobar nuevamente si la resistencia de la columna es mayor que la
demandada por las combinaciones de las fuerzas. Se aprecia en la figura 5-56 y
en la figura 5-57 que con 16 ¢ 1%/5” se cumple el requisito buscado en los ejes

locales 2 y 3 respectivamente.

COLUMNA C-90X45
(P-m2)
EJELOCAL 2,PLAN P 1

00
800

e N\

Combinaciones

Compresion
d

=]

N
A

Fuerza Axial, P (Tn)

Traccion

Momento Flector, M2-2 (Tn-m)

Figura 5-56.- Diagrama de interaccion de la columna C-0.90X0.45, para el gje local 2.

@ Tesis publicada con autorizacion del autor

SOME RIGHTS RESERVED Algunos Derechos Reservados. No olvide citar esta tesis




\\\ﬁNEg‘%

F < | PONTIFICIA
TESIS PUCP 2t #_% | UNIVERSIDAD
2 [ CATOLICA
= = = nEl
~ay PERU
COLUMNA C-90X45
(P-M3)
EJELOCAL 3,PLANP1
800 .
<
e TN
g yd 00 .L AN
o 7~ bt o
§ . Combinaciones
=
= 00
o 200
(_L'-; 175 4# 125 -100 5 -50 25 25 50 75 100 125 {0 175
< e 9 .
<
(]
RN /
> \ /
(N
\ 100 /
\ /
oot

Traccion

Momento Flector, M3-3 (Tn-m)

Figura 5-57.- Diagrama de interaccién de la columna C-0.90X0.45, para el eje local 3.

- Para calcular la distribucion del acero transversal, visualizar la fuerza cortante
en la columna, en la direccion 2. Para ello, ir al menu Display > Show Member
Forces/Stress Diagram (i) > Frame/Pier/Spandrel Forces.

- En la ventana Member Force Diagram for Frames, seleccionar el caso de
carga ENVOLYV y en el cuadro Component la opcidon Shear 2-2.

- Con las recomendaciones de la Norma E.060, calcular el espaciamiento del
refuerzo transversal. Para este caso con ¢ 3/8”: 1@0.05, 8@0.15 y rto. @ 0.30
m c/ext. es suficiente. El espaciamiento maximo de 0.30 m, contempla el

requerimiento de control del pandeo de las barras longitudinales.

En la figura 5-58 se muestra el disefio de la columna C-90X45 en el primer piso.

(] e @
® 042
2 @ @
0.90
160135
3983,/8”

0p3/871@0.058@0.15,rtc@0.30
Figura 5-58.- Esquema de la columna C-0.90X0.45 disefiada en el primer piso.
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5.3.3 Diseno de Muros (Placas)

A manera de ejemplo se va a disefiar el muro del nivel PLAN P 1, ubicado entre los
ejes 1C y 7A e identificado con la etiqueta PL1.:

- Verificar que las unidades sean Ton-m (|Term = ) en la parte inferior derecha
de la pantalla.

- Presionar el botén de comando &l (Set Elevation View) y elegir la elevacion A.

- Seleccionar el muro comprendido entre los ejes 1C y 7A de la planta PLAN P 1.

- Ingresar al menu Display > Show Tables, y en la ventana Choose Tables for
Display, seleccionar ANALYSIS RESULTS > Wall Output > Wall Forces >
Table: Pier Forces, como se indica en la figura 5-59.

B ANALYSIS BESULTS [1 of 27 tablez selected]
Hil:l Dizplacements
HHD Reactions
EHD Modal Information
#-[] Building Output
#-[] Frame Dutput
HJD Area Output
=& Wall Dutput
=B Wall Farces

Hil:l Objects and Elements

Figura 5-59.- Seleccién de la tabla de fuerzas internas de las secciones pier elegidas.

- En la misma ventana (Choose Tables for Display), dentro del cuadro Load
Cases/Combos (Results), presionar el boton de comando Select
Cases/Combos y seleccionar los casos de carga CM-SQ Static Nonlin, CV
Static Load, SISMOX Combo y SISMOY Combo, tal como se muestra en la
figura 5-60.

Select Output

— Select
Ch Static Load "
Ch-50 _Eitatinz: Manlin
ENVOLY Comba
b5 Combio
kS Combio
ki Combio ﬂl
kS Combio
k%S Combio
Clear 4 |

Figura 5-60.- Casos de carga seleccionados para realizar el disefio del muro.

@ Tesis publicada con autorizacion del autor

SOME RIGHTS RESERVED Algunos Derechos Reservados. No olvide citar esta tesis




TESIS PUCP

- Copiar los valores mostrados en la tabla Pier Forces en una hoja de Excel.

PONTIFICIA
UMIVERSIDAD

CATOLICA
DEL PERU

- Construir en Excel una tabla (ver tabla 5-10) con la fuerza axial (P) y los

momentos flectores (M2 y M3) para cada uno de los anteriores casos de carga.

Tabla 5-10.- Fuerzas internas del muro, provenientes del
programa ETABS.

MUERTA:

P

M2

M3

VIVA:

SISMOX:

SISMOY:

(Tn) (Tn-m) (Tn-m) |
-567.76 0.75 -1,999.30
-121.74 0.85 -604.69
43.35 0.81 -3,114.58
50.99 -20.86 1,189.62

- Realizar el metrado manual de la carga axial, para los casos de carga muerta y

viva, que recibe el muro en ese nivel, utilizando el criterio del area tributaria.

- Comparar con el resultado que obtiene el programa (ver tabla 5-11) y

posteriormente verificar si las cargas del programa se aproximan a las del

criterio de area tributaria. En este ejemplo se va a trabajar con la carga del

metrado manual.

Tabla 5-11.- Comparacion entre el metrado manual y de ETABS,
para la carga axial proveniente de los casos de carga muerta y viva.

P (ETABS)

P (Manual)

(Tn)

(Tn)

MUERTA:
VIVA:

- En la tabla 5-12, se muestran las cargas que actlan en el muro para los

diferentes casos de carga elegidos.

Tabla 5-12.- Fuerzas internas de los casos de carga.

MUERTA:

SISMOX:
SISMOY:

P M2 M3
(Tn) (Tn-m)
-642.28 0.75 -1,999.30
-156.34 0.85 -604.69
43.35 0.81 -3,114.58
50.99 -20.86 1,189.62

- Con las fuerzas de la tabla 5-12, realizar las combinaciones de los casos de

carga, que se muestran en la tabla 5-13.

©
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Tabla 5-13.- Combinaciones de los casos de carga, para el disefio del muro.

Nivel ‘Descripci()n Combinacion
MV -1164.97 2.51 -3826.98
MSX -534.7 1.49 -4913.95
MSY -527.06 -20.18 -609.75
MVSX -954.93 2.82 -6369.56

PLANP 1 PL1 MVSY -947.29 -18.85 -2065.36
-MSX -621.4 -0.13 1315.21
-MSY -629.04 21.54 -2988.99
-MVSX -1041.63 12 -140.4
-MVSY -1049.27 22.87 -4444.6

- Ingresar al menu Options > Preferences > Shear Wall Design y verificar que
los valores mostrados en la ventana Wall Pier/Spandrel Design Preferences
correspondan a los de la figura 5-61. Para una mejor presentacién del diagrama

de interaccién, el nimero de puntos (Number of Points) debe ser por lo menos

de 15.
Diesign Cods A1 31599 B
Febar Units cm’”2
Rebar/Length Urits cm”2dm
Phi [Bending-T enzion) 04
Phi [Compreszion) 0.7
Phi [Shear] 0.85
Phi [Shear Seizmic) 0.6
Prax Factar ns LI
Mumber of Curves 24
Mumber of Paoints 15
Edge Design PT-Max 0.06
Edge Design PC-Max 004
Section Deszign IP-Max 0.0z
Section Dezign IP-Min 0.0025
Utilization Factor Limit 0495 Cancel I

Figura 5-61.- Ventana de preferencias de disefio de secciones pier y spandrel.

- Ingresar al menu Design > Shear Wall Design > Define Pier Sections for
Checking y en la ventana Pier Sections (figura 5-62) presionar el botén de

comando Add Pier Section.
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— Sectionz — Chck. ta:

Add Pier Section.. |

EERZE

Add Copy of Pier Section... |

Madify/Shaw Fier Section... |

Delete Pier Section |

(] I Cancel |

Figura 5-62.- Ventana de definicion de secciones pier.

- En la ventana Pier Section Data, mostrada en la figura 5-63, escribir PL1 en el
cuadro de texto Section Name y presionar el botdbn de comando Section

Designer.

Pier Section Data
Section Hame IF'L1 PIS0O1

Baze Material I COMC - I

—Add Pier
& Add Mew Fier Section

" Start from Existing *#all Pier
| = -

— Define/E dit/Show Section

| Section Dezsigner... I

[ I Cancel |

Figura 5-63.- Ventana de definicion de datos de una seccion pier.

- Dentro del Sub Programa Section Designer, graficar la seccion del muro, con
una distribucién inicial de acero, tomando en cuenta la fuerza cortante para el
acero distribuido y asumiendo que los nucleos extremos toman integramente el
momento. De esta manera, se colocardn en cada nucleo de los extremos y en

los intermedios, que coinciden con los ejes, 6 ¢ 5/8” y un acero distribuido de ¢
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3/8” @ 0.35 m (pv = .0020). Ver figura 5-64.

=k
File Edit View Draw Select Display Options Help

D| o] 2| 8@ 2|2 oM B8|H|

|

% PLACA PL1

T ) 2
E‘ 0.30m

S = [ e * -

=, 8 |

o |t o= w + + ®
6¢5/8”

I=) $3/8"@0.35m

Ready X=-1209 Y=-043 ITon-m v| Done

Figura 5-64.- Refuerzo inicial colocado en el muro, dibujado en el Section Designer.

- Para obtener el diagrama de Interaccion (figura 5-65), presionar el botén de

comando £ (Show Interaction Surface).

Interaction Surface (ACI 318-99)
Edit
P e M2
1 5704.0135 386211 0
2 | 57040135 72387138 0
3 | 57040135 12349 0
4 | E528.1894 16542 0
5 | 50247411 15873 0 e
B | -4510.8698 22365 0
7 | 39855511 24031 0
B | -3445.2662 24891 0
3 | -2893.0589 24714 0
10 2335.23 23458 0
1| A781.1437 21085 0 ~Options——————————————— ~30 View
12 | 220885 17619 0 : o
13 | 6053797 13676 o @l [715 5| Flan
14 | 130.3349 51195234 0 , <
15 | Bri6193 516.7316 i ® ol [35 5| Elevation
16 R
17 = o phi with fy increase ad | MM | P3| Pz
18
Curve 1
fnge 0 [I4] <[> [¥]

Figura 5-65.- Superficie de interaccién para la seccion del muro dibujado.
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- Copiar los resultados mostrados en la ventana Interaction Surface en una hoja
de Excel, y graficar las curvas del diagrama de interaccién para los pares P-M2
(90°-curva 7y 270°-curva 19) y P-M3 (0°-curva 13 y 180°-curva 1).

- Comprobar si la resistencia del muro es mayor que la demandada por las
combinaciones de las fuerzas. En caso de no ser asi, iterar aumentando su
armadura, hasta llegar a cumplir con la demanda de resistencia. En la figura
5-66 y en la figura 5-67 se aprecia que con esta seccién se cumple el requisito

buscado en los ejes locales 2 y 3 respectivamente.

MURQ PIER PL1
(P-M2)
EJELOCAL 2,PLAN P 1

6000
6000

5000 \

1000
4

Compresion

//‘——-_-_"‘H
\____/

Combinaciones

mfgt.
40 -180 120 w o9® 120 180 240

1000
T

Fuerza Axial, P (Tn)

N

Traccion

Momento Flector, M2-2 (Tn-m)

Figura 5-66.- Diagrama de interaccién del muro PL1PISO1, para el gje local 2.

MURQ PIER PL1
(P-m3)
EJELOCAL 3,PLAN P 1

6000
6000

£O0o

/ \\

Compresion

// —\\

Fuerza Axial, P (Tn)

~
%

Combinaciones /
000 -21000 14 ‘bq\qc

3000
2000
g0 -~
od® 70 %00 21000 28000
. 0 /,
1000

Traccion

Momento Flector, M3-3 (Tn-m)

Figura 5-67.- Diagrama de interaccion del muro PL1PISO1, para el gje local 3.
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Para calcular la distribucion del acero transversal, visualizar la fuerza cortante
en la base del muro, en la direccion 2. Para ello, ir al mend Display > Show
Member Forces/Stress Diagram (%) > Frame/Pier/Spandrel Forces.

- En la ventana Member Force Diagram for Frames, seleccionar el caso de
carga ENVOLV, en el cuadro Component la opcion Shear 2-2 y dentro del
cuadro Include activar la casilla Piers.

- Con las recomendaciones de la Norma E.060, calcular el espaciamiento del
refuerzo transversal. El acero minimo a colocar es ¢ 3/8” @ 28.4 cm (ph =

0.0025), por lo que se espaciara el acero horizontal cada 25 cm.

En la figura 5-68 se muestra el disefio del muro PL1 en el primer piso.

0.85 530 6.80

1 i il

05,8 . . bg5,8" . B 05,87
‘1 f - 25m|  #3/8°80.35m N 3/8700.25m |3654575"00. 26m 3,/8"00.35m I #3,/8"90.25m 00 25m | |
A 7 el /0 A - 7 el S - - A
1 | |
| a0 | 5.50 | 0.0 | 8.30 | 00 |
; 275 ; 5.34 ; 1.90
1 1 1
5,5" a5 . N e /5" . . ga,/3"
| ‘im;/ﬁ"@ﬂ.zﬁm | \1m§/5"@0.25m P3/8"90.56m || A3/8"80.25m 159;/5"@0.2.?77 | #3/8°@0.36m $3/8°80.25m Lﬂﬂé 5'90.25m
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Figura 5-68.- Esquema del muro PL1PISO1 disefiado en el primer piso.
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6 CONCLUSIONES

- Al usar un programa de computo se reduce el tiempo de creacion del modelo y
se pueden realizar modificaciones muy rapidamente. Sin embargo, la veracidad
de los resultados estd en funcion de un modelo que se aproxime al

comportamiento de la estructura real.

- Durante el analisis de secuencia constructiva, ETABS resuelve las cargas que
se aplican en los elementos del edificio, realizando un analisis estéatico no lineal.
Para los elementos verticales (columnas y muros), sera necesario comparar
estas cargas con un metrado manual que tome en cuenta el criterio de area
tributaria (para verificar su validez), antes de utilizarlas para realizar las

combinaciones de los casos de carga utilizados para el disefio.

- Una herramienta til para el disefio de columnas y muros es el Disefiador de
Secciones, un sub programa dentro de ETABS, porque facilita la obtencién del

diagrama de interaccion de cualquier seccion transversal dibujada en él.

- En el caso de las vigas, el programa calcula las cargas por el criterio del area
tributaria, por lo cual es posible utilizar los resultados del disefio automatico
(que se muestra como areas o cuantias de acero) para obtener directamente y

de manera rapida el armado de acero en estos elementos.

- Nuestra norma no estd contemplada dentro del programa ETABS, pero es
posible obtener los mismos resultados que se obtendrian al disefiar con ésta, si
se selecciona para el disefio el cddigo ACI 318-99 y se especifica que los

elementos son del tipo "Ordinario” (sway ordinary).

- En cuanto a la interfase grafica, que ofrece opciones intuitivas para la creaciéon
del modelo estructural (ordenadas dentro de menus secuenciales y l6gicos), asi
como a las opciones de presentacién de resultados (por medio de graficos
realisticos y tablas) y a las diversidad de analisis que puede realizar el
programa, podemos concluir que ETABS es una herramienta que ha probado

ser sencilla y bastante completa para el analisis de edificios.
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ANEXOS

ANEXO A. Esquema del contenido del CD

ANEXO B. CD del Documento

ANEXO A
(Esquema del contenido del CD)

— Documento de la Tesis L Formado WORD (*.doc)

Formato ACROBAT (*.pdf)

— Archivos del Modelo Pasos del Modelo

— P1 Malla.xIs

— P17 _TvsSC.ixt
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